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Executive Summary

Mobile devices provide access to vital workplace resources while giving employees the flexibility to
perform their daily activities. There are several options for deploying mobile devices. One deployment
model is Corporate-Owned Personally-Enabled (COPE). COPE devices are owned by the enterprise and
issued to the employee. COPE architectures provide the flexibility of allowing both enterprises and
employees to install applications onto the enterprise-owned mobile device.

Securing mobile devices is essential to continuity of business operations. While mobile devices can
increase efficiency and productivity, they can also leave sensitive data vulnerable. Mobile device
security tools can address such vulnerabilities by helping secure access to networks and resources.

The National Cybersecurity Center of Excellence (NCCoE) at the National Institute of Standards and
Technology (NIST) built a laboratory environment to explore the challenges of securing mobile devices
while managing risks and how various technologies could be integrated to help organizations secure
their COPE devices.

This NIST Cybersecurity Practice Guide demonstrates how organizations can use standards-based,
commercially available products to help meet their COPE mobile device security and privacy needs.

Mobile devices are a staple within modern workplaces. As employees use COPE devices to perform
tasks, organizations are challenged with ensuring that these devices process, modify, and store sensitive
data securely. COPE devices bring unique threats to the enterprise and therefore should be managed in
a manner distinct from desktop platforms.

These challenges include securing them from different types of application- and network-based attacks
on mobile devices that have an always-on connection to the internet. Mobile devices also introduce
potential privacy implications for employees using the devices for personal activities.

Managing the security and privacy of workplace mobile devices and minimizing the risk posed can be
challenging because there are many mobile device security tools available. Proper implementation can
be difficult because the method of implementation varies considerably from tool to tool. In addition,
unfamiliarity with the threats to mobile devices can increase implementation challenges.

To address the challenge of securing COPE devices within an enterprise, NIST built an example solution
in a lab environment at the NCCoE to demonstrate mobile device security tools that enterprises can use
to secure their networks. These technologies are configured to protect organizational assets and end-
user privacy, providing methodologies to enhance the security and privacy of the adopting organization.

Both Apple iOS and Android devices are used in the example solution, which includes detailed device
configurations and enterprise mobility management policies provisioned to the devices. The foundation
of this architecture is based on federal U.S. guidance, including that from NIST 800 series publications,
the National Information Assurance Partnership, U.S. Department of Homeland Security, and Federal
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Chief Information Officers Council. These standards, best practices, and certification programs help
ensure the confidentiality, integrity, and availability of enterprise data on mobile systems.

This guide provides:

a detailed example solution and capabilities addressing risk and security control implementation
a demonstration of the approach that uses commercially available products

how-to instructions for implementers and security engineers, with instructions on integrating
and configuring the example solution into their organization with minimum impact on
operational processes

The NCCoE sought existing technologies that provided the following capabilities:

enhanced protection of data that resides on the mobile device

centralized management systems to deploy policies and configurations to devices
evaluation of the security of mobile applications

inhibited eavesdropping of mobile device data

privacy settings that protect end-user data

protection from phishing attempts

Commercial, standards-based products such as the ones we used are readily available and interoperable
with existing information technology (IT) infrastructure and investments.

While the NCCoE used a suite of commercial products to address this challenge, this guide does not
endorse these particular products, nor does it guarantee compliance with any regulatory initiatives. Your
organization’s information security experts should identify the products that will best integrate with
your existing tools and IT system infrastructure. Your organization can adopt this solution or one that
adheres to these guidelines in whole, or you can use this guide as a starting point for tailoring and
implementing parts of a solution.

The NCCoE’s practice guide Mobile Device Security: Corporate-Owned Personally-Enabled can help your
organization:

reduce adverse effects if a device is compromised

reduce capital investment by embracing modern enterprise mobility models
apply robust, standards-based technologies by using industry best practices
reduce user privacy risks

provide enhanced protection against loss of personal and business data when a device is stolen
or misplaced

deploy enterprise management technologies to improve the security of enterprise-owned
networks, devices, and applications

NIST SP 1800-21A: Mobile Device Security: Corporate-Owned Personally-Enabled 2



*12-008T"dS’1SIN/8209 0T /840" 10p//:d1Yy :wo4y 98Jeyd Jo 9244 d|qejieAe s| uofedlgnd sty

= reduce risk so that employees can access necessary data from nearly any location by using a
wide selection of enterprise-owned mobile devices and networks

= enhance visibility for system administrators into mobile security events, providing notification
and identification of device and data compromise

= implement government standards for mobile security

You can view or download the guide at https://www.nccoe.nist.gov/projects/building-blocks/mobile-
device-security/corporate-owned-personally-enabled. If you adopt this solution for your own
organization, please share your experience and advice with us. We recognize that technical solutions
alone will not fully enable the benefits of our solution, so we encourage organizations to share lessons
learned and best practices for transforming the processes associated with implementing this guide.

To provide comments or to learn more by arranging a demonstration of this example implementation,
contact the NCCoE at mobile-nccoe@nist.gov.

Organizations participating in this project submitted their capabilities in response to an open call in the
Federal Register for all sources of relevant security capabilities from academia and industry (vendors
and integrators). The following respondents with relevant capabilities or product components (identified
as “Technology Partners/Collaborators” herein) signed a Cooperative Research and Development
Agreement (CRADA) to collaborate with NIST in a consortium to build this example solution.

Qappthority Wkeyptowice @Lookout @Mobilelron Qualcomm

Certain commercial entities, equipment, products, or materials may be identified by name or company
logo or other insignia in order to acknowledge their participation in this collaboration or to describe an
experimental procedure or concept adequately. Such identification is not intended to imply special
status or relationship with NIST or recommendation or endorsement by NIST or NCCoE; neither is it
intended to imply that the entities, equipment, products, or materials are necessarily the best available
for the purpose.

The National Cybersecurity Center of Excellence (NCCoE), a part of the

National Institute of Standards and Technology (NIST), is a collaborative Visit https://www.nccoe.nist.gov
hub where industry organizations, government agencies, and academic nccoe@nist.gov
institutions work together to address businesses’ most pressing 301-975-0200

cybersecurity challenges. Through this collaboration, the NCCoE develops
modular, adaptable example cybersecurity solutions demonstrating how
to apply standards and best practices using commercially available
technology.

NIST SP 1800-21A: Mobile Device Security: Corporate-Owned Personally-Enabled 3


https://www.nccoe.nist.gov/projects/building-blocks/mobile-device-security/corporate-owned-personally-enabled
https://www.nccoe.nist.gov/projects/building-blocks/mobile-device-security/corporate-owned-personally-enabled
mailto:mobile-nccoe@nist.gov
https://www.nccoe.nist.gov/
mailto:nccoe@nist.gov

NIST SPECIAL PUBLICATION 1800-21B

Mobile Device Security:
Corporate-Owned Personally-Enabled (COPE)

Volume B:
Approach, Architecture, and Security Characteristics

Joshua M. Franklin*

Gema Howell

Kaitlin Boeckl

Naomi Lefkovitz

Ellen Nadeau*

Applied Cybersecurity Division
Information Technology Laboratory

Dr. Behnam Shariati

University of Maryland, Baltimore County

Department of Computer Science and Electrical Engineering
Baltimore, Maryland

Jason G. Ajmo
Christopher J. Brown
Spike E. Dog

Frank Javar

Michael Peck
Kenneth F. Sandlin
The MITRE Corporation
McLean, Virginia

*Former employee; all work for this publication done while at employer.
September 2020
Final

This publication is available free of charge from:
https://doi.org/10.6028/NIST.SP.1800-21

The first draft of this publication is available free of charge from:
https://www.nccoe.nist.gov/projects/building-blocks/mobile-device-security/enterprise

NIST o e e

M), |stiiots oF . NATIONAL CYBERSECURITY
Standards and Technology CENTER GF EXCELLENDE
U.S. Department of Commerce



https://doi.org/10.6028/NIST.SP.1800-21
https://www.nccoe.nist.gov/projects/building-blocks/mobile-device-security/enterprise

"1Z-008T°dS’ LSIN/8209°0T/840°10p//:d1y :woly 981eYd JO 9244 d|qe|ieAe S| uolredljgnd siyL

Certain commercial entities, equipment, products, or materials may be identified by name or company
logo or other insignia in order to acknowledge their participation in this collaboration or to describe an
experimental procedure or concept adequately. Such identification is not intended to imply special
status or relationship with NIST or recommendation or endorsement by NIST or NCCoE; neither is it
intended to imply that the entities, equipment, products, or materials are necessarily the best available
for the purpose.

National Institute of Standards and Technology Special Publication 1800-21B Natl. Inst. Stand. Technol.
Spec. Publ. 1800-21B, 147 pages, (September 2020), CODEN: NSPUE2

As a private-public partnership, we are always seeking feedback on our practice guides. We are
particularly interested in seeing how businesses apply NCCoE reference designs in the real world. If you
have implemented the reference design, or have questions about applying it in your environment,
please email us at mobile-nccoe@nist.gov.

All comments are subject to release under the Freedom of Information Act.

National Cybersecurity Center of Excellence
National Institute of Standards and Technology
100 Bureau Drive
Mailstop 2002
Gaithersburg, MD 20899

Email: nccoe@nist.gov
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The National Cybersecurity Center of Excellence (NCCoE), a part of the National Institute of Standards
and Technology (NIST), is a collaborative hub where industry organizations, government agencies, and
academic institutions work together to address businesses’ most pressing cybersecurity issues. This
public-private partnership enables the creation of practical cybersecurity solutions for specific
industries, as well as for broad, cross-sector technology challenges. Through consortia under
Cooperative Research and Development Agreements (CRADAs), including technology partners—from
Fortune 50 market leaders to smaller companies specializing in information technology security—the
NCCoE applies standards and best practices to develop modular, adaptable example cybersecurity
solutions using commercially available technology. The NCCoE documents these example solutions in
the NIST Special Publication 1800 series, which maps capabilities to the NIST Cybersecurity Framework
and details the steps needed for another entity to re-create the example solution. The NCCoE was
established in 2012 by NIST in partnership with the State of Maryland and Montgomery County,
Maryland.

To learn more about the NCCoE, visit https://www.nccoe.nist.gov. To learn more about NIST, visit
https://www.nist.gov.

NIST Cybersecurity Practice Guides (Special Publication 1800 series) target specific cybersecurity
challenges in the public and private sectors. They are practical, user-friendly guides that facilitate the
adoption of standards-based approaches to cybersecurity. They show members of the information
security community how to implement example solutions that help them align with relevant standards
and best practices, and provide users with the materials lists, configuration files, and other information
they need to implement a similar approach.

The documents in this series describe example implementations of cybersecurity practices that
businesses and other organizations may voluntarily adopt. These documents do not describe regulations
or mandatory practices, nor do they carry statutory authority.

Mobile devices provide access to vital workplace resources while giving employees the flexibility to
perform their daily activities. Securing these devices is essential to the continuity of business operations.

While mobile devices can increase efficiency and productivity, they can also leave sensitive data
vulnerable. Mobile device management tools can address such vulnerabilities by helping secure access
to networks and resources. These tools are different from those required to secure the typical computer
workstation.

NIST SP 1800-21B: Mobile Device Security: Corporate-Owned Personally-Enabled ii
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This practice guide focuses on security enhancements that can be made to corporate-owned personally-
enabled (COPE) mobile devices. COPE devices are owned by an enterprise and issued to an employee.
Both the enterprise and the employee can install applications onto the device.

To address the challenge of securing COPE mobile devices while managing risks, the NCCoE at NIST built
a reference architecture to show how various mobile security technologies can be integrated within an
enterprise’s network.

This NIST Cybersecurity Practice Guide demonstrates how organizations can use standards-based,
commercially available products to help meet their mobile device security and privacy needs.

KEYWORDS

Corporate-owned personally-enabled; COPE; mobile device management; mobile device security, on-
premise; bring your own device; BYOD
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The Technology Partners/Collaborators who participated in this build submitted their capabilities in
response to a notice in the Federal Register. Respondents with relevant capabilities or product
components were invited to sign a Cooperative Research and Development Agreement (CRADA) with
NIST, allowing them to participate in a consortium to build this example solution. We worked with:

Technology Partner/Collaborator Build Involvement

Appthority* Appthority Cloud Service, Mobile Threat Intelligence
Kryptowire Kryptowire Cloud Service, Application Vetting
Lookout Lookout Cloud Service/Lookout Agent Version 5.10.0.142

(i0S), 5.9.0.420 (Android), Mobile Threat Defense

Mobilelron Mobilelron Core Version 9.7.0.1, Mobilelron Agent
Version 11.0.1A (iOS), 10.2.1.1.3R (Android), Enterprise
Mobility Management

Palo Alto Networks Palo Alto Networks PA-220

Qualcomm Qualcomm Trusted Execution Environment (version is
device dependent)

* Appthority (acquired by Symantec—A division of Broadcom).
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This section helps familiarize the reader with:

= Corporate-Owned Personally-Enabled (COPE) concepts

= COPE challenges, solutions, and benefits as related to this practice guide

COPE mobile devices are owned by an enterprise and issued to an employee. Both the enterprise and
the employee can install applications onto the device.

This National Institute of Standards and Technology (NIST) Cybersecurity Practice Guide seeks to help
address COPE mobile device security implementation challenges in several ways: by analyzing a set of
mobile security and privacy threats; exploring mitigating technologies; and describing a reference design
based upon those technologies to help mitigate the identified threats.

Mobile devices provide greater flexibility in how employees access resources. For some organizations,
this flexibility supports a hybrid approach enhancing their in-office processes with mobile device
communication and workflows.

For others, this flexibility, combined with growing mobile functionality, fosters a mobile-first approach in
which their employees primarily communicate and collaborate using mobile devices. However, some of
the features that make mobile devices increasingly flexible and functional also make them challenging to
deploy and manage with security in mind.

Further, organizations are becoming progressively cognizant of the privacy implications that arise from
using mobile security technologies. Therefore, developing a successful mobile deployment strategy
requires organizations to evaluate their security and privacy requirements.

To help organizations address mobile device security and privacy risks, this document’s reference design
provides:

= adescription of a mobile device deployment example solution featuring an on-premises
enterprise mobility management (EMM) solution integrated with cloud- and agent-based mobile
security technologies to help deploy a set of security and privacy capabilities in support of a
COPE mobile device usage scenario

= aseries of how-to guides—step-by-step instructions covering the initial setup (installation or
provisioning) and configuration for each component of the architecture to help security
engineers rapidly deploy and evaluate our example solution in their test environment

The example solution of our reference design uses standards-based, commercially available products. It
can be used directly by any organization with a COPE usage scenario by implementing a security
infrastructure that supports integration of on-premises with cloud-hosted mobile security technologies.

NIST SP 1800-21B: Mobile Device Security: Corporate-Owned Personally-Enabled 1
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Alternatively, an organization may use our reference design and example solution in whole or part as
the basis for a custom solution that realizes the security and privacy characteristics that best support its
unique mobile device usage scenario.

1.1 Challenge

Mobile devices are a staple within modern workplaces, and as employees use these devices to perform
tasks, organizations are challenged with ensuring that devices process, modify, and store sensitive data
securely. They bring unique threats to the enterprise and need to be managed differently from desktop
platforms.

Due to their unique capabilities, mobile devices’ specific security challenges can include:

= securing their always-on connections to the internet from network-based attacks
= securing the data on devices to prevent compromise via malicious applications

= protecting them from phishing attempts that try to collect user credentials or entice a user to
install software

= selecting from the many mobile device management tools available and implementing their
protection capabilities consistently

= identifying threats to mobile devices and how to mitigate them

Given these challenges, managing the security of workplace mobile devices and minimizing the risk
posed can be complex. By providing an example solution that organizations can make immediate use of,
this guide provides an example solution to help simplify deployment of mobile device security
capabilities.

1.2 Solution

In our lab at the National Cybersecurity Center of Excellence (NCCoE), NIST engineers built an
environment that contains an example solution for managing the security of mobile devices. In this
guide, we show how an enterprise can leverage this infrastructure to implement on-premises EMM,
mobile threat defense (MTD), mobile threat intelligence (MTI), application vetting, secure boot/image
authentication, and virtual private network (VPN) services.

Further, these technologies were configured to protect organizational assets and end-user privacy,
providing methodologies to enhance the security posture of the adopting organization. The foundation
of this architecture is based on federal United States guidance, including that from the NIST 800 series
publications [1], the National Information Assurance Partnership (NIAP) [2], the Department of
Homeland Security [3], and the Federal Chief Information Officers (CIO) Council [4]. These standards,
best practices, and certification programs help ensure the confidentiality, integrity, and availability of
enterprise data on mobile systems.
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This guide provides:

a detailed example solution with capabilities that mitigate common mobile threats
a demonstration of an approach that uses commercially available products

step-by-step installation how-to guidance for implementers, which is designed to integrate with
existing systems to improve the organization’s mobile security posture with minimal disruption
to operations

The NCCoE sought existing technologies that provided the following capabilities:

ability to help protect data on the mobile device

utilization of centralized management systems to deploy policies and configurations to devices
vetting the security of mobile applications

ability to help protect data from eavesdropping

privacy settings to enable the predictability, manageability, and disassociability of end-users’
personally identifiable information (PIl)

Commercial, standards-based products such as the ones we used are readily available and interoperable
with existing information technology (IT) infrastructure and investments.

1.2.1 Standards and Guidance

This guide leverages many standards and guidance, including the NIST Cybersecurity Framework Version
1.1 [5], the NIST Privacy Risk Assessment Methodology (PRAM) (6], the National Initiative for
Cybersecurity Education (NICE) Cybersecurity Workforce Framework [7], the NIST Risk Management
Framework 8], and the NIST Mobile Threat Catalogue [9]. For additional information, see Appendix D,
Standards and Guidance.

1.3 Benefits

The potential benefits of the example solution explored by this project are to:

provide users with enhanced protection against both malicious applications and loss of personal
and business data when a device is stolen or misplaced

reduce adverse effects on an organization if a device is compromised
reduce capital investment by embracing modern enterprise mobility models

provide visibility for system administrators into mobile security events, enabling automated
identification and notification of a compromised device

provide modular architecture based on technology roles while remaining vendor-agnostic

facilitate multiple mobile device usage scenarios using COPE devices

NIST SP 1800-21B: Mobile Device Security: Corporate-Owned Personally-Enabled
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= apply robust, standards-based technologies using industry best practices
= demonstrate secure mobile access to organizational resources

= jllustrate the application of the NIST Risk Management Framework to mobility scenarios

This section helps familiarize the reader with:

= this practice guide’s content
= the suggested audience for each volume

= typographic conventions used in this volume

This NIST Cybersecurity Practice Guide demonstrates a standards-based reference design and provides
users with the information they need to replicate how to improve the security and privacy of
organization-owned mobile devices. This reference design is modular and can be deployed in whole or in
part.

This guide contains three volumes:

= NIST SP 1800-21A: Executive Summary

= NIST SP 1800-21B: Approach, Architecture, and Security Characteristics — what we built and why
(you are here)

= NIST SP 1800-21C: How-To Guides — instructions for building the example solution

Depending on your role in your organization, you might use this guide in different ways:

Business decision makers, including chief security and technology officers, will be interested in the
Executive Summary, NIST SP 1800-21A, which describes the following topics:

= challenges that enterprises face in securing organization-owned mobile devices from threats
that are distinct from desktop platforms

= example solution built at the NCCoE
= benefits of adopting the example solution

Technology or security program managers who are concerned with how to identify, understand, assess,
and mitigate risk will be interested in this part of the guide, NIST SP 1800-21B, which describes what we
did and why. The following sections will be of particular interest:

= Section 3.4, Risk Assessment, provides a description of the risk analysis we performed

NIST SP 1800-21B: Mobile Device Security: Corporate-Owned Personally-Enabled 4
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= Section 4.3, Security Control Map, maps the security characteristics of this example solution to
cybersecurity standards and best practices

You might share the Executive Summary, NIST SP 1800-21A, with your leadership team members to help
them understand the importance of adopting standards-based solutions to improve mobile device
security with on-premises mobile device management solutions.

IT professionals who want to implement an approach like this will find the whole practice guide useful.
You can use the how-to portion of the guide, NIST SP 1800-21C, to replicate all or parts of the build
created in our lab. The how-to portion of the guide provides specific product installation, configuration,
and integration instructions for implementing the example solution. We do not re-create the product
manufacturers’ documentation, which is generally widely available. Rather, we show how we
incorporated the products together in our environment to create an example solution.

This guide assumes that information technology (IT) professionals have experience implementing
security products within the enterprise. While we have used a suite of commercial products to address
this challenge, this guide does not endorse these particular products. Your organization can adopt this
solution or one that adheres to these guidelines in whole, or you can use this guide as a starting point
for tailoring and implementing parts of this guide’s example solution for on-premises mobile device
security management. Your organization’s security experts should identify the products that will best
integrate with your existing tools and IT system infrastructure. We hope that you will seek products that
are congruent with applicable standards and best practices. Section 3.6, Technologies, lists the products
we used, and Appendix | maps them to the cybersecurity controls provided by this reference solution.

A NIST Cybersecurity Practice Guide does not describe “the” solution, but a possible solution.
Comments, suggestions, and success stories will improve subsequent versions of this guide. Please
contribute your thoughts to mobile-nccoe @nist.gov.

2.1 Typographic Conventions

The following table presents typographic conventions used in this volume.

Typeface/

symbol Meaning Example

Italics file names and path names; For detailed definitions of terms, see
references to documents that the NCCoE Glossary.

are not hyperlinks; new terms;
and placeholders

Bold names of menus, options, Choose File > Edit.
command buttons, and fields

NIST SP 1800-21B: Mobile Device Security: Corporate-Owned Personally-Enabled 5
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Typeface/

Symbol

Monospace

Meaning

command-line input, onscreen
computer output, sample code
examples, and status codes

Example

mkdir

Monospace Bold

command-line user input
contrasted with computer
output

service sshd start

blue text

link to other parts of the
document, a web URL, or an
email address

All publications from NIST’s NCCoE
are available at
https://www.nccoe.nist.gov.

3 Approach

This section helps familiarize the reader with:

= this guide’s intended audience, scope, and assumptions

= the fictional organization used in the example scenario

= the risk assessment, including the privacy risk assessment

= the example solution’s goals and the technologies it uses

The NIST build team surveyed reports of mobile device security trends and openly invited the mobile
device security community—including vendors, researchers, administrators, and users—to engage in a
discussion about pressing cybersecurity challenges. The community expressed two significant messages.

First, administrators experienced confusion about which policies and standards—out of myriad
sources—should be implemented. Second, mobile device users were frustrated by the degrees to which
enterprises have control over their mobile devices and maintain visibility into their personal activity.

Therefore, the NIST build team reviewed the primary standards, best practices, and guidelines from
government sources and implemented a COPE usage scenario within this build. This effort highlights
several security characteristics and capabilities that are documented within the Mobile Device Security

for Enterprises building block [10].
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3.1 Audience

This practice guide is for organizations that want to enhance the security and privacy of corporate-
owned mobile devices. It is intended for executives, security managers, engineers, administrators, and
others who are responsible for acquiring, implementing, and maintaining mobile enterprise technology,
including centralized device management, application vetting, and endpoint protection systems.

This document will be of particular interest to system architects already managing mobile deployment
solutions and those looking to deploy mobile devices in the near term. It assumes readers have a basic
understanding of mobile device technologies and enterprise security principles. Please refer to Section 2
for how different audiences can effectively use this guide.

3.2 Scope

The scope of this build includes managing mobile phones and tablets with on-premises EMM. Mobile
devices in general are commonly defined as:

A portable computing device that: (i) has a small form factor such that it can easily be carried by
a single individual; (ii) is designed to operate without a physical connection (e.g., wirelessly
transmit or receive information); (iii) possesses local, non-removable or removable data storage;
and (iv) includes a self-contained power source. Mobile devices may also include voice
communication capabilities, on-board sensors that allow the devices to capture information,
and/or built-in features for synchronizing local data with remote locations. Examples include
smart phones, tablets, and E-readers [11].

Laptops are excluded from the scope of this publication, as the security controls available today for
laptops differ significantly from those available for mobile phones and tablets, although this is changing
with the emergence of unified endpoint management capabilities.

Devices with minimal computing capability are also excluded, including feature phones, wearables, and
devices classified as part of the Internet of Things. Classified systems, devices, data, and applications are
not addressed within this publication.

The build team devised a fictional scenario centered around a mock organization (Orvilia Development)
to provide context to our risk assessment and to enable us to build a reference design to solve common
enterprise mobile security challenges. Using a fictional scenario exemplifies the issues that an
organization may face when addressing common enterprise mobile security challenges. We intend for
the example solution proposed in this practice guide to be broadly applicable to enterprises, including
both the public and private sectors.

The example solution does not incorporate insider threats and their corresponding mitigations. It
focuses on external threats and how the example solution can address them.
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Additional options for deployment of Android, Apple, and Samsung Knox managed devices are discussed
in Appendix E.

3.2.1 Orvilia Development

The fictional organization, Orvilia Development, is a start-up company providing IT services to many
private sector organizations. Its service offerings include developing scalable web applications,
improving existing IT systems, project management, and procurement. Orvilia recently won its first
government contract. Given the organization’s current security posture, particularly in its use of mobile
devices, complying with government regulations and heightened cybersecurity standards presents it
with new challenges.

Orvilia has a deployment of on-premises IT resources. It hosts its own Microsoft Active Directory (AD)
domain, Microsoft Exchange email server, and web-based resources for employees, such as timekeeping
and travel support. All enterprise resources can be directly accessed by employees locally or remotely
from any internet-connected device by using password-based authentication. Orvilia also provides its
employees with corporate-owned mobile devices. These may be used for personal activity, including
phone calls, instant messaging, and installation and use of social applications. Employees also regularly
work outside the office and frequently use public Wi-Fi networks at hotels, airports, and coffee shops.

Orvilia’s mobile device deployment practice is still developing; it has minimal mobile device policies and
has not implemented any additional security mechanisms such as enterprise mobility management. All
policy and security enforcement actions are performed manually on an ad-hoc basis. Employees are
expected to secure their own COPE devices, for instance via the timely installation of operating system
(OS) updates, and to exercise good judgment regarding any personal use.

However, no mechanisms have been put into place to prevent or detect misuse or device compromise.
Further, corporate policy prohibits access to the corporate network from personally owned mobile
devices, but no technical safeguards have been implemented to prevent employees from doing so. This
posture had been promoted based on the organization’s small size, high level of employee technical
acumen, and lack of awareness that it has been significantly impacted by any cybersecurity incidents.

However, Orvilia’s new status as a contractor to a civilian government agency calls for it to achieve and
maintain compliance with government policies, which require compliance with cybersecurity best
practices and applicable standards. For example, Orvilia is required to secure its access to and storage of
sensitive government information, which its employees will need to access from their mobile devices,
both locally at agency sites and remotely from Orvilia or during travel.

In addition to meeting compliance requirements rising from its contractual obligations to a government
agency, Orvilia leadership is concerned about the potential for future incidents where nation-state
malicious actors might obtain sensitive government data from unsecured devices and infrastructure.
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Therefore, a risk assessment as described in NIST SP 800-30 Revision 1, Guide for Conducting Risk
Assessments [12], was performed using the risk management concepts shown in Figure 3-1.

Figure 3-1 Risk Management Approach

- Risk Assumptions - Establishes Foundation
- Risk Constraints for Risk Management
- Priorities and Tradeoffs ORGANIZATIONAL RISK FRAME - Delineates Boundaries
- Risk Tolerance RISK MANAGEMENT STRATEGY OR APPROACH for Risk-Based Decisions
- Uncertainty
DETERMINES DETERMINES
N
[ Risk Assessment Methodology

Risk Assessment Risk Assessment Analysis
Process Mode/ Approach Approach

The risk assessment revealed that Orvilia’s current mobile infrastructure places the organization at risk
of intrusion and compromise of sensitive data. The results of the risk assessment process are presented

in Appendix F.

Based on the risk assessment findings, Orvilia chose to invest in security improvements to its mobile
infrastructure. Details of Orvilia’s new mobile device security infrastructure are provided in Section 4. As
described in Section 4’s architecture design, Orvilia’s new infrastructure addressed the concerns
identified in its risk assessment. Orvilia’s risk assessment team reviewed guidance by standards
organizations and government agencies as part of its process and identified the standards and guidance
identified in Appendix D as applicable to its organizational mobile use case.

3.3 Assumptions

This project is guided by the following assumptions:

= The solution was developed in a lab environment based on a typical organization’s IT enterprise.
It does not reflect the complexity of a production environment.

= An organization has access to the skills and resources required to implement a mobile device
security solution.
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= The benefits of adopting this particular mobile device security solution outweigh any additional
performance, reliability, or security risks that may be introduced. However, we draw the
reader’s attention to the fact that implementation of any security controls has the potential to
increase or decrease the attack surface within an enterprise, the actual impact of which will vary
from organization to organization. Because the organizational environment in which this build
could be implemented represents a greater level of complexity than is captured in the current
guide, we assume that organizations will first examine the implications for their current
environment before implementing any part of the proposed solution.

= QOrganizations have either already invested or are willing to invest in the security of mobile
devices used within their organization and of their IT systems more broadly. As such, we assume
they either have the technology in place to support this implementation or have access to the
off-the shelf information security technology used in this build, which we assume will perform as
described by the respective product vendor.

= QOrganizations have familiarized themselves with existing standards and any associated
guidelines (e.g., NIST Cybersecurity Framework [5], NIST SP 800-124 Revision 2 Draft [13], NIST
SP 1800-4 [14]) relevant to implementation of the solution proposed in this practice guide. We
also assume that any existing technology to be used in the proposed solution has been
implemented in a manner consistent with these standards.

= Organizations have instituted relevant mobile device security policies and that these will be
updated based on implementation of this solution.

3.3.1 Systems Engineering

Some organizations use a systems engineering-based approach in planning and implementing their IT
projects. Organizations wishing to implement IT systems are encouraged to conduct robust
requirements development, taking into consideration the operational needs of each system stakeholder.

The information contained within Section 4 of this volume provides architecture details to help
understand the operational capabilities of the example solution. Guidance is also provided in standards
such as the International Organization for Standardization (I1SO), International Electrotechnical
Commission (IEC), Institute of Electrical and Electronics Engineers (IEEE) 15288:2015, Systems and
software engineering—System life cycle processes [15]; and NIST SP 800-160, Systems Security
Engineering: Considerations for a Multidisciplinary Approach in the Engineering of Trustworthy Secure
Systems [16], which provide guidance in this endeavor. With these standards, organizations may choose
to adopt only those sections that are relevant to their environment and business context.

3.4 Risk Assessment

NIST SP 800-30 Revision 1, Guide for Conducting Risk Assessments [12], states that risk is “a measure of
the extent to which an entity is threatened by a potential circumstance or event, and typically a function
of: (i) the adverse impacts that would arise if the circumstance or event occurs; and (ii) the likelihood of
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occurrence.” The guide further defines risk assessment as “the process of identifying, estimating, and
prioritizing risks to organizational operations (including mission, functions, image, reputation),
organizational assets, individuals, other organizations, and the Nation, resulting from the operation of
an information system. Part of risk management incorporates threat and vulnerability analyses, and
considers mitigations provided by security controls planned or in place.”

The NCCoE recommends that any discussion of risk management, particularly at the enterprise level,
begins with a comprehensive review of NIST SP 800-37 Revision 2, Risk Management Framework for
Information Systems and Organizations [17]—material that is available to the public. The Risk

Management Framework (RMF) guidance [8], as a whole, proved to be invaluable in giving us a baseline

to assess risks, from which we developed the project, the security characteristics of the build, and this
guide.

This section provides information on the risk assessment process employed to improve the mobile
security posture of Orvilia Development. Typically, a NIST SP 800-30 Revision 1-based risk assessment
follows a four-step process as shown in Figure 3-2: Prepare for assessment, conduct assessment,
communicate results, and maintain assessment. Full details of the risk assessment can be found in

Appendix F.

Figure 3-2 Risk Assessment Process

Step 1: Prepare for Assessment
Derived from Organizational Risk Frame

Step 2: Conduct Assessment
Expanded Task View

Identify Threat Sources and Events

v

Identify Vulnerabilities and
Predisposing Conditions

v

| Determine Likelihood of Occurrence

v

| Determine Magnitude of Impact

v

| Determine Risk

Step 3: Communicate Results
Step 4: Maintain Assessment
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The purpose of Orvilia Development’s risk assessment is to identify and document risk-impacting
changes to its mission resulting from Orvilia’s new status as a contractor to government agencies and
COPE mobile deployment.

3.4.1 Risk Assessment of the Fictional Organization Orvilia Development

This risk assessment is scoped to Orvilia’s mobile deployment, which consists of mobile devices used to
access Orvilia enterprise resources along with any backend IT components used to manage or provide
services to those mobile devices.

Risk assessment assumptions and constraints were developed using a NIST SP 800-30 Revision 1 Generic
Risk Model as shown in Figure 3-3 to identify the following necessary components of the risk
assessment:

= threat sources

= threat events

= vulnerabilities

= predisposing conditions
=  security controls

= adverse impacts

= organizational risks

NIST SP 1800-21B: Mobile Device Security: Corporate-Owned Personally-Enabled 12
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Figure 3-3 NIST 800-30 Generic Risk Model
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3.4.2 Development of Threat Event Descriptions

Orvilia examined the sample tables in NIST SP 800-30 Revision 1—Table F-1, Table F-2, Table F-3, Table
F-4, and Table F-5—and analyzed the sources of mobile threats. Using this process, Orvilia leadership
identified the potential mobile device threat events that are described in the following subsections. A
mapping of the threat events considered in this guide’s example solution to the Mobile Threat
Catalogue can be found in Table 3-1.

A note about selection of the threat events: These threat events were developed by identifying threats
from the NIST Mobile Threat Catalogue [9] that would have the ability to significantly disrupt Orvilia’s
processes. In the interest of brevity, we limited our identified threat events of concern to those that
were presumed to average a foreseeably high likelihood of occurrence and high potential for adverse
impact in Orvilia’s specific scenario. The threats from the NIST Mobile Threat Catalogue that could have
less impact to Orvilia were not prioritized as high and did not become part of the following 12 threat
events that Orvilia prioritized for inclusion in its mobile device security architecture.
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Table 3-1 Threat Event Mapping to the Mobile Threat Catalogue

Threat Event (TE) NIST Mobile Threat Catalogue Threat ID

TE-1 APP-2, APP-12

TE-2 AUT-9

TE-3 APP-5, AUT-10, APP-31, APP-40, APP-32, APP-2
TE-4 STA-9, APP-4, STA-16, STA-0, APP-26
TE-5 APP-32, APP-36

TE-6 STA-7, EMM-3

TE-7 CEL-18, APP-0, LPN-2

TE-8 AUT-2, AUT-4

TE-9 APP-9, AUT-0

TE-10 EMM-5

TE-11 PHY-0

TE-12 EMM-9

3421 Threat Event 1—Unauthorized Access to Sensitive Information via a Malicious
or Privacy-Intrusive Application

Summary: A mobile application can attempt to collect and exfiltrate any information to which it has
been granted access. This includes any information generated during use of the application (e.g., user
input), user-granted permissions (e.g., contacts, calendar, call logs, camera roll), and general device data
available to any application (e.g., International Mobile Equipment Identity , device make and model,
serial number). Further, if a malicious application exploits a vulnerability in other applications, the
operating system (OS), or device firmware to achieve privilege escalation, it may gain unauthorized
access to any data stored on or otherwise accessible through the device.

Risk Assessment Analysis:

Overall Likelihood: Very High
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Justification: Employees have access to download any applications at any time. If an employee requires
an application that provides a desired function, the employee can download that application from any
available source (trusted or untrusted). If an application performs an employee’s desired function, they
may download an application from an untrusted source whose app then requires privacy-intrusive
permissions.

Level of Impact: High

Justification: Orvilia’s mobile devices currently have the ability to download an application from an
untrusted source whose apps require privacy-intrusive permissions. This poses a threat for sensitive
corporate data, as some applications may include features that access corporate data, unbeknownst to
the user.

3422 Threat Event 2—Theft of Credentials Through a Short Message Service (SMS)
or Email Phishing Campaign

Summary: Malicious actors may create fraudulent websites that mimic the appearance and behavior of
legitimate ones and entice users to authenticate to them by distributing phishing messages over SMS or
email. Effective use of social engineering techniques such as impersonating an authority figure or
creating a sense of urgency may compel users to forgo scrutiny of the message and proceed to
authenticate to the fraudulent website; it then captures and stores the user’s credentials before
(usually) forwarding them to the legitimate website to allay suspicion.

Risk Assessment Analysis:

Overall Likelihood: Very High
Justification: Phishing campaigns are a common threat that occurs almost daily.
Level of Impact: High

Justification: A successful phishing campaign could provide the malicious actor with corporate
credentials, allowing access to sensitive corporate data, or personal credentials that could lead to
compromise of corporate data or infrastructure via other means.

34.2.3 Threat Event 3—Malicious Applications Installed via Uniform Resource
Locators (URLs) in SMS or Email Messages

Summary: Malicious actors may send users SMS or email messages that contain a URL where a
malicious application is hosted. Generally, such messages are crafted using social engineering
techniques designed to dissuade recipients from scrutinizing the nature of the message, thereby
increasing the likelihood they access the URL using their mobile device. If they do, it will attempt to
download and install the application. Effective use of social engineering by the attacker will further
compel an otherwise suspicious user to grant any trust required by the developer and all permissions
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requested by the application. Granting the former facilitates the installation of other malicious
applications by the same developer, and granting the latter increases the potential for the application to
do direct harm.

Risk Assessment Analysis:

Overall Likelihood: High

Justification: Installation of malicious applications via URLs is less common than other phishing attempts.
The process for sideloading applications requires much more user input and consideration (e.g., trusting
the developer certificate) than standard phishing, which solely requests a username and password. A
user may proceed through the process of sideloading an application to acquire a desired capability from
an application.

Level of Impact: High

Justification: Once a user installs a malicious sideloaded application, this could provide a malicious actor
with full access to a mobile device, and therefore, access to corporate data and credentials, without the
user’s knowledge.

34.2.4 Threat Event 4—Confidentiality and Integrity Loss Due to Exploitation of
Known Vulnerability in the OS or Firmware

Summary: When malware successfully exploits a code execution vulnerability in the mobile OS or device
drivers, the delivered code generally executes with elevated privileges and then issues commands in the
context of the root user or the OS kernel. These commands may be enough for some to accomplish their
goal, but advanced malicious actors will usually attempt to install additional malicious tools and to
establish a persistent presence. If successful, the malicious actor will be able to launch further attacks
against the user, the device, or any other systems connected to the device. As a result, any data stored
on, generated by, or accessible to the device at that time—or in the future—may be compromised.

Risk Assessment Analysis:

Overall Likelihood: High

Justification: Many public vulnerabilities specific to mobile devices have been seen over the years, such
as Stagefright. Users jailbreak iOS devices and root Android devices to download third-party applications
and apply unique settings/configurations that the device would not typically be able to apply/access.

Level of Impact: High

Justification: Exploiting a vulnerability allows circumventing security controls and modifying protected
device data that should not be modified. Jailbroken and rooted devices may exploit kernel vulnerabilities
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and allow third-party applications/services root access that can also be used to bypass security controls
built-in or applied to a mobile device.

3425 Threat Event 5—Violation of Privacy via Misuse of Device Sensors

Summary: Malicious actors with access (authorized or unauthorized) to device sensors (microphone,
camera, gyroscope, Global Positioning System [GPS] receiver, and radios) can use them to conduct
surveillance. It may be directed at the user, as when tracking the device location, or it may be applied
more generally, as when recording any nearby sounds. Captured sensor data may be immediately useful
to a malicious actor, such as a recording of an executive meeting. Alternatively, the data may be
analyzed in isolation or in combination with other data to yield sensitive information. For example,
audio recordings of on-device or proximate activity can be used to probabilistically determine user
inputs to touchscreens and keyboards—essentially turning the device into a remote key logger.

Risk Assessment Analysis:

Overall Likelihood: Very High

Justification: This has been seen on public application stores in the past, with applications allegedly
being used for data collection [18]. As mentioned in Threat Event 1, unbeknownst to the user, a
downloaded application may be granted privacy-intrusive permissions that allow access to device
sensors.

Level of Impact: High

Justification: When the sensors are being misused, the user may not be aware. This allows collection of
sensitive enterprise data, such as location, without knowledge of the user.

3.4.2.6 Threat Event 6—Compromise of the Integrity of the Device or Its Network
Communications via Installation of Malicious EMM/MDM, Network, VPN
Profiles, or Certificates

Summary: Malicious actors who successfully install an Enterprise Mobility Management/Mobile Device
Management (EMM/MDM), network, or VPN profile or certificate onto a device will gain a measure of
additional control over the device or its communications. Presence of a malicious EMM/MDM profile
will allow an attacker to misuse existing OS application programming interfaces (APls) to send the device
a wide variety of commands. This may allow a malicious actor to obtain device information; install or
restrict applications; or remotely locate, lock, or wipe the device. Malicious network profiles may allow a
malicious actor to automatically compel the device to connect to access points under their control to
achieve a person-in-the-middle attack on all outbound connections. Alternatively, malicious VPN profiles
assist in the undetected exfiltration of sensitive data by encrypting it, thus hiding it from network
scanning tools. Additionally, malicious certificates may allow the malicious actor to compel the device to
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automatically trust connections to malicious web servers, wireless access points, or installation of
applications under the attacker’s control.

Risk Assessment Analysis:

Overall Likelihood: Moderate

Justification: Unlike installation of an application, installation of EMM/MDM, network, VPN profiles, and
certificates requires additional effort and understanding from the user to properly implement.

Level of Impact: Very High

Justification: If a malicious actor were able to install malicious configuration profiles or certificates, they
would be able to perform actions such as decrypt network traffic and possibly even control the device.

3.4.2.7  Threat Event 7—Loss of Confidentiality of Sensitive Information via
Eavesdropping on Unencrypted Device Communications

Summary: Malicious actors can readily eavesdrop on communication over unencrypted, wireless
networks such as public Wi-Fi access points, which are commonly provided by coffee shops and hotels.
While a device is connected to such a network, a malicious actor would gain unauthorized access to any
data sent or received by the device for any session not already protected by encryption at either the
transport or application layers. Even if the transmitted data were encrypted, an attacker may be privy to
the domains, internet protocol (IP) addresses, and services (as indicated by port numbers) to which the
device connects; such information could be used in future watering hole attacks or person-in-the-middle
attacks against the device user.

Additionally, visibility into network layer traffic enables a malicious actor to conduct side-channel
attacks against its encrypted messages, which can still result in a loss of confidentiality. Further,
eavesdropping on unencrypted messages during a handshake to establish an encrypted session with
another host or endpoint may facilitate attacks that ultimately compromise security of the session.

Risk Assessment Analysis:

Overall Likelihood: High

Justification: Users require network access to retrieve email and access cloud services and other
necessary data on the internet. Users can connect to readily available free internet access in public
venues such as coffee shops, hotels, and airports.

Level of Impact: High

Justification: Users may connect to unencrypted wireless networks, and many applications do not
properly encrypt network communications. Improper use of encryption, or lack thereof, allows a
malicious actor to eavesdrop on network traffic.
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3.4.2.8 Threat Event 8—Compromise of Device Integrity via Observed, Inferred, or
Brute-Forced Device Unlock Code

Summary: A malicious actor may be able to obtain a user’s device unlock code by direct observation,
side-channel attacks, or brute-force attacks. Both the first and second can be attempted with at least
proximity to the device; only the third technique requires physical access. However, side-channel attacks
that infer the unlock code by detecting taps and swipes to the screen can be attempted by applications
with access to any peripherals that detect sound or motion (microphone, gyroscope, or accelerometer).
Once the device unlock code has been obtained, a malicious actor with physical access to the device will
gain immediate access to any data or functionality not already protected by additional access control
mechanisms. Additionally, if the user employs the device unlock code as a credential to any other
systems, the attacker may further gain unauthorized access to those systems.

Risk Assessment Analysis:

Overall Likelihood: High

Justification: Unlike shoulder-surfing to observe a user’s passcode, brute-force attacks are not as
common or successful due to the built-in deterrent mechanisms. These mechanisms include exponential
back-off/lockout period and device wipes after a certain number of failed unlock attempts.

Level of Impact: High

Justification: If a malicious actor can successfully unlock a device without the user’s permission, they
could have full control over the user’s corporate account and thus gain unauthorized access to corporate
data.

3429 Threat Event 9—Unauthorized Access to Backend Services via Authentication
or Credential Storage Vulnerabilities in Internally Developed Applications

Summary: If a malicious actor gains unauthorized access to a mobile device, the attacker also has access
to the data and applications on that mobile device. The mobile device may contain an organization’s in-
house applications and can subsequently gain access to sensitive data or backend services. This could
result from weaknesses or vulnerabilities present in the authentication or credential storage
mechanisms implemented within an in-house application.

Risk Assessment Analysis:

Overall Likelihood: Very High

Justification: Often applications include hard-coded credentials for the default password of the
administrator account. Default passwords are readily available online. These passwords may not be
changed to allow for ease of access and to eliminate the pressure of remembering a password.
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Level of Impact: High

Justification: Successful extraction of the credentials allows an attacker to gain unauthorized access to
enterprise data.

3.4.2.10 Threat Event 10— Unauthorized Access of Enterprise Resources from an
Unmanaged and Potentially Compromised Device

Summary: An employee who accesses enterprise resources from an unmanaged mobile device may
expose the enterprise to vulnerabilities that may compromise enterprise data. Unmanaged devices do
not benefit from security mechanisms deployed by the organization such as mobile threat defense,
mobile threat intelligence, application vetting services, and mobile security policies. These unmanaged
devices limit an organization’s visibility into the state of a mobile device, including if the device is
compromised by a malicious actor. Therefore, users who violate security policies to gain unauthorized
access to enterprise resources from such devices risk providing attackers with access to sensitive
organizational data, services, and systems.

Risk Assessment Analysis:

Overall Likelihood: Very High
Justification: This may occur accidentally when an employee attempts to access their email.
Level of Impact: High

Justification: Unmanaged devices pose a sizable security risk because the enterprise has no visibility into
their security or risk posture. Due to this lack of visibility, a compromised device may allow an attacker
to attempt to exfiltrate sensitive enterprise data.

34211 Threat Event 11—Loss of Organizational Data Due to a Lost or Stolen Device

Summary: Due to the nature of the small form factor of mobile devices, they can be misplaced or stolen.
A malicious actor who gains physical custody of a device with inadequate security controls may be able
to gain unauthorized access to sensitive data or resources accessible to the device.

Risk Assessment Analysis:

Overall Likelihood: Very High

Justification: Mobile devices are small and can be misplaced. Enterprise devices may be lost or stolen at
the same frequency as personally owned devices.

Level of Impact: High

Justification: Similar to Threat Event 9, if a malicious actor can gain access to the device, they could
potentially have access to sensitive corporate data.
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34212 Threat Event 12—Loss of Confidentiality of Organizational Data Due to Its
Unauthorized Storage in Non-Organizationally Managed Services

Summary: If employees violate data management policies by using unmanaged services to store
sensitive organizational data, this data will be placed outside organizational control, where the
organization can no longer protect its confidentiality, integrity, or availability. Malicious actors who
compromise the unauthorized service account or any system hosting that account may gain
unauthorized access to the data.

Further, storage of sensitive data in an unmanaged service may subject the user or the organization to
prosecution for violation of any applicable laws (e.g., exportation of encryption) and may complicate
efforts by the organization to achieve remediation or recovery from any future losses, such as those
resulting from the public disclosure of trade secrets.

Risk Assessment Analysis:

Overall Likelihood: High

Justification: This could occur either intentionally or accidentally (e.g., taking a screenshot and backup
pictures to an unmanaged cloud service).

Level of Impact: High

Justification: Storage in unmanaged services presents a risk to the confidentiality and availability of
corporate data because the corporation would no longer control it.

3.4.3 I|dentification of Vulnerabilities and Predisposing Conditions

In Section 3.4, we identified vulnerabilities and predisposing conditions that increase the likelihood that
identified threat events will result in adverse impacts for Orvilia Development. Each vulnerability or
predisposing condition is listed in Table 3-2 along with the corresponding threat events and ratings of
threat pervasiveness. More details on the use of threat event ratings can be found in Appendix F.

Table 3-2 Identify Vulnerabilities and Predisposing Conditions

Vulnerability ID  Vulnerability or Predisposing Condition Resulting Threat | Pervasiveness
Events
VULN-1 Email and other enterprise resources can TE-2, TE-10, TE- | Very High
be accessed from anywhere, and only 11
username/password authentication is
required.
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Vulnerability ID  Vulnerability or Predisposing Condition Resulting Threat | Pervasiveness

Events

VULN-2 Public Wi-Fi networks are regularly used by | TE-7 Very High
employees for remote connectivity from
their corporate mobile devices.

VULN-3 No EMM/MDM deployment exists to TE-1, TE-3, TE-4, |Very High
enforce and monitor compliance with TE-5, TE-6, TE-7,
security-relevant policies on corporate TE-8, TE-9, TE-11,
mobile devices. TE-12

3.4.4 Summary of Risk Assessment Findings

Table 3-3 summarizes the risk assessment findings. More detail about the methodology used to rate
overall likelihood, level of impact, and risk can be found in Appendix F.

Table 3-3 Summary of Risk Assessment Findings

Vulnerabilities, | Overall Level of Risk

Threat Event Predisposing Likelihood Impact
Conditions

TE-1: Unauthorized access to sensitive | VULN-3 Very High | High High
information via a malicious or privacy-
intrusive application

TE-2: Theft of credentials through an VULN-1 Very High |High High
SMS or email phishing campaign

TE-3: Malicious applications installed VULN-3 High High High
via URLs in SMS or email messages

TE-4: Confidentiality and integrity loss VULN-3 High High High
due to exploitation of known
vulnerability in the OS or firmware

TE-5: Violation of privacy via misuse of | VULN-3 Very High | High High
device sensors
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Vulnerabilities, | Overall Level of {3

Threat Event Predisposing Likelihood Impact
Conditions

TE-6: Compromise of the integrity of VULN-3 Moderate |Very High High
the device or its network
communications via installation of
malicious EMM/MDM, network, VPN
profiles, or certificates

TE-7: Loss of confidentiality of sensitive | VULN-2, VULN-3 |High High High
information via eavesdropping on
unencrypted device communications

TE-8: Compromise of device integrity VULN-3 High High High
via observed, inferred, or brute-forced
device unlock code

TE-9: Unauthorized access to backend VULN-3 Very High | High High
services via authentication or
credential storage vulnerabilities in
internally developed applications

TE-10: Unauthorized access of VULN-1 Very High | High High
enterprise resources from an
unmanaged and potentially
compromised device

TE-11: Loss of organizational data due VULN-1, VULN-3 | Very High |High High
to a lost or stolen device

TE-12: Loss of confidentiality of VULN-3 High High High
organizational data due to its
unauthorized storage in non-
organizationally managed services

Note 1: Risk is stated in qualitative terms based on the scale in Table I-2 of Appendix | in NIST Special
Publication 800-30 Revision 1 [12].

Note 2: The risk rating itself is derived from both the overall likelihood and level of impact using Table I-
2 of Appendix I in NIST Special Publication 800-30 Revision 1 [12]. Because these scales are not true
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interval scales, the combined overall risk ratings from Table I-2 do not always reflect a strict
mathematical average of these two variables. This is demonstrated in the table above where levels of
moderate weigh more heavily than other ratings.

Note 3: Ratings of risk relate to the probability and level of adverse effect on organizational operations,
organizational assets, individuals, other organizations, or the nation. Per NIST SP 800-30 Revision 1,
adverse effects (and the associated risks) range from negligible (i.e., very low risk), limited (i.e., low),
serious (i.e., moderate), severe or catastrophic (i.e., high), to multiple severe or catastrophic effects (i.e.,
very high).

3.4.5 Privacy Risk Assessment

This section describes the privacy risk assessment conducted on Orvilia’s enterprise security
architecture. To perform the privacy risk assessment, the NIST Privacy Risk Assessment Methodology
(PRAM) was used. The PRAM is a tool for analyzing, assessing, and prioritizing privacy risks to help
organizations determine how to respond and select appropriate solutions. The PRAM can also serve as a
useful communication tool to convey privacy risks within an organization. A blank version of the PRAM is
available for download on NIST’s website [19].

The PRAM uses the privacy risk model and privacy engineering objectives described in NIST Internal
Report (NISTIR) 8062, An Introduction to Privacy Engineering and Risk Management in Federal Systems
[20], to analyze for problematic data actions. Data actions are any system operations that process PII.
Processing can include collection, retention, logging, analysis, generation, transformation or merging,
disclosure, transfer, and disposal of PIl. A problematic data action is one that could cause an adverse
effect for individuals. The PRAM activities identified the following potential problems for individuals.

3.4.5.1 Potential Problems for Individuals

Three data actions were identified in the PRAM that have the potential to create problems for
individuals. Those three data actions, along with their risk assessment analysis, follow:

= blocking access and wiping devices
= employee monitoring

= data sharing across parties

3.4.5.1.1 Data Action 1: Blocking Access and Wiping Devices

Employees are likely to use their devices for both personal and work-related purposes. Therefore, in a
system that features the capability to wipe a device entirely, there could be an issue of employees losing
personal data. This is a potential problem for individuals because employee use of work devices for both
personal and work-related purposes is common.
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Devices that might pose a risk to the organization’s security posture can be blocked from accessing
enterprise resources or wiped and reset to factory setting defaults, which could result in loss of
information contained on the device. Potential options for minimizing the impact to the employee
include:

= blocking the device’s access to enterprise resources until it is granted access permission again

= selectively wiping elements of the device without removing all data on the device. Within the
example solution, this option is available for iOS devices.

= advising employees to back up the personal data maintained on devices

= limiting staff with the ability to perform wipes or block access

3.4.5.1.2 Data Action 2: Employee Monitoring

Employees may not be aware of the monitoring of their interactions with the system and may not want
this monitoring to occur. Employer-owned or -controlled networks like Orvilia’s often can monitor
activities, and many do on a regular basis.

The assessed infrastructure offers Orvilia a number of security capabilities, including reliance on
comprehensive monitoring capabilities. A significant amount of data relating to employees, their
devices, and their activities is collected and analyzed by multiple parties. Potential options for
minimizing the impact to the employee include:

= |imit staff with ability to review data about employees and their devices
= develop organization policies and techniques to limit collection of specific data elements

= develop organization policies and techniques regarding disposal of PlI

3.4.5.1.3 Data Action 3: Data Sharing Across Parties
Data transmission about individuals and their devices among a variety of different parties could be
confusing for employees who might not know who has access to different information about them.

The infrastructure involves several parties that serve different purposes supporting Orvilia’s security
objectives. As a result, a significant flow of data about individuals and their devices occurs across various
parties.

If a wide audience of administrators and co-workers know which of their colleagues are conducting
activity on their devices that triggers security alerts, it could lead to undesired outcomes such as
employee embarrassment. Potential options for minimizing the impact to the employee include:

= developing organization policies and techniques for the de-identification of data
= using encryption

=  |imiting or disabling access to data
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= developing organization policies and techniques to limit the collection of specific data elements
= using contracts to limit third-party data processing

Additional information regarding these potential problems for individuals and potential options for
minimizing the impact to the employees is provided in Appendix G.

3.5 Solution Goals

This section describes the solution goals for revising Orvilia’s mobile security architecture. Here is an
overview of the security issues identified within Orvilia’s original (also known as current) mobile device
infrastructure architecture. To address these issues, a list of security goals was developed to provide a
high-level overview of factors that could be applied to improve the security of Orvilia’s mobile
architecture.

3.5.1 Current Architecture

Prior to investing in security improvements to their mobile infrastructure—as identified based on the
aforementioned risk assessment—Orvilia Development had not implemented a mobile security strategy.
Several weaknesses were identified based on their use of mobile devices. A subset of these weaknesses
is presented in Figure 3-4.
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Figure 3-4 Orvilia’s Mobile Deployment Before Security Enhancements
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The following issues are highlighted in Figure 3-4 with a red exclamation mark:

1. Organizational and personal data can become commingled if either the same application
is used in both contexts or if multiple applications access shared device resources (e.g.,
contacts or calendar).

2. Mobile devices are connecting to Orvilia from unencrypted public Wi-Fi hotspots; data
transmitted prior to a secure connection is subject to eavesdropping, including
passwords.

3. Applications for work or personal use may contain unidentified vulnerabilities or
weaknesses that increase the risk of device compromise.

4. Applications may be obtained outside official application stores, increasing the risk that
they are malware in disguise.

5. Because mobile devices can connect from unknown locations, firewall rules must allow
inbound connections from unrecognized, potentially malicious IP addresses.

NIST SP 1800-21B: Mobile Device Security: Corporate-Owned Personally-Enabled 27



"12-008T"dS’1SIN/8209 0T /840" 10p//:d1Y :wo4y 98Jeyd Jo 9344 d|qejieAe s| uofedlgnd sty

3.5.2 Security Goals

In considering improvement to the security of their current deployment, Orvilia was able to identify
high-level security goals to correct these shortcomings, as illustrated in Figure 3-5.

Figure 3-5 Orvilia’s Security Goals
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The following strategies are highlighted in Figure 3-5 with a green exclamation mark:

1. Organizational and personal information can be separated by restricting data flow
between organizationally managed and unmanaged applications. Sensitive data is
protected from crossing between work and personal contexts.

2. Mobile devices can connect to Orvilia over a VPN or similar solution to encrypt all data
before it is transmitted from the device, protecting otherwise unencrypted data from
interception.

3. Identifying applications with significant vulnerabilities or weaknesses facilitates blocking
or uninstalling those applications from managed devices, reducing their risk to the
organization.

4. Malware detection could be deployed to devices to identify malicious applications and
facilitate remediation.
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5. Mobile devices can be provisioned with a security certificate that allows them to be
identified and authenticated at the connection point, which combines with user
credentials to create two-factor authentication from mobile devices.

These high-level goals, obtained from a review of their current mobile security posture, provide
examples of why a thorough risk assessment process is beneficial to organizations implementing mobile
device security capabilities.

3.6 Technologies

This section describes the mobile-specific technology components used within this example solution.
These technologies were selected to address the security goals and threat events identified in the risk
assessment. This section provides a brief description of each technology and discusses the security
capabilities that each component provides to address Orvilia’s security issues. For additional
information, Appendix | provides the technologies used in this project and provides a mapping between
the specific product used and the cybersecurity standards and best practices that the product provides
in the example solution discussed in this guide.

3.6.1 Architecture Components

The security components in this section are combined into a cohesive enterprise security architecture to
enable enterprises to address mobile security threats and provide secure access to enterprise resources
from mobile devices. The security components described in this section provide protection for the
following enterprise architecture components that are accessed by Orvilia’s users with their mobile
devices.

= email/Outlook Web Access—contacts

= private chat server

= travel support

= organization intranet (e.g., internal announcements, organizational charts, policies)

= time reporting

36.1.1 Trusted Execution Environment

A trusted execution environment (TEE) is “a tamper-resistant processing environment that runs on a
separation kernel. It guarantees the authenticity of the executed code, the integrity of the runtime
states (e.g., central processing unit registers, memory and sensitive 1/0), and the confidentiality of its
code, data and runtime states stored on a persistent memory. In addition, it shall be able to provide
remote attestation that proves its trustworthiness for third-parties [21].”

NIST SP 1800-21B: Mobile Device Security: Corporate-Owned Personally-Enabled 29



"12-008T°dS’ LSIN/8Z09°0T/840°10p//:d1y :woly 981eYd JO 9244 d|qe|ieAe S| uolredljgnd siyL

3.6.1.2  Enterprise Mobility Management

Organizations use Enterprise Mobility Management solutions to secure the mobile devices of users who
are authorized to access organizational resources. Such solutions generally have two main components.
The first is a backend service that mobile administrators use to manage the policies, configurations, and
security actions applied to registered mobile devices. The second is an on-device agent, usually in the
form of a mobile application, that integrates between the mobile OS and solution’s backend service.
Alternatively, iOS supports a web-based EMM enrollment use case.

At a minimum, an EMM solution can perform MDM functions, which include the ability to provision
configuration profiles to devices, enforce security policies on devices, and monitor compliance with
those policies by devices. The on-device MDM agent can typically notify the device user of any
noncompliant settings and may be able to remediate some noncompliant settings automatically. The
organization can use policy compliance data to inform its access control decisions so that it grants access
only to a device that demonstrates the mandated level of compliance with the security policy that
applies to it.

EMM solutions commonly include any of the following: mobile application management, mobile content
management, and implementations of or integrations with device- or mobile OS-specific
containerization solutions, such as Samsung Knox (please refer to Appendix E for more information).
These capabilities can be used to manage installation and usage of applications based on the
applications’ trustworthiness and work relevance. Additionally, they can control how managed
applications access and use organizational data and possibly strengthen the separation between a user’s
personal and professional usage of the device.

Further, EMM solutions often have integrations with a diverse set of additional tools and security
technologies that enhance their capabilities. An example is an EMM embedded with a mobile threat
defense tool that serves to perform on-device, behavioral-based threat detection and to trigger policy
remediation without the need to communicate to any server or service outside the device. This type of
integration allows one application, the EMM agent, to manage, detect, and remediate device, network,
application, malware, and spear phishing attacks. Additionally, because the remediation is autonomous
at the device (does not require reaching a policy server), it has the advantage in addressing network-
based threat vectors such as Pineapple or Stingray impersonation of valid Wi-Fi or cellular networks
[22].

For further reading, NIST SP 800-124 Revision 2 Draft, Guidelines for Managing the Security of Mobile
Devices in the Enterprise [13], provides additional information on mobile device management with EMM
solutions. Additionally, NIAP’s Protection Profile for Mobile Device Management Version 4.0 [23]
describe important capabilities and security requirements to look for in EMM systems.
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3.6.13 Virtual Private Network

A VPN gateway increases the security of remote connections from authorized mobile devices to an
organization’s internal network. A VPN is a virtual network, built on top of existing physical networks,
which can provide a secure communications mechanism for data and control information transmitted
between networks. VPNs are used most often to protect communications carried over public networks
such as the internet. A VPN can provide several types of data protection, including confidentiality,
integrity, data origin authentication, replay protection, and access control that help reduce the risks of
transmitting data between network components.

VPN connections apply an additional layer of encryption to the communication between remote devices
and the internal network, and VPN gateways can enforce access control decisions by limiting which
devices or applications can connect to it. Integration with other security mechanisms allows a VPN
gateway to base access control decisions on more risk factors than it may be able to collect on its own;
examples include a device’s level of compliance with mobile security policies or the list of installed
applications that are not allowed by the organization as reported by an integrated EMM.

NIAP’s Extended Package for VPN Gateways [24], in combination with the internationally and
collaboratively developed Protection Profile for Network Devices [25], describes important capabilities
and security requirements to expect from VPN gateways.

3.6.1.4 Mobile Application Vetting Service

Mobile application vetting services use a variety of static, dynamic, and behavioral techniques to
determine if an application demonstrates any behaviors that pose a security or privacy risk. The risk may
be to a device owner or user, to parties that own data on the device, or to external systems to which the
application connects. The set of detected behaviors is often aggregated to generate a singular score that
estimates the level of risk (or conversely, trustworthiness) attributed to an application. Clients can often
adjust the values associated with given behaviors (e.g., hard-coded cryptographic keys) to tailor the
score for their unique risk posture. Those scores may be further aggregated to present a score that
represents the overall risk or trustworthiness posed by the set of applications currently installed on a
given device.

Mobile applications, malicious or benign, have high potential to negatively impact both security and user
privacy. A malicious application can contain code intended to exploit vulnerabilities present in
potentially any targeted hardware, firmware, or software on the device. Alternatively, or in conjunction
with exploit code, a malicious application may misuse any device, personal, or behavioral data to which
it has been explicitly or implicitly granted access, such as contacts, clipboard data, or location services.
Benign applications may still present vulnerabilities or weaknesses that malicious applications can
exploit to gain unauthorized access to its data or functionality. Further, benign applications may place
user privacy at risk by collecting more information than is necessary for the application to deliver
functionality desired by the user.
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While not specific to applications, some services may include device-based risks (e.g., lack of disk
encryption or vulnerable OS version) in their analysis to provide a more comprehensive assessment of
the risk or trustworthiness presented by a device when running an application or service.

NIAP does not provide a Protection Profile for application vetting services themselves. However, NIAP’s
Protection Profile for Application Software [26] describes security requirements to be expected from
mobile applications. Many mobile application vetting vendors provide capabilities to automate
evaluation of applications against NIAP’s requirements.

3615 Mobile Threat Defense

MTD generally takes the form of an application that is installed on the device, which provides the widest
and most timely access to information about what activity is taking place. Ideally, the MTD solution will
be able to detect unwanted activity and properly inform the user so they can act to prevent or limit the
harm an attacker could cause. Additionally, MTD solutions may integrate with EMM solutions to
leverage the EMM agent’s on-device capabilities, such as blocking a malicious application from being
launched until the user can remove it.

MTD products typically analyze device-based, application-based, and network-based attacks. Device-
based threats include outdated operating system versions and insecure configuration settings.
Application-based threats include the issues discussed above regarding the mobile application vetting
service, though sometimes without the same breadth or depth found in services dedicated to
application vetting. Network-based attacks include use of unencrypted or public Wi-Fi networks and
attacks such as active attempts to intercept and decrypt network traffic.

3.6.1.6  Mobile Threat Intelligence

In this guide, we describe mobile threat intelligence as actionable information that mobile
administrators can use to make changes to their security configuration to improve their posture relative
to recent discoveries. Intelligence data include malicious URLs, IP addresses, domain names, and
application names or package/bundle IDs, as well as malware signatures or vulnerabilities in
applications, mobile devices, device platform services, or mobile security products. This list is not all-
encompassing, as any recent information that could inform rapid changes to enable an enterprise to
better secure a mobile deployment against novel or newly enhanced threats is equally applicable to the
term. This capability may be found in various other types of technology, such as MTD and other network
analysis tools.

3.6.1.7  Mobile Operating System Capabilities

Mobile OS capabilities are available without the use of additional security features. They are included as
part of the mobile device’s core capabilities. The following mobile OS capabilities can be found in mobile
devices, particularly mobile phones.
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3.6.1.7.1 Secure Boot

Secure boot is a general term that refers to a system architecture designed to prevent and detect any
unauthorized modification to the boot process. A system that successfully completes a secure boot has
loaded its start-up sequence information into a trusted operating system. A common mechanism is for
the first program executed (a boot loader) to be immutable (stored on read-only memory or
implemented strictly in hardware). Further, the integrity of mutable code is cryptographically verified
prior to execution by either immutable or verified code. This process establishes a chain of trust that can
be traced back to immutable, implicitly trustworthy code. Use of an integrated TEE as part of a secure
boot process is preferable to an implementation that uses software alone [27].

3.6.1.7.2 Device Attestation

This is an extension of the secure boot process that involves the operating system (or more commonly,
an integrated TEE) providing cryptographically verifiable proof that it has a known and trusted identity
and is in a trustworthy state, which means all software running on the device is free from unauthorized
modification.

Device attestation requires cryptographic operations using an immutable private key that can be verified
by a trusted third party, which is typically the original equipment manufacturer of the TEE (e.g.,
Qualcomm or Samsung) or device platform vendor (e.g., Google, Apple, or Microsoft). Proof of
possession of a valid key establishes the integrity of the first link in a chain of trust that preserves the
integrity of all other pieces of data used in the attestation. It will include unique device identifiers,
metadata, and the results of integrity checks on mutable software, and possibly metrics from the boot
or attestation process itself [27].

3.6.1.7.3 Device Management and MDM API

Mobile operating systems and platform-integrated firmware (e.g., Samsung Knox) provide a number of
built-in security features that are generally active by default. Examples include disk and file-level
encryption, verification of digital signatures for installed software and updates, a device unlock code,
remote device lock, and automatic device wipe following a series of failed device unlock attempts. Some
of these features are directly configurable by the user via a built-in application or through a service
provided by the device platform vendor (e.g., Google, Apple, or Microsoft).

Additionally, mobile operating systems expose an APl to MDM products that allow an organization that
manages a device to have greater control over these and many more settings that might not be directly
accessible to the device user. Management APIs allow enterprises using integrated EMM or MDM
products to manage devices more effectively and efficiently than they could by using the built-in
application alone.
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4 Architecture
This section helps familiarize the reader with the example solution’s:

= architecture description
= enterprise security architecture privacy data map

= security control map

This example solution consists of the six mobile security technologies described in Section 3.6: trusted
execution environment, enterprise mobility management, virtual private network, mobile application
vetting service, mobile threat defense, and mobile threat intelligence. Table 4-1, identifies the
commercially available products used in this example solution and how they aligned with the six mobile
security technologies.

Table 4-1 Commercially Available Products Used

Commercially Available Product Mobile Security Technology
Appthority Cloud Service Mobile threat intelligence
Kryptowire Cloud Service Mobile application vetting service
Lookout Cloud Service/Lookout Mobile threat defense

Agent Version 5.10.0.142 (iOS),
5.9.0.420 (Android)

Mobilelron Core Version 9.7.0.1 Enterprise mobility management

Mobilelron Agent Version 11.0.1A
(i0S), 10.2.1.1.3R (Android)

Palo Alto Networks, PA-220 Virtual private network
Version 8.1.1
Qualcomm, (version is mobile Trusted execution environment

device dependent)

These components are further integrated with broader on-premises security mechanisms and a VPN
gateway as shown in Figure 4-1. This integrated solution provides a broad range of capabilities to help
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securely provision and manage devices, protect against and detect device compromise, and help provide
security-enhanced access to enterprise resources by only authorized mobile users and devices.

Organizations exploring the use of on-premises EMM technology should be aware they will be
responsible for installing and configuring the on-premises instances of the EMM technology. This will
include the software licenses that must be paid for directly by the organization for any underlying
platforms or components. Pre-built software images and containers may be available that can help ease
installation and configuration work. As a recommended best practice, if prebuilt containers and images
are used, it is recommended that they be checked for common software vulnerabilities.

On-premises mobile device management solutions offer the benefit that enterprise data resides within
the organization. Allowed devices may still send and receive information from the mobile device
solution that they are authorized to obtain. Organizations that are interested can explore monitoring
data flows from the EMM to other devices. Additionally, on-premises mobile device management
solutions provide the organization with the capability to maintain physical security of the EMM.

Figure 4-1 Example Solution Architecture
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4.1 Architecture Description

The NCCoE worked with industry subject matter experts to develop an open, standards-based,
commercially available architecture that addresses the risks identified during the risk assessment
process in Section 3.4.

Where possible, the architecture uses components that are present on NIAP’s Product Compliant List
[28], meaning the product has been successfully evaluated against a NIAP-approved Protection Profile
[26]. NIAP collaborates with a broad community, including industry, government, and international
partners, to publish technology-specific security requirements and tests in the form of Protection
Profiles. The requirements and tests in these Protection Profiles are intended to ensure that evaluated
products address identified security threats.

The example solution architecture supports its desired security characteristics as a result of the
following integrations.

4.1.1 Enterprise Integration

This example solution extends central identity and access management to mobile devices via an
integration between both Mobilelron Core and Palo Alto Networks GlobalProtect with Microsoft Active
Directory Domain Services (ADDS). The integrity of identification and authentication by mobile devices
to the enterprise is further enhanced by using device certificates issued by local Microsoft Active
Directory Certificate Services (ADCS).

By integrating with AD, Mobilelron Core allows administrators to authorize select groups of users to
register a mobile device, limiting mobile access to only those users who require it. Additionally, different
security policies, device configurations, and authorized applications can be deployed to different AD
groups, allowing administrators to centrally manage distinct mobile use cases. Mobilelron Core queries
AD using the lightweight directory access protocol.

Through its integration with ADCS, Mobilelron Core automatically configures devices to obtain locally
managed device certificates by using the Simple Certificate Enrollment Protocol (SCEP). Our example
solution mitigates the potential of remote exploitation of SCEP by restricting certificate enrollment to
mobile devices that are connected to a dedicated enterprise-managed Wi-Fi network that allows devices
to access only Mobilelron Core and the Network Device Enrollment Service server. Further, this example
solution uses a dynamic SCEP scheme, in which Mobilelron Core supplies a registered mobile device
with a onetime password to include in its SCEP request, thus helping prevent unknown and untrusted
devices that gain unauthorized access to the dedicated Wi-Fi network from obtaining a trusted device
certificate.

The example solution’s chosen certificate enrollment configuration includes the mobile user’s User
Principal Name (UPN) in the device certificate’s Subject Alternative Name field, which the Palo Alto
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Networks GlobalProtect VPN gateway uses to perform chain validation and enforce access control for
the unique combination of mobile user and device.

Mobilelron Core-registered devices also utilize the device certificate indirectly to enhance the security of
remote connections to the enterprise in two ways. First, communication with Mobilelron Core (which
must be accessible from the internet in the demilitarized zone) is secured using two-way Transport Layer
Security (TLS). This protects Mobilelron Core from establishing secure connections with untrusted
mobile devices. Second, the device certificate is used in the GlobalProtect VPN configuration, which
restricts access to the VPN to only trusted devices. Further, GlobalProtect uses the device user’s UPN to
grant appropriate access to enterprise resources based on the device user’s UPN through its integration
with ADDS.

As shown in Figure 4-2 [29], devices present the certificates to the VPN and EMM authentication
services after the certificates have been successfully issued. The GlobalProtect VPN authenticates the
device user. On successful authentication, the GlobalProtect application prompts the user to
authenticate using a second factor-their Active Directory domain password. Once this is verified,
GlobalProtect establishes a tunnel with the gateway and is assigned an IP address from the IP pool in the
gateway’s tunnel configuration.
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Figure 4-2 Example Solution Gateway Architecture
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4.1.2 Mobile Component Integration

This section describes how the various mobile technology components integrate with one another. The
majority of these components integrate with the EMM, Mobilelron. Mobilelron supports the integration
of third-party cloud services through a defined API. Mobilelron Core authenticates external systems by
using basic authentication, so TLS protects the confidentiality of APl account credentials and
Mobilelron’s responses to clients’ Representational State Transfer calls. Mobilelron API client accounts
for Kryptowire, Lookout Mobile Endpoint Security, and Appthority Mobile Threat Protection (MTP) are
each assigned administrative roles that grant the minimum set of permissions necessary to achieve
integration [30], [31].

4.1.2.1  Appthority—Mobilelron

The Appthority application reputation service provides an integration with Mobilelron Core systems
through implementation of connector software provided by Appthority. The connector provides the
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code that exercises the APIs provided by Mobilelron Core and the Appthority cloud service. In this
integration, an APl user was created within the Mobilelron Core system and assigned specific roles
required for successful operation of the application vetting service.

Automatic syncing between the Appthority service and Mobilelron Core system can occur on a
configurable basis. Specifically, the application and device inventory data are synced between the two
systems. In this integration, syncing occurs every hour, but this value should be adjusted to fit the needs
of the organization.

In this example solution, the integration provides the primary security benefit of compliance
enforcement and remediation escalation. In the initial step of the process, the application inventory is
gathered from the Mobilelron Core system, and each application is assigned a threat measurement
score. If an application is installed on a device that is not compliant with the configured policy,
Appthority MTP communicates with the Mobilelron Core system to identify those devices, which
triggers Mobilelron compliance enforcement actions.

4.1.2.2 Lookout—Mobilelron

The Lookout mobile threat defense service provides integration with Mobilelron Core systems through
implementation of connector software provided by Lookout. The connector provides the code that
exercises the APIs provided by Mobilelron Core and the Lookout cloud service. This integration allows
Lookout to retrieve device details as well as application inventory information and to apply labels to
devices as necessary.

Following analysis, Lookout uses the API to apply specific labels to devices to categorize them based on
risk posture, which is calculated based on the severity of issues detected on the device. Mobilelron can
then automatically respond to application of specific labels based on built-in compliance actions. This
allows administrators to configure exactly how Mobilelron will respond to devices in the following
categories:

= Pending—Lookout not yet activated

= Secured-Lookout active

= Threats Present—Lookout has detected threats

= Deactivated—Lookout has been deactivated

= Low Risk—devices with a low risk score in Lookout

= Moderate Risk—devices with a moderate risk score in Lookout

= High Risk—devices with a high-risk score in Lookout
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4.1.2.3 Kryptowire—Mobilelron

Kryptowire obtains device details, such as device platform, OS version, and the universally unique
identifiers assigned to each registered device by Mobilelron Core to enable clear identification of a
particular device across systems. Kryptowire obtains the inventory of applications from all of the devices
enrolled in Mobilelron.

Kryptowire performs static, dynamic, and behavioral binary code analysis on mobile applications against
government (NIAP) and industry (The Open Web Application Security Project, or OWASP) [32] standards.
Kryptowire provides both a detailed security analysis, provides pass/fail evidence down to the line of
code, and provides a summary weighted risk score for each application.

Mobile application administrators can use these detailed reports to inform decisions on which
applications are trusted and compliant with enterprise security and privacy policies and which are
restricted for enterprise or personal use.

4.1.24 Palo Alto Networks—Mobilelron

Palo Alto Networks’ GlobalProtect VPN is used to secure remote connections from mobile devices.
Mobilelron Core offers specific configuration options for the GlobalProtect client available on Android
and iOS that facilitates secure deployment of VPN clients and enablement of VPN access using
certificate-based authentication to the GlobalProtect gateway. Details of the certificate enroliment
process are provided in Section 4.1.1

The VPN architecture used in this example solution is composed of two components of the Palo Alto
Networks next-generation firewall-a GlobalProtect portal and a GlobalProtect gateway. The portal
provides the management functions for VPN infrastructure. Every endpoint that participates in the
GlobalProtect network receives configuration information from the portal, including information about
available gateways as well as any client certificates that may be required to connect to the GlobalProtect
gateway(s).

The gateway provides security enforcement for traffic from GlobalProtect applications. It is configured
to provide access to specific enterprise resources only to mobile device users after a successful
authentication and authorization decision.

The VPN tunnel negotiation between the VPN endpoint/mobile device and the VPN gateway is
presented in Figure 4-3 [33]. It demonstrates a user logging into the system (1), the portal returning the
client configuration (2), the agent automatically connecting to the gateway and establishing a VPN
tunnel (3), and the gateway’s security policy enabling access to internal and external applications (4).
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Figure 4-3 Example Solution VPN Architecture
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For our example solution, we chose to enforce an always-on VPN configuration. This configuration
causes registered devices to establish a VPN connection to the GlobalProtect gateway whenever they
have network connectivity—this occurs over cellular or Wi-Fi and is persistent across device reboot. This
configuration affords devices with the greatest degree of protection, as additional Palo Alto Networks
services can be extended to GlobalProtect. This example solution uses URL filtering, which blocks mobile
devices from accessing prohibited internet domains or any domain that Palo Alto Networks associates
with active exploits (e.g., phishing campaigns, watering hole attacks, botnet command and control). NIST
SP 800-46 Revision 2, Guide to Enterprise Telework, Remote Access, and BYOD Security [34], describes
the most common VPN options used for remote workers.

4.1.2.4.1 FIPS Compliance

Any sensitive information passing over the internet, wireless networks, and other untrusted networks
should have its confidentiality and integrity preserved through cryptography [34]. While federal
agencies are required to use cryptographic algorithms that are NIST-approved and contained in Federal
Information Processing Standards (FIPS)-validated modules, adoption of these standards is available to
private and commercial organizations [35]. This example solution uses these best practices in the
following ways:

= FIPS-CC mode in the GlobalProtect VPN appliance is enabled, which requires TLS 1.1 (or above)
and limits the public key use to FIPS-approved algorithms. This example solution’s
implementation uses the highest version of TLS available, with TLS 1.2 being the minimum
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acceptable version. A full list of security functions can be found on the Palo Alto Networks FIPS-
CC Security Functions documentation site [36].

= Asdescribed in Section 4.1.1, dynamic SCEP challenges are enabled.

To align our example solution with guidance in NIST SP 800-52 Revision 2, Guidelines for the Selection,
Configuration, and Use of Transport Layer Security (TLS) Implementations [37], this example solution
implements the following configuration:

= The GlobalProtect portal and gateway restrict the list of cipher suites available to the client
application by using a TLS service profile. The minimum version of TLS is set to 1.2 as
recommended by NIST SP 800-52.

= The GlobalProtect portal and gateway server certificates use 2048-bit RSA key modulus signed
with sha256WithRSAEncryption algorithm.

4.1.2.5  iOS and Android EMM Integration

iOS and Android-based devices both integrate directly with EMM solutions, providing enterprise-level
management of security controls based on policy.

iOS Integration

iOS devices are managed by configuration profiles. Configuration profiles can force security policies such
as VPN usage, enterprise Kerberos support, and access to cloud services. iOS further incorporates a set
of additional security controls in what is termed supervised mode, which denotes a corporately owned
device. Typically, organizations choose to use the Apple Business Manager (formerly Device Enrollment
Program) [38] for large-scale deployments of iOS devices in supervised mode due to the reduction of
labor involved in manually configuring each device. However, due to the small number of devices in our
reference design, we have configured supervised mode using the Apple Configurator 2 tool [39]. A
description of iOS security capabilities can be found in Apple Platform Security [40].

Android Integration

Similarly, Android-based devices offer security controls that an EMM can leverage for enterprise
deployments. The Android Enterprise program by Google is available on devices with Android 5.0
(Lollipop) and higher. An EMM deploys a device policy controller [41] as part of its on-device agent that
controls local device policies and system applications on devices. A newer mode introduced in Android
8.0 supports fully-managed devices with a work profile, intended for COPE deployments [42], [43], [44].
In this scenario, the device is corporately owned. Device level controls such as device wipe and reset to
factory default settings are available. A work profile is also created to keep enterprise applications and
data separate from any personal data. This scenario allows for some flexibility of the device owner to
permit personal use of the device while retaining device controls and is the chosen deployment of this
reference implementation.
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4.2 Enterprise Security Architecture Privacy Data Map

Orvilia performed a privacy analysis using both the information gathered in the initial PRAM effort and the identified mobile security
technologies included in the revised architecture. The output from the PRAM activities, including data flows between the components, along
with their on-premises or cloud-based location, resulted in the information contained in Figure 4-4. Note: The Key within this figure includes all
data action types, but this particular example solution does not cover the Disposal of data in the Privacy Data Mapping exercise. For additional
information on the PRAM activities, see Appendix G.

Figure 4-4 NIST Privacy Risk Assessment Methodology Data Map for Orvilia’s Enterprise Security Architecture
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4.3 Security Control Map

Using the developed risk information as input, the security characteristics of the solution were
identified. A security control map was developed documenting the example solution’s capabilities with
applicable Subcategories from the NIST Cybersecurity Framework Version 1.1 [5]; NIST SP 800-53
Revision 4, Security and Privacy Controls for Federal Information Systems and Organizations [11];
International Organization for Standardization (ISO), International Electrotechnical Commission (IEC)
27001:2013, Information technology—Security techniques—Information security management systems —
Requirements [45]; the Center for Internet Security’s Control set [46] Version 6; and NIST SP 800-181,
National Initiative for Cybersecurity Education (NICE) Cybersecurity Workforce Framework [7].

The security control map identifies the security characteristic standards mapping for the products as
they were used in the example solution. The products may be capable of additional capabilities not used
in this example solution. For that reason, it is recommended the mapping not be used as a reference for
all of the security capabilities these products may be able to address. The security control map can be
found in Table I-1.

This section helps familiarize the reader with:
= assumptions and limitations
= build testing

= scenarios and findings

The purpose of the security characteristic analysis is to understand the extent to which the project
meets its objective of demonstrating how to increase the security of mobile devices within an enterprise
by deploying EMM, MTD, MTI, application vetting, secure boot/image authentication, and VPN services.

5.1 Analysis Assumptions and Limitations

The security characteristic analysis has the following limitations:

= |tis neither a comprehensive test of all security components nor a red-team exercise.
= [t cannot identify all weaknesses.

= |t does not include the lab infrastructure. It is assumed those systems are hardened. Testing
these devices would reveal only weaknesses in implementation that would not be relevant to
those adopting this reference architecture.
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5.2 Build Testing

Functional testing was used to confirm the example solution’s capabilities. We use the test activities to
demonstrate Orvilia’s susceptibility to the threat before implementing the architecture detailed in this
practice guide. We use the test activities again after implementing the architecture to demonstrate that
the threats have been appropriately addressed.

5.2.1 Threat Event 1 —Unauthorized Access to Sensitive Information via a
Malicious or Privacy-Intrusive Application

Summary: Unauthorized access to sensitive information via a malicious or privacy-intrusive application
is tested. We tested this threat by placing a mock sensitive enterprise contact list and calendar entries
on devices, then attempted to install and use applications on the Apple App Store and Google Play Store
[47] that access and back up those entries. Ideally, the enterprise’s security architecture would either
detect or prevent use of these applications, or it would block the applications from accessing enterprise-
controlled contact list and calendar entries.

Test Activity: Install an iOS or Android application that accesses the contact and calendar entries and
backs them up to a cloud service. We have no reason to believe these applications are malicious.
However, the behavior of accessing and backing up enterprise-controlled data (contacts and calendar
entries) without authorization presents an activity that should be mitigated by this example solution’s
security architecture.

Desired Outcome: The enterprise’s security architecture should identify the presence of the applications
and the fact that they access contact and calendar entries. The security architecture should block these
applications from installing, block them from running, or detect their presence and cause another
appropriate response to occur, such as blocking the mobile device from accessing enterprise resources
until the applications are removed.

Alternatively, built-in device mechanisms such as Apple’s managed applications functionality and
Google’s Android enterprise work profile functionality could be used to separate the contact and
calendar entries associated with enterprise email accounts, so they can be accessed only by enterprise
applications (applications authorized and managed by the EMM), not applications manually installed by
the user. The user should not have the ability to manually provision their enterprise email account. The
account should be able to be provisioned only by the EMM, enabling enterprise controls on the
enterprise contact list and calendar data. However, in this practice guide build, we chose to make the
devices fully managed, not divided into separate enterprise and personal areas.

Observed Outcome: Appthority identified the presence of applications that have access to sensitive
data and updated the device labels in Mobilelron Core.
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5.2.2 Threat Event 2 —Theft of Credentials Through an SMS or Email Phishing
Campaign

Summary: A fictitious phishing event was created where protection against theft of credentials through
an SMS or email phishing campaign was tested.

Test Activity:

= Establish a web page with a form that impersonates an enterprise login prompt.

= Send the web page’s URL via SMS or email and attempt to collect and use enterprise login
credentials.

Desired Outcome: The enterprise’s security architecture should block the user from browsing to known
malicious websites. Additionally, the enterprise should use multifactor authentication or phishing-
resistant authentication methods, such as those based on public key cryptography, so that either there
is no password for a malicious actor to capture, or capturing the password is insufficient to obtain access
to enterprise resources.

Observed Outcome: The example solution used Palo Alto Networks’ next-generation firewall. The
firewall includes PAN-DB, a URL filtering service that automatically blocks known malicious URLs. The
URL filtering database is updated regularly to help protect users from malicious URLs. The next-
generation firewall blocked the attempt to visit the phishing site because the malicious URL was present
in PAN-DB. This kept the user from accessing the phishing site.

5.2.3 Threat Event 3—Malicious Applications Installed via URLs in SMS or Email
Messages

Summary: Unauthorized applications, not present on the official Apple App Store or Google Play Store,
are installed via URL links in SMS, email messages, or third-party websites.

Test Activity (Android):

= Send an email to the user containing a link to a file with a message urging the user to click on
the link to install the application.

= On the device, if not already enabled, attempt to enable the Unknown Sources toggle setting in
the device security settings to allow installing applications from sources other than the Google
Play Store.

= On the device, read the received email, click on the link, and attempt to install the F-Droid
application.

= Observe whether the F-Droid application could be successfully installed. If so, observe whether
the enterprise detected and responded to installation of the unauthorized application.

Test Activity (iOS):
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= Send an email to the user containing a link to an iOS application available for installation from a
website, along with a message urging the user to click on the link to install the application.

=  On the device, read the received email, click on the link, and attempt to install the application.

= On the device, attempt to explicitly trust the developer’s signing certificate. Then attempt to run
the application.

= Observe whether the application could run. If so, observe whether the enterprise detected and
responded to installation of the unauthorized application.

Desired Outcome: The device does not allow the user to install the unauthorized application. If the
application is somehow installed, its presence should be detected, and an appropriate response should
occur, such as blocking the device from accessing enterprise resources until the application is removed.

Observed Outcome: On iOS devices, Lookout detected that an application had been sideloaded, and it
applied a label to the device. Mobilelron then quarantined the device (removed the device’s access to
enterprise resources) until the threat was resolved.

On iOS devices, Mobilelron has a configuration option that prohibited the user from trusting the
developer certificate.

On Android devices, Mobilelron has a configuration option that prohibited the user from enabling
Unknown Sources on the device.

5.2.4 Threat Event 4 —Confidentiality and Integrity Loss due to Exploitation of
Known Vulnerability in the OS or Firmware

Summary: When malware successfully exploits a code execution vulnerability in the mobile OS or device
drivers, the delivered code generally executes with elevated privileges and issues commands in the
context of the root user or the OS kernel.

Test Activity: Attempt to access enterprise resources from a mobile device with known vulnerabilities
(e.g., running an older, unpatched version of iOS or Android).

Desired Outcome: The enterprise’s security architecture should identify the presence of devices that are
running an outdated version of iOS or Android susceptible to known vulnerabilities. It should be
possible, when warranted by the risks, to block devices from accessing enterprise resources until system
updates are installed.

Observed Outcome: Lookout identified that devices were running outdated operating systems. This
information was communicated to Mobilelron, which subsequently automatically quarantined the
devices until the operating system was updated.
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5.2.5 Threat Event 5 —Violation of Privacy via Misuse of Device Sensors

Summary: There is collection of location, camera, or microphone data by an application that has no
need to access this data.

Note: Not all applications that have access to location, camera, or microphone data are malicious.
However, when an application is found to be collecting this information, additional vetting or testing
may be required to determine the intent of its use and to then determine if the application is malicious.

Test Activity: Upload the application to Kryptowire; observe the output report.

Desired Outcome: Output report identifies the use of location, camera, or microphone use by the
application.

Observed Outcome: The Kryptowire report identified the use of location sensor, camera, or microphone
by the application. An administrator could then perform further testing on the application, and if
necessary, identify the application as prohibited within the EMM.

5.2.6 Threat Event 6—Compromise of the Integrity of the Device or Its Network
Communications via Installation of Malicious EMM/MDM, Network, VPN
Profiles, or Certificates

Summary: There is compromise of the integrity of the device or its network communications via

installation of malicious EMM/MDM, network, VPN profiles, or certificates using a person-in-the-middle
approach.

Test Activity:

= Install mitmproxy (https://mitmproxy.org/) on a computer (we used a Mac) connected to the
same Wi-Fi network as the mobile devices.

= Install mitmproxy’s CA certificate (stored at ~/.mitmproxy/mitmproxy-ca-cert.cer on our Mac)
onto the mobile devices being tested. iOS- and Android-specific instructions are found below.

= Configure the computer as necessary to run mitmproxy in transparent mode, as described in
https://docs.mitmproxy.org/stable/howto-transparent/.

= Toillustrate a malicious actor’s ability to manipulate network traffic, we downloaded the
mitmproxy internet_in_mirror script from https://docs.mitmproxy.org/stable/addons-
examples/#internet-in-mirror. It performs a mirror reflection of the content of all websites.

= Run mitmproxy in transparent mode and using the internet_in_mirror script: mitmproxy —mode
transparent —ssl-insecure —showhost -s internet_in_mirror.py

= Rather than perform an intrusive attack such as address resolution protocol spoofing, we
manually configured each mobile device’s Wi-Fi network settings to change the default
gateway’s (sometimes referred to as router in the network settings) IP address to the

NIST SP 1800-21B: Mobile Device Security: Corporate-Owned Personally-Enabled 48


https://mitmproxy.org/
https://docs.mitmproxy.org/stable/howto-transparent/
https://docs.mitmproxy.org/stable/addons-examples/#internet-in-mirror
https://docs.mitmproxy.org/stable/addons-examples/#internet-in-mirror

"T2-008T°dS’ LSIN/8Z09°0T/840°10p//:d1y :wouly 981eyd JO 9244 d|qe|ieAe S| uonrealjgnd siyL

computer’s IP address rather than the router’s IP address. This configuration change forced all
the network traffic from each device through the computer.

Test Activity (Android):

=  Place mitmproxy’s CA certificate as an attachment within an email message.

= QOpen the email message on the Android device and click on the attachment to attempt to install
the CA certificate.

=  Modify the device’s Wi-Fi network settings to manually change the default gateway’s IP address
to the address of the computer running mitmproxy.

=  Browse to a hypertext transfer protocol secure (https) website (e.g.,
https://www.nccoe.nist.gov), and observe whether the content has been reversed, illustrating
that the person-in-the-middle attack on a TLS-protected connection was successful.

Test Activity (iOS):

= Use Apple Configurator 2 on a Mac, or another tool, to create an iOS configuration profile
containing mitmproxy’s CA certificate. The configuration profile used in testing was named
Enterprise Access. The configuration profile was signed using a key associated with an Apple
free developer account certificate. The signature was optional (Configuration profiles do not
have to be signed).

= Send the configuration profile as an attachment within an email message.

= Open the email message and attempt to click on the attachment to install the configuration
profile. Attempt to follow the prompts to complete the profile installation.

= Attempt to enable the CA certificate in the iOS device’s Certificate Trust Settings.

Desired Outcome: The enterprise’s security architecture should block installation of unauthorized
configuration profiles (iOS) or CA certificates (Android). Alternatively, the security architecture may
detect the presence of unauthorized configuration profiles or CA certificates and perform another
appropriate action, such as blocking the device from accessing enterprise resources until the
configuration profile or CA certificate is removed. The architecture should also detect attempted
person-in-the-middle attacks.

Observed Outcome: Lookout detected a person-in-the-middle attack on both iOS and Android devices.
Lookout also detected the unknown configuration profile on iOS.

5.2.7 Threat Event 7—Loss of Confidentiality of Sensitive Information via
Eavesdropping on Unencrypted Device Communications
Summary: Malicious actors can readily eavesdrop on communication over unencrypted, wireless

networks such as public Wi-Fi access points, which are commonly provided by coffee shops and hotels.
While a device is connected to such a network, a malicious actor would gain unauthorized access to any
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data sent or received by the device for any session not already protected by encryption at either the
transport or application layers.

Test Activity: Test if applications will attempt to establish an http or unencrypted connection.

Desired Outcome: Be alerted when applications attempt to make an unencrypted connection or prevent
the application from being able to do so.

Appthority can determine if applications will attempt to establish an http or unencrypted connection.

iOS and Android also can require a secure connection for an application. (When it tries to connect to the
server if it is unencrypted, it will just drop the connection).

Observed Outcome: On both iOS and Android, Appthority detected a “sends data unencrypted” threat
for an application. Transferring data over unencrypted connections could result in the loss of
confidentiality of information being transmitted by that application.

5.2.8 Threat Event 8—Compromise of Device Integrity via Observed, Inferred, or
Brute-Forced device Unlock Code

Summary: A malicious actor may be able to obtain a user’s device unlock code by direct observation,
side-channel attacks, or brute-force attacks.

Test Activity:

= Attempt to completely remove the device unlock code. Observe whether the attempt succeeds.

= Attempt to set the device unlock code to “1234,” a weak four-digit personal identification
number (PIN). Observe whether the attempt succeeds.

= Attempt to continuously unlock the device, confirming the device is factory reset after 10 failed
attempts.

Desired Outcome: Policies set on the device by the EMM (Mobilelron) should require a device unlock
code to be set, prevent the device unlock code from being removed, require a minimum complexity for
the device unlock code, and factory reset the device after 10 failed unlock attempts.

Additionally, Lookout can identify and report devices that have the lock screen disabled.

Observed Outcome: Mobilelron applied a policy to the devices that enforced a mandatory PIN and
device wipe capability after 10 failed unlock attempts. Further, Lookout reports when the device has the
lock screen disabled. For both devices, all data was erased after 10 failed unlock attempts.

The option to remove the unlock PIN/passcode had been disabled. Upon attempting to set the PIN to
one with repetitious or consecutive characters, an error was displayed, informing the user they cannot
use the PIN they entered.
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5.2.9 Threat Event 9—Unauthorized Access to Backend Services via Authentication
or Credential Storage Vulnerabilities in Internally Developed Applications

Summary: If a malicious actor gains unauthorized access to a mobile device, the attacker also has access
to the data and applications on that mobile device. The mobile device may contain an organization’s in-
house applications and can subsequently gain access to sensitive data or backend services.

Test Activity: Application was submitted to Appthority for analysis of credential weaknesses.
Desired Outcome: Discover and report credential weaknesses.

Observed Outcome: Appthority recognized within an application that it uses hard-coded credentials.
The application’s use of hard-coded credentials could introduce vulnerabilities if the hard-coded
credentials were used for access to enterprise resources by unauthorized entities. If the hard-coded
credentials result was applied to an application policy, that policy would be applied as a label in
Mobilelron to all devices with that application installed.

5.2.10 Threat Event 10 —Unauthorized Access of Enterprise Resources from an
Unmanaged and Potentially Compromised Device

Summary: An employee that accesses enterprise resources from an unmanaged mobile device may
expose the enterprise to vulnerabilities that may compromise enterprise data. Unmanaged devices do
not benefit from security mechanisms deployed by the organization such as mobile threat defense,
mobile threat intelligence, application vetting services, and mobile security policies. These unmanaged
devices limit an organization’s visibility into the state of a mobile device, including if the device is
compromised by an attacker.

Test Activity: Attempt to directly access enterprise services, e.g., Exchange email server or corporate
VPN, on a mobile device that is not enrolled into the EMM system.

Desired Outcome: Enterprise services should not be accessible from devices that are not enrolled into
the EMM system. Otherwise, the enterprise is not able to effectively manage devices to prevent threats.

Observed Outcome: Devices that were not enrolled in Mobilelron were unable to access enterprise
resources as the GlobalProtect VPN gateway prevented the devices from authenticating without proper
client certificates. The client certificates are obtainable only by enrolling in the EMM.

5.2.11 Threat Event 11—Loss of Organizational Data Due to a Lost or Stolen Device

Summary: Due to the nature of the small form factor of mobile devices, they can be misplaced or stolen.
A malicious actor who gains physical custody of a device with inadequate security controls may be able
to gain unauthorized access to sensitive data or resources accessible to the device.
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Test Activity: Attempt to download enterprise data onto a mobile device that is not enrolled into the
EMM system (may be performed in conjunction with TE-10). Attempt to remove (in conjunction with TE-
8) the device unlock code or demonstrate that the device does not have a device unlock code in place.
Attempt to locate and wipe the device through the EMM console (it will fail if the device is not enrolled
in the EMM).

Desired Outcome: It should be possible to locate or wipe EMM-enrolled devices in response to a report
that they have been lost or stolen. As demonstrated by TE-10, only EMM-enrolled devices should be
able to access enterprise resources. As demonstrated by TE-8, EMM-enrolled devices can be forced to
have a screen lock with a passcode of appropriate strength, which helps resist exploitation (including
loss of organizational data) if the device has been lost or stolen.

Should the device be unreachable by the EMM (e.g., disconnected from all networking), EMM control
and corporate data will be removed after 10 failed unlock attempts.

Observed Outcome (Enrolled Devices): Enrolled devices are protected. An enterprise policy requiring a
personal identification number/lock screen is present, and therefore, the enterprise data on the device
could not be accessed. After 10 attempts to access the device, the device was wiped. Additionally, the
device was remotely wiped after it was reported as lost to enterprise mobile device service
management.

Observed Outcome (Unenrolled Devices): As shown in Threat Event 10, only enrolled devices can access
enterprise services. When the device attempted to access enterprise data, no connection to the
enterprise services was available. Because the device cannot access the enterprise, enterprise
information would not be located on the device.

5.2.12 Threat Event 12—Loss of Confidentiality of Organizational Data Due to Its
Unauthorized Storage in Non-Organizationally Managed Services

Summary: If employees violate data management policies by using unmanaged services to store
sensitive organizational data, this data will be placed outside organizational control, where the
organization can no longer protect its confidentiality, integrity, or availability. Malicious actors who
compromise the unauthorized service account or any system hosting that account may gain
unauthorized access to the data.

Test Activity: Connect to the enterprise VPN. Open an enterprise website or application. Attempt to
extract enterprise data by taking a screenshot, or copy/paste and send it via an unmanaged e-mail
account.

Desired Outcome: Screenshots and other data-sharing actions will be prohibited by the EMM while
using managed applications.
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Observed Outcome: Through Mobilelron restriction and lockdown policies, an administrator prevented
the following actions on devices:

Android

= copy/paste
= screen capture
= data transfer over near-field communication
= data transfer over Universal Serial Bus
= Bluetooth
iOS
= screen capture and recording (iOS 9+)
= AirDrop
= iCloud Backup
= iCloud Documents and data access
= managed applications storing data in iCloud
= data flow between managed and unmanaged applications
= hand-off

These restrictions prohibited the user from executing common data leakage methods.

5.3 Scenarios and Findings

One aspect of our security evaluation involved assessing how well the reference design addresses the
security characteristics it was intended to support. The Cybersecurity Framework Subcategories were
used to provide structure to the security assessment by consulting the specific sections of each standard
that are cited in reference to a Subcategory.

The cited sections provide validation points that the example solution would be expected to exhibit.
Using the Cybersecurity Framework Subcategories as a basis for organizing our analysis allowed us to
systematically consider how well the reference design supports the intended security characteristics.

This section provides the scenarios and findings for the security and privacy characteristics the example
solution was intended to support. They include:

= development of the Cybersecurity Framework and NICE Framework mappings
= threat event scenarios and example solution architecture mitigations

= data action scenarios and potential mitigations that organizations could employ
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5.3.1 Cybersecurity Framework and NICE Framework Work Roles Mappings

While the example solution was being developed, the Cybersecurity Framework Subcategory mappings
were developed into a table mapping for organizations implementing the example solution’s
capabilities.

As the example solution’s products were installed, configured, and used in the example solution
architecture, the example solution’s functions and their corresponding Cybersecurity Framework
Subcategories, along with other guidance alignment, were determined and documented.

This mapping became an important resource to the example solution contained in this practice guide
because it provides the ability to communicate with the organization’s stakeholders about the security
controls that the example solution can help mitigate, and the workforce requirements that the example
solution will require.

The example solution’s products, security control, and workforce mapping can be found in Table I-1.

5.3.2 Threat Event Scenarios and Findings

As part of the findings, the threat events were mitigated in the example solution architecture using the
concepts and technology shown in Table 5-1. Each threat event was matched with functions that helped
mitigate the risks posed by the threat event.

Note: While not demonstrated in the table, TEE provided tamper-resistant processing environment
capabilities that helped mitigate mobile device runtime and memory threats in the example solution.

Table 5-1 Threat Event Scenarios and Findings Summary

Threat Event How the Example Solution The Technology
Architecture Helps Mitigate the Function That
Threat Event Helps Mitigate

the Threat Event

Threat Event 1: Unauthorized access to | Ensured administrators have insight MTI

sensitive information via a malicious or into what corporate data

privacy-intrusive application applications can access.

Threat Event 2: Theft of credentials Utilized PAN-DB to block known Firewall

through an SMS or email phishing malicious websites.

campaign
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Threat Event

How the Example Solution
Architecture Helps Mitigate the

Threat Event

The Technology
Function That
Helps Mitigate
the Threat Event

Threat Event 3: Malicious applications Disabled installing applications from EMM

installed via URLs in SMS or email unknown sources.

messages

Threat Event 4: Confidentiality and Quarantined noncompliant device EMM

integrity loss due to exploitation of until its operating system was

known vulnerability in the OS or updated.

firmware

Threat Event 5: Violation of privacy via Application vetting reports indicated | MTI

misuse of device sensors the sensors to which an application
requested access.

Threat Event 6: Compromise of the Detected a person-in-the-middle MTD

integrity of the device or its network attack and an unauthorized

communications via installation of configuration profile on iOS.

malicious EMM/MDM, network, VPN

profiles, or certificates

Threat Event 7: Loss of confidentiality of | Application vetting reports indicated | Application

sensitive information via eavesdropping | if an application sent data without Vetting

on unencrypted device communications | proper encryption.

Threat Event 8: Compromise of device Enforced mandatory device wipe EMM

integrity via observed, inferred, or capabilities after 10 failed unlock

brute-forced device unlock code attempts.

Threat Event 9: Unauthorized access to | Application vetting reports indicated | MTI

backend services via authentication or if an application used credentials

credential storage vulnerabilities in improperly.

internally developed applications

Threat Event 10: Unauthorized access of | Devices not enrolled in the EMM VPN

enterprise resources from an
unmanaged and potentially
compromised device

system were not able to connect to
the corporate VPN.
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Threat Event

How the Example Solution
Architecture Helps Mitigate the

The Technology
Function That
Helps Mitigate
the Threat Event

Threat Event

Threat Event 11: Loss of organizational
data due to a lost or stolen device

Enterprise data was protected by EMM
enforced passcode policies and
device wipe capabilities.

Threat Event 12: Loss of confidentiality Policies that enforce data loss EMM

of organizational data due to its
unauthorized storage in non-
organizationally managed services

prevention were pushed to devices.

5.3.3 Data Action Scenarios and Findings

The results of the PRAM found that three data actions were especially relevant to the build. Potential
mitigations that could be used by an organization to lessen their impact were identified by the PRAM as
shown below. Further details on the PRAM’s findings can be found in Appendix G.

Table 5-2 Data Action Scenarios and Findings Summary

Data Action

Data Action 1:
Blocking access and
wiping devices

Data Action

Description

Employees are likely to
use their devices for
both personal and work-
related purposes.
Therefore, in a system
that features the
capability to wipe a
device entirely, there
could be an issue of
employees losing
personal data.

How the Data Action Could Be Mitigated

Block the device’s access to enterprise resources
until it is granted access permission again.

Selectively wipe elements of the device without
removing all data on the device.

Advise employees to back up the personal data
maintained on devices.

Limit staff with the ability to perform wipes or
block access.

Data Action 2:
Employee monitoring

Employer-owned or
controlled networks
monitor activities on a

Limit staff with ability to review data about
employees and their devices.
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Data Action

Data Action
Description

regular basis. Employees
may not be aware of the
monitoring of their
interactions with the
system and may not
want this monitoring to
occur.

How the Data Action Could Be Mitigated

Develop organizational policies and techniques to
limit collection of specific data elements.

Develop organizational policies and techniques
regarding disposal of PII.

Data Action 3: Data
sharing across parties

Data transmission about
individuals and their
devices among a variety
of different parties
could be confusing for
employees who might
not know who has
access to different
information about them.

Develop organizational policies and techniques for
de-identification of data.

Use encryption.

Limit or disable access to data.

Develop organizational policies and techniques to
limit collection of specific data elements.

Use contracts to limit third-party data processing.

6 Conclusion

This document provides an overview of the Risk Management Framework and the Privacy Risk
Assessment Methodology, an explanation of mobile device security concepts, and an example solution

for organizations implementing a COPE deployment.

Our fictitious Orvilia Development organization started with a mobile device infrastructure that was
lacking mobile device security architecture concepts. It employed security risk management and privacy
risk assessment methodologies to understand the current gaps in its architecture and methods to
enhance the security and privacy of its systems.

After identifying the core threat events from the risk assessment, the appropriate mobile device security
technologies were applied. These included an on-premises EMM solution integrated with cloud- and
agent-based mobile security technologies to help deploy a set of security and privacy capabilities in
support of a usage scenario.
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The practice guide also includes in Volume C a series of How-To Guides—step-by-step instructions
covering the initial setup (installation or provisioning) and configuration for each component of the
architecture—to help security engineers rapidly deploy and evaluate our example solution in their test
environment.

The example solution of our reference design uses standards-based, commercially available products. It
can be used directly by any organization with a COPE usage scenario by implementing a security
infrastructure that supports an integration of on-premises with cloud-hosted mobile security
technologies. The practice guide provides a reference design and example solution that an organization
may use in whole or in parts as the basis for a custom solution that realizes the security and privacy
characteristics that best support its unique mobile device usage scenario.

A topic of interest for a future build is a bring your own device (BYOD) scenario. This entails protecting
corporate data on personally owned devices that employees will use for work as well as personal
activity. Another area of interest is a thin client deployed to mobile devices allowing the employee to
access a virtual device contained within the corporate infrastructure.

Further, examination of emerging 5G technologies as they relate to mobile device security is a new field
that presents a wide breadth of research opportunities.
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AD
ADCS
ADDS
API
ATARC
ATT&CK
BYOD
Clo

Cis
COMSEC
COPE
csp

CVE
DHS
DMz
EMM
FedRAMP
FIPS
GPS
HTTP
HTTPS
IEC

IEEE
IMEI

Active Directory

Active Directory Certificate Services

Active Directory Domain Services

Application Programming Interface

Advanced Technology Academic Research Center
Adversarial Tactics, Techniques, and Common Knowledge
Bring Your Own Device

Chief Information Officer

Center for Internet Security

Communications Security

Corporate-Owned Personally-Enabled

Credential Service Provider

Common Vulnerabilities and Exposures
Department of Homeland Security

Demilitarized Zone

Enterprise Mobility Management

Federal Risk and Authorization Management Program
Federal Information Processing Standards

Global Positioning System

Hypertext Transfer Protocol

Hypertext Transfer Protocol Secure

International Electrotechnical Commission
Institute of Electrical and Electronics Engineers
International Mobile Equipment Identity
Internet Protocol

Interagency Report

International Organization for Standardization
Information Technology

Mobile Device Management

Mobile Services Category Team
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MTC
MTD
MTI
MTP
NCCoE
NIAP
NICE
NIST
NVD
oS
PA
Pll
PRAM
RMF
ROM
SCEP
SIEM
SMS
SP
TE
TEE
TLS
UPN
URL
VPN

Mobile Threat Catalogue

Mobile Threat Defense

Mobile Threat Intelligence

Mobile Threat Protection

National Cybersecurity Center of Excellence
National Information Assurance Partnership
National Initiative for Cybersecurity Education
National Institute of Standards and Technology
National Vulnerability Database

Operating System

Palo Alto Networks

Personally Identifiable Information

Privacy Risk Assessment Methodology

Risk Management Framework

Read-only Memory

Simple Certificate Enrollment Protocol
Security Information and Event Management
Short Message Service

Special Publication

Threat Event

Trusted Execution Environment

Transport Layer Security

User Principal Name

Uniform Resource Locator

Virtual Private Network
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Access Management

Agent

Application Layer

App-Vetting
Process

Brute-Force Attack

Chief
Information Officers
(C10) Council

Common Vulnerabilities and
Exposures

Corporate-Owned
Personally-Enabled (COPE)

Cryptographic Algorithm

Cryptographic Key

Access Management is the set of practices that enables only those
permitted the ability to perform an action on a particular resource.
The three most common Access Management services you
encounter every day perhaps without realizing it are: Policy
Administration, Authentication, and Authorization [48].

A host-based intrusion prevention system program that monitors
and analyzes activity and performs preventive actions; OR a
program or plug-in that enables an SSL VPN to access non-Web-
based applications and services [49].

Layer of the TCP/IP protocol stack that sends and receives data for
particular applications such as DNS, HTTP, and SMTP [49].

The process of verifying that an app meets an organization’s
security requirements. An app vetting process comprises app
testing and app approval/rejection activities [50].

In cryptography, an attack that involves trying all possible
combinations to find a match [51].

The CIO Council is the principal interagency forum for improving
agency practices related to the design, acquisition, development,
modernization, use, sharing, and performance of Federal
information resources [52].

A dictionary of common names for publicly known information
system vulnerabilities [53].

A device owned by an enterprise and issued to an employee. Both
the enterprise and the employee can install applications onto the
device.

A well-defined computational procedure that takes variable
inputs, including a cryptographic key, and produces an output [54].

A value used to control cryptographic operations, such as
decryption, encryption, signature generation, or signature
verification [55].
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Cryptography

Data Action

De-identification

Demilitarized Zone (DMZ)

Disassociability

Encryption

Enterprise Mobility

Management

Identity Verification

Impact

The discipline that embodies the principles, means, and methods
for the transformation of data in order to hide their semantic
content, prevent their unauthorized use, or prevent their
undetected modification [54].

System operations that process PIl [20].

General term for any process of removing the association between
a set of identifying data and the data subject [51].

A network created by connecting two firewalls. Systems that are
externally accessible but need some protections are usually
located on DMZ networks [56].

Enabling the processing of PIl or events without association to
individuals or devices beyond the operational requirements of the
system [20].

The cryptographic transformation of data to produce ciphertext
[54].

Enterprise Mobility Management (EMM) systems are a common
way of managing mobile devices in the enterprise. Although not a
security technology by itself, EMMs can help to deploy policies to
an enterprise’s device pool and to monitor device state [9].

Confirmation, through the provision of objective evidence, that
specified requirements have been fulfilled (e.g., an entity’s
requirements have been correctly defined, or an entity’s attributes
have been correctly presented; or a procedure or function
performs as intended and leads to the expected outcome).
Adapted from Verification [54].

The effect on organizational operations, organizational assets,
individuals, other organizations, or the Nation (including the
national security interests of the United States) of a loss of
confidentiality, integrity, or availability of information or an
information system [11].
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Key Logger

Malware

Manageability

Mobile Device

Mobile Device
Management (MDM)

Network Layer

Person (Man)-in-the-Middle
Attack

A remote program designed to record which keys are pressed on a
computer keyboard used to obtain passwords or encryption keys
and thus bypass other security measures [57].

Software or firmware intended to perform an unauthorized
process that will have adverse impact on the confidentiality,
integrity, or availability of an information system. A virus, worm,
Trojan horse, or other code-based entity that infects a host.
Spyware and some forms of adware are also examples of malicious
code [11].

Providing the capability for granular administration of data,
including alteration, deletion, and selective disclosure [20].

A portable computing device that: (i) has a small form factor such
that it can easily be carried by a single individual; (ii) is designed to
operate without a physical connection (e.g., wirelessly transmit or
receive information); (iii) possesses local, non-removable or
removable data storage; and (iv) includes a self-contained power
source. Mobile devices may also include voice communication
capabilities, on-board sensors that allow the devices to capture
information, and/or built-in features for synchronizing local data
with remote locations. Examples include smart phones, tablets,
and E-readers [11].

The administration of mobile devices such as smartphones,
tablets, computers, laptops, and desktop computers. MDM is
usually implemented through a third-party product that has
management features for particular vendors of mobile devices
[50].

Layer of the TCP/IP protocol stack that is responsible for routing
packets across networks [49].

An attack in which an attacker is positioned between two
communicating parties in order to intercept and/or alter data
traveling between them. In the context of authentication, the
attacker would be positioned between claimant and verifier,
between registrant and CSP during enrollment, or between
subscriber and CSP during authenticator binding [55].
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Phishing

Predictability

Predisposing
Conditions

Privacy Risk
Assessment
Methodology (PRAM)

Read-Only Memory

Red Team Exercise

Replay Resistance

Risk

An attack in which the subscriber is lured (usually through an
email) to interact with a counterfeit verifier/RP and tricked into
revealing information that can be used to masquerade as that
subscriber to the real verifier/RP [55].

Enabling reliable assumptions by individuals, owners, and
operators about data and their processing by a system, product, or
service [20].

A condition that exists within an organization, a mission/business
process, enterprise architecture, or information system including
its environment of operation, which contributes to (i.e., increases
or decreases) the likelihood that one or more threat events, once
initiated, will result in undesirable consequences or adverse
impact to organizational operations and assets, individuals, other
organizations, or the Nation [12].

The PRAM is a tool that applies the risk model from NISTIR 8062
and helps organizations analyze, assess, and prioritize privacy risks
to determine how to respond and select appropriate solutions.
The PRAM can help drive collaboration and communication
between various components of an organization, including privacy,
cybersecurity, business, and IT personnel [58].

ROM is a pre-recorded storage medium that can only be read from
and not written to [59].

An exercise, reflecting real-world conditions, that is conducted as a
simulated adversarial attempt to compromise organizational
missions and/or business processes to provide a comprehensive
assessment of the security capability of the information system
and organization [11].

Protection against the capture of transmitted authentication or
access control information and its subsequent retransmission with
the intent of producing an unauthorized effect or gaining
unauthorized access [60].

A measure of the extent to which an entity is threatened by a
potential circumstance or event, and typically a function of: (i) the
adverse impacts that would arise if the circumstance or event
occurs; and (ii) the likelihood of occurrence [12].

NIST SP 1800-21B: Mobile Device Security: Corporate-Owned Personally-Enabled

64



"12-008T"dS’1SIN/8209°0T/840°10p//:d1Y :wo4y 98Jeyd Jo 9344 d|qejieAe s| uopedlgnd sty

Risk Assessment

Risk
Management
Framework

Sandbox

Security Control

Side-Channel Attacks

Social Engineering

Threat

Threat Events

The process of identifying risks to organizational operations
(including mission, functions, image, reputation), organizational
assets, individuals, other organizations, and the Nation, resulting
from the operation of an information system. Part of risk
management, incorporates threat and vulnerability analyses, and
considers mitigations provided by security controls planned or in
place. Synonymous with risk analysis [11].

The Risk Management Framework (RMF) provides a structured,
yet flexible approach for managing the portion of risk resulting
from the incorporation of systems into the mission and business
processes of the organization [61].

A restricted, controlled execution environment that prevents
potentially malicious software, such as mobile code, from
accessing any system resources except those for which the
software is authorized (Under Sandboxing) [54].

A safeguard or countermeasure prescribed for an information
system or an organization designed to protect the confidentiality,
integrity, and availability of its information and to meet a set of
defined security requirements [11].

An attack enabled by leakage of information from a physical
cryptosystem. Characteristics that could be exploited in a side-
channel attack include timing, power consumption, and
electromagnetic and acoustic emissions [55].

The act of deceiving an individual into revealing sensitive
information, obtaining unauthorized access, or committing fraud
by associating with the individual to gain confidence and trust [55].

Any circumstance or event with the potential to adversely impact
organizational operations (including mission, functions, image, or
reputation), organizational assets, individuals, other organizations,
or the Nation through an information system via unauthorized
access, destruction, disclosure, or modification of information,
and/or denial of service [12].

An event or situation that has the potential for causing undesirable
consequences or impact [12].
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Threat

Intelligence

Threat Sources

Transport Layer

Transport Layer
Security (TLS)

Trusted
Certificate

Unmanaged Device

Virtual Private
Network

Vulnerability

Watering Hole

Threat information that has been aggregated, transformed,
analyzed, interpreted, or enriched to provide the necessary
context for decision-making processes [62].

The intent and method targeted at the intentional exploitation of a
vulnerability or a situation and method that may accidentally
trigger a vulnerability. Synonymous with threat agent [11].

Layer of the TCP/IP protocol stack that is responsible for reliable
connection-oriented or connectionless end-to-end
communications [49].

A security protocol providing privacy and data integrity between
two communicating applications. The protocol is composed of two
layers: the TLS Record Protocol and the TLS Handshake Protocol
[54].

A certificate that is trusted by the Relying Party on the basis of
secure and authenticated delivery. The public keys included in
trusted certificates are used to start certification paths. Also
known as a “trust anchor” [63].

A device inside the assessment boundary that is either
unauthorized or, if authorized, not assigned to a person to
administer [64].

Protected information system link utilizing tunneling, security
controls, and endpoint address translation giving the impression of
a dedicated line [54].

Weakness in an information system, system security procedures,
internal controls, or implementation that could be exploited by a
threat source [12].

Watering hole attacks involve attackers compromising one or
more legitimate Web sites with malware in an attempt to target
and infect visitors to those sites [65].
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Device enrollment and management capabilities are available when deploying mobile devices in bulk.
Certain settings can be preloaded, and devices can ship preconfigured for enterprise management. iOS-,
Android-, and Samsung Knox-based devices integrate directly with Enterprise Mobility Management
(EMM) solutions, providing enterprise-level management of security controls based on policy.

E.1 Android Devices

For Android devices, zero-touch enrollment provides an option different from the manual setup of
Android devices. Android-based devices offer security controls that an EMM can leverage for enterprise
deployments. The Android Enterprise program by Google is available on devices with Android 5.0
(Lollipop) and higher. An EMM deploys a device policy controller as part of its on-device agent that
controls local device policies and system applications on devices. Android Enterprise supports corporate-
owned personally-enabled and bring your own device deployment scenarios through work-managed
and work-profile device solutions [83], [84].

E.2 iOS Devices

For iOS devices, Apple Configurator supports Volume Purchase and Device Enrollment Program
scenarios. Apple Business Manager provides a mobile device management solution to assist
organizations in deploying iOS devices. iOS devices are managed by configuration profiles. Configuration
profiles can force security policies such as virtual private network usage, enterprise Kerberos support,
and access to cloud services. i0OS further incorporates a set of additional security controls in what is
termed supervised mode, which denotes a corporately owned device.

Typically, organizations choose to use the Device Enrollment Program for large-scale deployments of iOS
devices in supervised mode due to the reduction of labor involved in manually configuring each device.
However, due to the small number of devices in our reference design, we have configured supervised
mode using the Apple Configurator 2 tool. A more detailed description of iOS capabilities can be found
in the iOS Security Guide [85], [86].

E.3 Samsung Knox Devices

Samsung Knox Mobile Enrollment provides the ability to add Samsung devices to the enterprise without
manually enrolling each device. Samsung Knox Mobile Enroliment works on Samsung Galaxy devices
running Android Lollipop or higher. It allows remote provisioning of devices when they connect to Wi-Fi
or cellular networks. Samsung Knox Mobile Enrollment works with a number of EMM solutions,
including cloud-based options [87], [88], [89], [90].
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F.1 Risk Assessment

National Institute of Standards and Technology (NIST) Special Publication (SP) 800-30 Revision 1, Guide
for Conducting Risk Assessments, [12] states that risk is “a measure of the extent to which an entity is
threatened by a potential circumstance or event, and typically a function of: (i) the adverse impacts that
would arise if the circumstance or event occurs; and (ii) the likelihood of occurrence.” The guide further
defines risk assessment as “the process of identifying, estimating, and prioritizing risks to organizational
operations (including mission, functions, image, reputation), organizational assets, individuals, other
organizations, and the Nation, resulting from the operation of an information system. Part of risk
management incorporates threat and vulnerability analyses, and considers mitigations provided by
security controls planned or in place.”

The NCCoE recommends that any discussion of risk management, particularly at the enterprise level,
begins with a comprehensive review of NIST SP 800-37 Revision 2, Risk Management Framework for
Information Systems and Organizations—material that is available to the public. The Risk Management
Framework (RMF) guidance, as a whole, proved to be invaluable in giving us a baseline to assess risks,
from which we developed the project, the security characteristics of the build, and this guide.

This section details the risk assessment undertaken to improve the mobile security posture of the
fictional organization Orvilia Development. Typically, a NIST SP 800-30 Revision 1-based risk assessment
follows a four-step process as shown in Figure F-1: Prepare for assessment, conduct assessment,
communicate results, and maintain assessment.
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Figure F-1 Risk Assessment Process

Step 1: Prepare for Assessment
Derived from Organizational Risk Frame

Step 2: Conduct Assessment
Expanded Task View

Identify Threat Sources and Events

v

Identify Vulnerabilities and
Predisposing Conditions

v

Determine Likelihood of Occurrence

v

Determine Magnitude of Impact

v

Step 3: Communicate Results
Step 4: Maintain Assessment

Determine Risk

To provide the most value in this exercise:

=  We focused on the preparation, which established the context of the risk assessment.

= We conducted the risk assessment, which produced a list of information security risks that were
prioritized by risk level and used to inform risk response decisions.

= We followed the process detailed in Section 3 of NIST SP 800-30 Revision 1 [12] to perform a risk
assessment of the current mobile infrastructure.

We recommend that organizations performing a risk assessment communicate results and perform
maintenance of the risk assessment, but these activities were deemed out of scope for this project. The
following tasks were used during the assessment process.

F.1.1 Task 1-1: Risk Assessment Purpose

Identify the purpose of the risk assessment in terms of the information that the assessment is intended to
produce and the decisions the assessment is intended to support.

NIST SP 1800-21B: Mobile Device Security: Corporate-Owned Personally-Enabled 81



"T2-008T'dS LSIN/8209'0T/810°10p//:d11y :wiouy 98.4eyd Jo 9344 3|qe|ieAe s} uonedljgnd siyL

The purpose of the risk assessment of Orvilia Development was to identify and document new risks to
its mission resulting from addition of a mobility program.

The results of the risk assessment informed decisions to Orvilia’s mobility deployment that included:

= implementation of new security mechanisms
= configuration changes to existing infrastructure

= updates to security and appropriate-use policies relevant to their mobility program

F.1.2 Task 1-2: Risk Assessment Scope

Identify the scope of the risk assessment in terms of organizational applicability, time frame supported,
and architectural/technology considerations.

Organizational Applicability:

The scope of this risk assessment was limited to systems impacted by inclusion of a mobility program; it
did not include existing information technology (IT) infrastructure to which no impact was anticipated.
With their original architecture, Orvilia deployed corporate-owned personally-enabled (COPE) devices.
Orvilia employees utilized mobile devices for local and remote work activities and limited personal
activities (e.g., phone calls, messaging, social applications, and personal emails).

With Orvilia’s new government contract, this risk assessment also evaluated Orvilia’s mobile
deployment regarding its ability to access and store government data while meeting applicable
information security and privacy requirements.

While not directly associated with risk assessment activities, Orvilia will be required to demonstrate
compliance with government standards and policies established to improve data security. Therefore,
Orvilia needed to determine how compliance with government policy and application of its standards
would best align with its strategy to identify, protect again, detect, respond to, and recover from threats
related to its mobility program.

Time Frame Supported:

Because this was the first risk assessment performed by Orvilia, the process was more time-intensive
than it will be in future risk management cycles. Orvilia completed the initial risk assessment within six
months.

Architectural and Technology Considerations:

This risk assessment was scoped to Orvilia’s mobile deployment, which constitutes mobile devices used
to access Orvilia enterprise resources along with any backend IT components used to manage or provide
services to those mobile devices.
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The following provide an overview of the mobile deployment components involved in the original
(current) Orvilia architecture.

F.1.3

Mobile Device: A mobile device is a small form factor device with a rich operating system, at
least one wireless network interface, and the ability to run applications. These features are
considered essential for Orvilia to have portable and efficient access to enterprise data.

Communication Networks and Data Transmission: Mobile devices will establish connections to
the internet by using their cellular or Wi-Fi adapters. As connections may be made to unsecured
access points or may traverse untrusted networks, consideration will be given to the risks
associated with the security of those connections and the data transmitted over them.
Additionally, the organization will need to consider risks arising from permitting inbound
connections by mobile devices via the internet.

Public Application Stores: With a COPE deployment strategy, employees will have the option to
download any mobile application available from official platform application stores (e.g., Google
Play Store). While those platforms analyze applications for malicious behaviors, it is still possible
for such applications to exceed Orvilia’s needs for user privacy or pose a risk to the devices or
data. Therefore, risks from such applications should be included in this assessment.

Device and Operating System (0S) Vendor Infrastructure: The hardware, firmware, and
software that compose each model of mobile device can vary, particularly those from different
manufacturers and vendors, which may incorporate technology that is exclusive to their
products. It will be important to select devices that demonstrate security mechanisms that align
with the organization’s risk mitigation strategy. However, risks that are specific to given device
components (e.g., chipsets or driver versions) will be out of scope for this assessment.

Enterprise Systems: If a potentially compromised mobile device can connect to the enterprise, it
poses direct risks to any systems it can reach or data it can access. Such systems will reasonably
include on-premises mobile application stores, mobile management technologies, email servers,
file servers, and intranet web servers. Subsequent compromise of any of these systems may
cascade to others not directly reachable by the mobile device. Risks to all such systems by a
mobile device should be included in this assessment.

Task 1-3: Risk Assessment Assumptions and Constraints

Identify the specific assumptions and constraints under which the risk assessment is conducted.

Risk assessment assumptions and constraints were developed using a NIST SP 800-30 Revision 1 Generic
Risk Model as shown in Figure F-2.
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Figure F-2 NIST 800-30 Generic Risk Model
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F.1.3.1 Risk Assessment Assumptions

Some of the threats and their resulting risks and impacts span several levels. In cases where these risks
and impacts have several possible levels, it was assumed that Orvilia would document these using a

high-water mark methodology. This assumption of greatest risk then provided the basis for risk
mitigation activities. For example, where the threat risk could pose a moderate, high, or very high

outcome, the very high outcome was selected, and these very high risks were prioritized for mitigation.

F.1.3.2 Risk Assessment Constraints

Information regarding the following were used as input for the constraints for the risk assessment.

threat source

threat events

S

vulnerabilities and predisposing conditions

likelihood

impacts

risk assessment and analysis approaches

resources available for the assessment
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= skills and expertise

Threat Sources

Orvilia’s executives and managers identified two threat sources as possible concerns. Orvilia’s technical
staff were provided security control mappings identified within this guide to help them understand the
additional security that the example solution could provide to Orvilia as they implemented the example
solution.

Additionally, due to the cybersecurity-focused scope of the risk assessment, non-adversarial threat
sources (e.g., unintentional hardware, software, or system design and architecture shortcoming threats)
were not considered.

As identified in Section F.1.6, Task 2-1: Identify and Characterize Threat Sources of Concern, the risk
assessment identified the following threat sources of concern:

= Orvilia’s competitors
= pation-state actors

Threat Events

= Threat events were described at a high level and in general terms within the risk assessment.
Similar threat events were combined into a single, broader threat.

=  Only those threat events that have been previously observed by an authoritative source were
considered (e.g., reported as already having occurred by other organizations), drawing primarily
from the NIST National Cybersecurity Center of Excellence Mobile Threat Catalogue [9].

= Threat events involving exploitation of vulnerabilities within the cellular network, including a
mobile device’s cellular baseband, reasonably exceeded Orvilia’s ability to directly identify and
mitigate them and were not further assessed.

= Threat events involving exploitation of vulnerabilities in low-level hardware, firmware, and
device controllers reasonably exceeded Orvilia’s ability to directly identify and mitigate them
and were not further assessed.

= Threat events involving exploitation of vulnerabilities in the supply chain reasonably exceeded
Orvilia’s ability to directly identify and mitigate them and were not further assessed.

Vulnerabilities and Predisposing Conditions

= Mobile device vulnerabilities considered during this risk assessment included those in mobile
operating systems and mobile applications, including third-party software libraries.

= Vulnerabilities in commonly used noncellular network protocols such as Bluetooth and Wi-Fi
were considered.
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= Vulnerabilities related to a potential Enterprise Mobility Management (EMM) system were
considered.

= Additional information and determinations were made via Appendix F of NIST SP 800-30
Revision 1.

Likelihood

= Likelihood determinations were made via Appendix G of NIST SP 800-30 Revision 1.

Note: The rating of overall likelihood is derived from the Likelihood of Initiation and Likelihood that
Threat Events Result from Adverse Impacts using Table G-5 of Appendix G in NIST SP 800-30 Revision 1
[12]. Ratings of the latter two variables relied heavily on the subjective judgment of Orvilia employees.

Impacts

= Impact determinations were made via Appendix H of NIST SP 800-30 Revision 1.

Note: Ratings of impact relied heavily on the subjective judgment of Orvilia employees.
Risk Assessment and Analysis Approaches

= This risk assessment focused on identifying an initial set of threats to Orvilia’s mobile
deployment.

= Approaches for describing threats and their impact were informed by the Adversarial Tactics,
Techniques, and Common Knowledge (ATT&CK) Framework [91].

= The rating of Risk was derived from both the overall likelihood and level of impact using Table I-
2 of Appendix | in NIST SP 800-30 Revision 1 [12].

Resources Available for the Assessment

= QOrvilia ensured the appropriate staff with the requisite expertise were available to conduct the
assessment within the time allotted.

= QOrvilia provided funding for the risk analysis staff.

=  QOrvilia staff who conducted the risk assessment had the necessary information systems and
software.

Skills and Expertise

= Risk assessments were conducted by experts leveraging industry best practices and NIST risk
assessment frameworks.
F.1.4 Task 1-4: Risk Assessment Threat, Vulnerability, and Impact Sources

Identify the sources of descriptive threat, vulnerability, and impact information to be used in the risk
assessment.
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Orvilia used the following methods to identify mobile infrastructure threats, vulnerabilities, and impacts.

F.1.4.1 Sources of Threats

This risk assessment identified NIST’s Mobile Threat Catalogue (MTC) [9], along with its associated NIST
Interagency Report 8144, Assessing Threats to Mobile Devices & Infrastructure [92], and MITRE’s
ATT&CK Mobile Profile [93] as credible sources for threat information. Each entry in the MTC contains
several pieces of information: an identifier, a category, a high-level description, details on its origin,
exploit examples, Common Vulnerabilities and Exposures [94] examples, possible countermeasures, and
academic references.

MITRE’s ATT&CK is a curated knowledge base and model for cyber-adversary behavior. ATT&CK details
specific techniques that can be used by cyber adversaries. Each technique entry typically includes a
detailed technical description, mitigations, detection analytics, examples of use by malicious actors, and
references. The ATT&CK model organizes these techniques into high-level malicious actor tactical
objectives, referred to as tactics. A primary use case for ATT&CK is use by organizations to assess the
state of their cybersecurity defenses and prioritize deployment of defensive capabilities. The ATT&CK
Mobile Profile describes tactics and techniques specific to the mobile environment.

Due to Orvilia’s current use of cloud services, it identified the outputs of the Federal Risk and
Authorization Management Program [95] and associated NIST SP 800-53 security controls as being in
scope for this risk assessment.

F.1.4.2 Sources of Vulnerabilities

Vulnerabilities are commonly associated with mobile operating systems, device drivers, mobile
applications, and third-party libraries. However, vulnerabilities can be present in any level of the mobile
technology stack. For up-to-date information regarding vulnerabilities, this risk assessment identified
the National Vulnerability Database (NVD) [96] as a credible source of information. The NVD is the U.S.
government repository of standards-based vulnerability management data. Use of NVD was
supplemented by review of individual vendor vulnerability disclosures such as those published in the
Pixel/Nexus Security Bulletins [97] for Android, Apple security updates [98] for iOS, Managing Devices &
Corporate Data on iOS [99], and Android Security Updates [100] for Android-based Samsung devices.

F.1.4.3 Sources of Impacts

This risk assessment identified the scenario described in Section F.1.2 as the primary source of impact
determination information. The scenario identified the following systems as being critical to the
organization’s mission:

= Microsoft Active Directory domain

=  Microsoft Exchange email server
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= timekeeping web application
= travel support web application
= corporately owned mobile devices

An example of a successful attack against a mobile device is one that could be used to glean the
credentials for the travel support web application and use them to penetrate the application server.
While Orvilia can absorb minimal downtime to the web application, the attacker could use this position
to gain a foothold in the Orvilia infrastructure to laterally move to more critical systems in the
environment, such as the email server. Compromise of the email server would have high impact,
possibly causing serious harm to the organization.

F.1.5 Task 1-5: Risk Assessment Risk Model and Analytic Approach Identification

Identify the risk model and analytic approach to be used in the risk assessment.

In this risk assessment, the analytic approach used qualitative (i.e., subjective) ratings of risk (i.e., very
low, low, moderate, high, and very high). The approach was primarily threat oriented, as described in
Section F.1.6.

F.1.6 Task 2-1: Identify and Characterize Threat Sources of Concern

Identify and characterize threat sources of concern, including capability, intent, and targeting
characteristics for adversarial threats and range of effects for non-adversarial threats.

Orvilia examined NIST SP 800-30 Revision 1’s Table D-2: Taxonomy of Threat Sources [12] and identified
the following threat sources of concern:

Table F-1 Threat Sources of Concern

Identifier Threat Source Description Characteristic

TS-1 Adversarial, Orvilia’s competitors seek to exploit Capability, Intent,
Organization, dependence on cyber resources, specifically the | Targeting
Competitor data entrusted by its customers to increase

market share.

TS-2 Adversarial, Nation-state actors stealing sensitive Capability, Intent,
Nation-State government data from unsecured devices and |Targeting
infrastructure

Orvilia produced the following table as output of Task 2-1 to provide relevant inputs to the risk tables. It
identifies the threat sources identified in NIST SP 800-30 Revision 1 with the associated risk rating of
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capability, intent, and targeting score (using the previously mentioned five-point scale: very low, low,
moderate, high, and very high).

Orvilia’s assessment found that all threat events could be initiated by both threat sources
(Organization/Competitor and Nation-State).

Capability refers to the level of expertise of the malicious actor. Intent refers to the malicious actor’s
goal. Targeting refers to the reconnaissance and selection methods performed by the malicious actor.

Table F-2 Threat Sources Qualitative Scale

Identifier Threat Events Relevant to In Scope  Capability Intent Targeting

Threat Sources

TS-1 All threat events Yes High High High
(Threat Events 1-12)

TS-2 All threat events Yes Very High Very High |Very High
(Threat Events 1-12)

F.1.7 Task 2-2: Identify Potential Threat Events

Identify potential threat events, relevance of the events, and the threat sources that could initiate the
events.

The threat events used for the example solution are described below. These threat events describe how
the mobile devices in Orvilia might be compromised by malicious activities. All of the threat events map
to both threat sources identified in Section F.1.6.

Orvilia examined the sample tables in NIST SP 800-30 Revision 1—Tables E-1, E-2, E-3, E-4, and E-5—and
analyzed the sources of mobile threats identified in Task 1-4. Using this process, Orvilia leadership
identified the following threat events.

F.1.7.1 Threat Event 1—Unauthorized Access to Sensitive Information via a Malicious or
Privacy-Intrusive Application

A mobile application can attempt to collect and exfiltrate any information to which it has been granted
access. This includes any information generated during use of the application (e.g., user input), user-
granted permissions (e.g., contacts, calendar, call logs, camera roll), and general device data available to
any application (e.g., International Mobile Equipment Identity, device make and model, serial number).
Further, if a malicious application exploits a vulnerability in other applications, the OS, or device
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firmware to achieve privilege escalation, it may gain unauthorized access to any data stored on or
otherwise accessible through the device.

F.1.7.2 Threat Event 2—Theft of Credentials Through an SMS or Email Phishing
Campaign

Malicious actors may create fraudulent websites that mimic the appearance and behavior of legitimate
ones and entice users to authenticate to them by distributing phishing messages over short message
service (SMS) or email. Effective use of social engineering techniques such as impersonating an authority
figure or creating a sense of urgency may compel users to forgo scrutiny of the message and proceed to
authenticate to the fraudulent website; it then captures and stores the user’s credentials before
(usually) forwarding them to the legitimate website to allay suspicion.

F.1.7.3 Threat Event 3—Malicious Applications Installed via URLs in SMS or Email
Messages

Malicious actors may send users SMS or email messages that contain a uniform resource locator (URL)
where a malicious application is hosted. Generally, such messages are crafted using social engineering
techniques designed to dissuade recipients from scrutinizing the nature of the message, thereby
increasing the likelihood they access the URL by using their mobile device. If the URL is accessed, the
device will attempt to download and install the application. Effective use of social engineering by the
attacker will further compel an otherwise suspicious user to grant any trust required by the developer
and all permissions requested by the application. Granting the former facilitates installation of other
malicious applications by the same developer, and granting the latter increases the potential for the
application to do direct harm.

F.1.7.4 Threat Event 4—Confidentiality and Integrity Loss Due to Exploitation of Known
Vuilnerability in the OS or Firmware

When malware successfully exploits a code execution vulnerability in the mobile OS or device drivers,
the delivered code generally executes with elevated privileges and issues commands in the context of
the root user or the OS kernel. This may be enough for some to accomplish their goal, but advanced
malicious actors will usually attempt to install additional malicious tools and to establish a persistent
presence. If successful, the attacker will be able to launch further attacks against the user, the device, or
any other systems to which the device connects. As a result, any data stored on, generated by, or
accessible to the device at that time—or in the future—may be compromised.

F.1.7.5 Threat Event 5—Violation of Privacy via Misuse of Device Sensors

Malicious actors with access (authorized or unauthorized) to device sensors (microphone, camera,
gyroscope, Global Positioning System receiver, and radios) can use them to conduct surveillance. It may
be directed at the user, as when tracking the device location, or it may be applied more generally, as
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when recording any nearby sounds. Captured sensor data, such as a recording of an executive meeting,
may be immediately useful to a malicious actor. Alternatively, the data may be analyzed in isolation or in
combination with other data to yield sensitive information. For example, audio recordings of on-device
or proximate activity can be used to probabilistically determine user inputs to touchscreens and
keyboards—essentially turning the device into a remote key logger.

F.1.7.6 Threat Event 6—Compromise of the Integrity of the Device or Its Network
Communications via Installation of Malicious EMM/MDM, Network, VPN
Profiles, or Certificates

Malicious actors who successfully install an EMM/mobile device management (MDM), network, or
virtual private network (VPN) profile or certificate onto a device will gain a measure of additional control
over the device or its communications. Presence of an EMM/MDM profile will allow an attacker to
misuse existing OS application programming interfaces to send the device a wide variety of commands.
This may allow a malicious actor to obtain device information, install or restrict applications, or remotely
locate, lock, or wipe the device. Malicious network profiles may allow a malicious actor to automatically
compel the device to connect to access points under their control to achieve a person-in-the-middle
attack on all outbound connections. Alternatively, VPN profiles assist in the undetected exfiltration of
sensitive data by encrypting it, thus hiding it from network scanning tools. Additionally, malicious
certificates may allow the malicious actor to compel the device to automatically trust connections to
malicious web servers, wireless access points, or installation of applications under their control.

F.1.7.7 Threat Event 7—Loss of Confidentiality of Sensitive Information via
Eavesdropping on Unencrypted Device Communications

Malicious actors can readily eavesdrop on communication over unencrypted, wireless networks such as
public Wi-Fi access points, which are commonly provided by coffee shops and hotels. While a device is
connected to such a network, an attacker would gain unauthorized access to any data sent or received
by the device for any session not already protected by encryption at either the transport or application
layers. Even if the transmitted data were encrypted, an attacker would be privy to the domains, internet
protocol addresses, and services (as indicated by port numbers) to which the device connects; such
information could be used in future watering hole attacks or person-in-the-middle attacks against the
device user. Additionally, visibility into network layer traffic enables a malicious actor to conduct side-
channel attacks against its encrypted messages, which can still result in a loss of confidentiality. Further,
eavesdropping on unencrypted messages during a handshake to establish an encrypted session with
another host or endpoint may facilitate attacks that ultimately compromise the security of the session.
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F.1.7.8 Threat Event 8—Compromise of Device Integrity via Observed, Inferred, or
Brute-Forced Device Unlock Code

A malicious actor may be able to obtain a user’s device unlock code by direct observation, side-channel
attacks, or brute-force attacks. Both the first and second can be attempted with at least proximity to the
device; only the third technique requires physical access. However, side-channel attacks that infer the
unlock code by detecting taps and swipes to the screen can be attempted by applications with access to
any peripherals that detect sound or motion (e.g., microphone, gyroscope, or accelerometer). Once the
device unlock code has been obtained, a malicious actor with physical access to the device will gain
immediate access to any data or functionality not already protected by additional access control
mechanisms. Additionally, if the user employs the device unlock code as a credential to any other
systems, the malicious actor may further gain unauthorized access to those systems.

F.1.7.9 Threat Event 9—Unauthorized Access to Backend Services via Authentication or
Credential Storage Vulnerabilities in Internally Developed Applications

If a malicious actor gains unauthorized access to a mobile device, the malicious actor also has access to
the data and applications on that mobile device. The mobile device may contain an organization’s in-
house applications and can subsequently gain access to sensitive data or backend services. This could
result from weaknesses or vulnerabilities present in the authentication or credential storage
mechanisms implemented within an in-house application.

F.1.7.10 Threat Event 10—Unauthorized Access of Enterprise Resources from an
Unmanaged and Potentially Compromised Device

An employee who accesses enterprise resources from an unmanaged mobile device may expose the
enterprise to vulnerabilities that may compromise enterprise data. Unmanaged devices do not benefit
from security mechanisms deployed by the organization such as mobile threat defense, mobile threat
intelligence, application vetting services, and mobile security policies. These unmanaged devices limit an
organization’s visibility into the state of a mobile device, including if the device is compromised by a
malicious actor. Therefore, users who violate security policies to gain unauthorized access to enterprise
resources from such devices risk providing malicious actors with access to sensitive organizational data,
services, and systems.

F.1.7.11 Threat Event 11—Loss of Organizational Data Due to a Lost or Stolen Device

Due to the nature of the small form factor of mobile devices, they can be misplaced or stolen. A
malicious actor who gains physical custody of a device with inadequate security controls may be able to
gain unauthorized access to sensitive data or resources accessible to the device.
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F.1.7.12 Threat Event 12—Loss of Confidentiality of Organizational Data Due to Its
Unauthorized Storage to Non-Organizationally Managed Services

If employees violate data management policies by using unmanaged services to store sensitive

organizational data, the data will be placed outside organizational control, where the organization can

no longer protect its confidentiality, integrity, or availability. Malicious actors who compromise the

unauthorized service account or any system hosting that account may gain unauthorized access to the

data.

Further, storage of sensitive data in an unmanaged service may subject the user or the organization to
prosecution for violation of any applicable laws (e.g., exportation of encryption) and may complicate
efforts by the organization to achieve remediation or recovery from any future losses, such as those
resulting from the public disclosure of trade secrets.

F.1.8 Task 2-3: Identify Vulnerabilities and Predisposing Conditions

Identify vulnerabilities and predisposing conditions that affect the likelihood that threat events of
concern result in adverse impacts.

Drawing on the scenario described in Section 3.4.3, there existed vulnerabilities and predisposing
conditions that increased the likelihood that identified threat events would result in adverse impacts for
Orvilia. Each vulnerability or predisposing condition is listed in the table below along with the
corresponding threat events.

The methodology used to rate the level of pervasiveness was qualitative (i.e., subjective) and used a
five-point scale.

= Very High
= High
= Moderate
= Low

= VeryLow
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Table F-3 Identify Vulnerabilities and Predisposing Conditions

Vulnerability  Vulnerability or Predisposing Condition Resulting Pervasiveness
Threat Events

VULN-1 Email and other enterprise resources can be | TE-2, TE-10, TE- |Very High
accessed from anywhere, and only 11
username/password authentication is
required.

VULN-2 Public Wi-Fi networks are regularly used by TE-7 Very High
employees for remote connectivity from
their corporate mobile devices.

VULN-3 No EMM/MDM deployment exists to enforce | TE-1, TE-3, TE-4, |Very High
and monitor compliance with security- TE-5, TE-6, TE-7,
relevant policies on corporate mobile TE-8, TE-9, TE-
devices. 11, TE-12

Note 1: Ratings of the level of pervasiveness were based on the qualitative scale found in Table F-5 of
Appendix F in NIST SP 800-30 Revision 1 [12].

Note 2: Ratings of pervasiveness indicate that the vulnerabilities apply few (i.e., very low), some (i.e.,
low), many (i.e., moderate), most (i.e., high), or all (i.e., very high) organizational missions/business
functions and processes, or information systems.

F.1.9 Task 2-4: Determine Likelihood of a Threat and the Likelihood of the Threat
Having Adverse Impacts

Determine the likelihood that threat events of concern result in adverse impacts, considering (i) the
characteristics of the threat sources that could initiate the events; (ii) the vulnerabilities/predisposing
conditions identified; and (iii) the organizational susceptibility reflecting the
safeguards/countermeasures planned or implemented to impede such events.

In the interest of brevity, the threat events of concern identified in Task 2-2 were limited to those
presumed to have a foreseeably high likelihood of occurrence.

The methodology used to identify the likelihood of threats of concern was qualitative (i.e., subjective)
and used the following five-point scale.

= Very High
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= High

= Moderate
= Low

= VerylLow

Table F-4 Likelihood of Threat Events of Concern

Threat ID Likelihood of Threat  Likelihood of Threat Event Resulting Overall Likelihood
Event Initiation in Adverse Impacts

TE-1 High Very High Very High
TE-2 Very High High Very High
TE-3 High High High

TE-4 Moderate Very High High

TE-5 High Very High Very High
TE-6 Moderate High Moderate
TE-7 High High High

TE-8 Moderate High High

TE-9 Moderate High Very High
TE-10 High Very High Very High
TE-11 Very High Very High Very High
TE-12 High High High

Note 1: For the Likelihood of Threat Event Initiation, the ratings translate as follows: Moderate =
malicious actor is somewhat likely to initiate; High = malicious actor is highly likely to initiate; Very high =
malicious actor is almost certain to initiate.

Note 2: For the Likelihood of Threat Event Resulting in Adverse Impacts, the ratings translate as follows:
Moderate = if the threat is initiated, it is somewhat likely to have adverse impacts; High = if the threat is
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initiated, it is highly likely to have adverse impacts; Very high = if the threat is initiated, it is almost
certain to have adverse impacts.

Note 3: Overall likelihood was calculated based on the qualitative scale found in Table G-3 of Appendix
G in NIST SP 800-30 Revision 1 [12]. It is derived from both the Likelihood of Threat Event Initiation and
Likelihood of Threat Event Resulting in Adverse Impacts. Because these scales are not true interval
scales, the combined overall ratings do not always reflect a strict mathematical average of the two
ratings.

F.1.10 Task 2-5: Determine the Extent of Adverse Impacts

Determine the adverse impacts from threat events of concern considering (i) the characteristics of the
threat sources that could initiate the events; (ii) the vulnerabilities/predisposing conditions identified;
and (iii) the susceptibility reflecting the safequards/countermeasures planned or implemented to impede
such events.

Threat events with a high potential for adverse impacts were then identified in our specific scenario.

The methodology used to determine the extent of adverse impacts was qualitative (i.e., subjective) and
used the following five-point scale.

= Very High
= High

= Moderate
=  Low

=  VeryLow

Table F-5 Potential Adverse Impacts

Threat Type of Impact Impact Affected Asset Maximum
Impact
TE-1 Harm to Inability, or limited ability, to perform High
Operations, missions/business functions in the future
Assets,
Individuals

Damage to or loss of information systems or networks

TE-2 Harm to Inability, or limited ability, to perform High
Operations, missions/business functions in the future
Other

Organizations
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Type of Impact Impact Affected Asset Maximum
Impact
TE-3 Harm to Inability, or limited ability, to perform High
Operations, missions/business functions in the future
Assets
Damage to or loss of information systems or networks
TE-4 Harm to Inability, or limited ability, to perform High
Operations, missions/business functions in the future
Assets
Damage to or loss of information systems or networks
TE-5 Harm to Inability, or limited ability, to perform High
Operations, missions/business functions in the future
Assets,
Individuals Damage to or loss of information systems or networks
Loss of personally identifiable information
TE-6 Harm to Inability, or limited ability, to perform Very High
Operations, missions/business functions in the future
Assets, Other
Organizations Damage to or loss of information systems or networks
Damage to reputation (and hence future or potential
trust relationships)
TE-7 Harm to Inability, or limited ability, to perform High
Operations, missions/business functions in the future
Assets
Damage to or loss of information systems or networks
TE-8 Harm to Inability, or limited ability, to perform High
Operations, missions/business functions in the future
Assets
Damage to or loss of information systems or networks
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Type of Impact Impact Affected Asset Maximum
Impact
TE-9 Harm to Inability, or limited ability, to perform High
Operations, missions/business functions in the future
Assets
Damage to or loss of information systems or networks
TE-10 Harm to Inability, or limited ability, to perform High
Operations, missions/business functions in the future
Assets
Damage to or loss of information systems or networks
TE-11 Harm to Inability, or limited ability, to perform High
Operations, missions/business functions in the future
Assets,
Individuals Damage to or loss of information systems or networks
Damage to reputation (and hence future or potential
trust relationships)
Loss of personally identifiable information
TE-12 Harm to Inability, or limited ability, to perform High
Operations, missions/business functions in the future
Assets, Other
Organizations, Damage to or loss of information systems or networks
Individuals
Loss of personally identifiable information
Damage to reputation (and hence future or potential
trust relationships)

Note 1: Ratings of maximum impact were based on the qualitative scale found in Appendix H, Table H-3

in NIST SP 800-30 Revision 1 [12].

Note 2: Ratings of maximum impact indicate the threat event could be expected to have negligible (i.e.,
very low risk), limited (i.e., low), serious (i.e., moderate), severe or catastrophic (i.e., high), or multiple
severe or catastrophic effects (i.e., very high).
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Note 3: For specific examples of types of impact, see Appendix H of NIST SP 800-30, Revision 1 [12].

F.1.11 Task 2-6: Determine Risk to Organization

Determine the risk to the organization from threat events of concern considering (i) the impact that
would result from the events; and (ii) the likelihood of the events occurring.

In the interest of brevity, the threat events of concern identified in Task 2-2 were limited to those
presumed to have a foreseeably high likelihood of occurrence and high potential for adverse impact in
Orvilia’s specific scenario.

Threat Source Characteristics
This table summarizes the risk assessment findings.

The methodology used to identify risk to organization was qualitative (i.e., subjective) and used the
following five-point scale.

= Very High
= High

= Moderate
= lLow

=  VeryLow

Table F-6 Summary of Risk Assessment Findings

Vulnerabilities, | Overall Level of

Threat Event Predisposing Likelihood | Impact
Conditions

TE-1: Unauthorized access to sensitive | VULN-3 Very High |High High
information via a malicious or privacy-
intrusive application

TE-2: Theft of credentials through an VULN-1 Very High |High High
SMS or email phishing campaign

TE-3: Malicious applications installed VULN-3 High High High
via URLs in SMS or email messages
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Threat Event

TE-4: Confidentiality and integrity loss
due to exploitation of known
vulnerability in the OS or firmware

Overall Level of
Likelihood | Impact

Vulnerabilities,

Predisposing
Conditions

VULN-3 High High

High

TE-5: Violation of privacy via misuse of
device sensors

VULN-3 Very High |High

High

TE-6: Compromise of the integrity of
the device or its network
communications via installation of
malicious EMM/MDM, network, VPN
profiles, or certificates

VULN-3 Moderate |Very High

High

TE-7: Loss of confidentiality of sensitive
information via eavesdropping on
unencrypted device communications

VULN-2 High High

High

TE-8: Compromise of device integrity
via observed, inferred, or brute-forced
device unlock code

VULN-3 High High

High

TE-9: Unauthorized access to backend
services via authentication or
credential storage vulnerabilities in
internally developed applications

VULN-3 Very High |High

High

TE-10: Unauthorized access of
enterprise resources from an
unmanaged and potentially
compromised device

VULN-1 Very High |High

High

TE-11: Loss of organizational data due
to a lost or stolen device

VULN-3 Very High |High

High

TE-12: Loss of confidentiality of
organizational data due to its

VULN-3 High High

High
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Vulnerabilities, | Overall Level of {3

Threat Event Predisposing Likelihood | Impact
Conditions

unauthorized storage in non-
organizationally managed services

Note 1: Risk is stated in qualitative terms based on the scale in Table I-2 of Appendix | in NIST SP 800-30
Revision 1 [12].

Note 2: The risk rating itself is derived from both the overall likelihood and level of impact using Table I-
2 of Appendix | in NIST SP 800-30 Revision 1 [12]. Because these scales are not true interval scales, the
combined overall risk ratings from Table I-2 do not always reflect a strict mathematical average of these
two variables. This is demonstrated in the table above in which levels of Moderate weigh more heavily
than other ratings.

Note 3: Ratings of risk relate to the probability and level of adverse effect on organizational operations,
organizational assets, individuals, other organizations, or the nation. Per NIST SP 800-30 Revision 1,
adverse effects (and the associated risks) range from negligible (i.e., very low risk), limited (i.e., low),
serious (i.e., moderate), severe or catastrophic (i.e., high), to multiple severe or catastrophic effects (i.e.,
very high).
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This section describes the privacy risk assessment conducted on Orvilia’s enterprise security
architecture. To perform the privacy risk assessment, the National Institute of Standards and Technology
(NIST) Privacy Risk Assessment Methodology (PRAM) was used, a tool for analyzing, assessing, and
prioritizing privacy risks to help organizations determine how to respond and select appropriate
solutions. The PRAM can also serve as a useful communication tool to convey privacy risks within an
organization. A blank version of the PRAM is available for download on NIST’s website [19].

The PRAM uses the privacy risk model and privacy engineering objectives described in NIST Internal
Report 8062, An Introduction to Privacy Engineering and Risk Management in Federal Systems [20], to
analyze potential problematic data actions. Data actions are any system operations that process
personally identifiable information (PIl). Processing can include collection, retention, logging, analysis,
generation, transformation or merging, disclosure, transfer, and disposal of PIl. A problematic data
action is one that could cause an adverse effect for individuals.

The PRAM begins with framing the business objectives for the system, including the organizational
needs served, and framing organizational privacy governance, including identification of privacy-related
legal obligations and commitments to principles or other organizational policies. Next, create a data
map to illustrate the data actions performed by the system and the PIl processed by the data actions.
These data actions, the Pll being processed, and the contextual factors that describe the circumstances
surrounding the system’s processing of Pll serve as inputs to the risk analysis.

Then, assess the probability that a data action will become problematic for individuals, assess the
secondary costs absorbed by the organization from a data action creating a problem for individuals, and
use likelihood and impact calculations to determine the total estimated risk per data action. Finally, list
potential mitigating technical and policy controls for the identified risks. The output from the PRAM
activities resulted in the information contained in Figure G-1.

Note: The Key within Figure G-1 includes all data action types (Collection, Retention/Logging,
Generation/Transformation, Disclosure/Transfer, and Disposal), but this particular example solution
does not cover the Disposal of data in the Privacy Data Mapping exercise.
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Figure G-1 PRAM Data Map for Orvilia’s Enterprise Security Architecture
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As an output of the Orvilia PRAM, we identified three broad data actions with the potential to create
problems for individuals and relevant mitigations. Some mitigations listed under a particular data action
may provide privacy benefits to individuals beyond the scope of that data action. We also identified
overarching training and support controls that can help mitigate risks associated with all three of these
data actions.

While a security information and event management (SIEM) capability was not used in the reference
implementation, SIEMs, as discussed here, can be extremely beneficial in understanding the privacy
implications of the mobile device security data being logged, aggregated, and stored.

G.1 Data Action 1: Blocking Access and Wiping Devices

Devices that might pose a risk to the organization’s security posture can be blocked from accessing
enterprise resources or wiped and reset to factory setting defaults. Options are outlined in the following
sections for how this might be accomplished.

G.1.1 Potential Problem for Individuals

In a corporate-owned personally-enabled or bring your own device environment, employees are likely to
use their devices for both personal and work-related purposes. Therefore, in a system that features the
capability to wipe a device entirely, there could be an issue of employees losing personal data—and
employees may not even expect this possibility. A hypothetical example would be that an Orvilia
employee stores personal pictures on the mobile device issued to them by Orvilia, but these photos are
lost when their device is wiped after anomalous activity is detected.

G.1.2 Mitigations

Block access instead of wiping devices.

As an alternative to wiping data entirely, devices can be blocked from accessing enterprise resources,
for example, until an unapproved application is removed. This temporary blocking of access helps
ensure an individual will not lose personal data through a full wipe of a device. Taking this approach may
help bring the system’s capabilities into alighment with employees’ expectations about what can
happen to their devices, especially if they are unaware that devices can be wiped by administrators—
providing for greater predictability in the system.

= Related mitigation: If this approach is taken, remediation processes should also be established
and communicated to employees. It is important to have a clear remediation process in place to
help employees regain access to resources on their devices at the appropriate time. It is equally
important to clearly convey this remediation process to employees. A remediation process
provides greater manageability in the system supporting employees’ ability to access resources.
If well communicated to employees, this also provides greater predictability, as employees will
know the steps involved in regaining access.

NIST SP 1800-21B: Mobile Device Security: Corporate-Owned Personally-Enabled 104



"[Z-OOg'['dS'_LS|N/gZOQ'OI/EJO'!Op//Zdnq ‘woJy BSJEL]C) }JO 934} 9|qe|leae si| u011931|qnd SIyl

Enable only selective wiping.

An alternative mitigation option for wiping is to specify the information to be wiped. Performing a
selective wipe is an option that only removes enterprise data from the device instead of being a full
factory reset. When configured this way, a wipe preserves employees’ personal configurations,
applications, and data while removing only the corporate configurations, applications, and data. Within
the example solution, this option is available for iOS devices.

Advise employees to back up the personal data maintained on devices.

If device wiping remains an option for administrators, encourage employees to perform regular backups
of their personal data to ensure it remains accessible in case of a wipe.

Limit staff with the ability to perform wipes or block access.

Limit staff with the ability to perform a wipe to only those with that responsibility by using role-based
access controls. This can help decrease the chances of accidentally removing employee data or blocking
access to resources.

G.2 Data Action 2: Employee Monitoring

The assessed infrastructure offers Orvilia a number of security capabilities, including reliance on
comprehensive monitoring capabilities, as noted in Section 4, Architecture. A significant amount of data
relating to employees, their devices, and their activities is collected and analyzed by multiple parties.

G.2.1 Potential Problem for Individuals

Employees may not be aware that their interactions with the system are being monitored and may not
want this monitoring to occur. Collection and analysis of information might enable Orvilia or other
parties to craft a narrative about an employee based on their interactions with the system, which could
lead to a power imbalance between Orvilia and the employee and loss of trust in the employer if the
employee discovers unanticipated monitoring.

G.2.2 Mitigations

Limit staff with ability to review data about employees and their devices.

This may be achieved using role-based access controls and by developing organizational policies to limit
how employee data can be used by staff with access to that data. Access can be limited to any
dashboard in the system containing data about employees and their devices but is most sensitive within
the mobile management dashboard, which is the hub for data about employees, their devices, and
threats. Minimizing access to sensitive information can enhance disassociability for employees using the
system.
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Limit or disable collection of specific data elements.

Conduct a system-specific privacy risk assessment to determine what elements can be limited. Consider
the configuration options for intrusive device features, such as location services, application inventory
collection, and location-based wake-ups. When collecting application inventory data, ensure that
information is gathered only from applications installed from the organization’s corporate application
store. While these administrative configurations may help provide for disassociability in the system,
there are also some opportunities for employees to limit the data collected.

Organizations may allow their employees to manage certain aspects and configurations of their device.
For example, employees may be able to disable location services in their device OS to prevent collection
of location data. Each of these controls contributes to reducing the number of attributes collected
regarding employees and their mobile devices. This reduction of collected data limits administrators’
ability to associate information with specific individuals.

Dispose of PII.

Disposal of Pll after an appropriate retention period can help reduce the risk of entities building profiles
of individuals. Disposal can also help bring the system’s data processing into alignment with employees’
expectations and reduce the security risk associated with storing a large volume of PII. Disposal may be
particularly important for certain parties in the system that collect a larger volume of data or more
sensitive data. Disposal may be achieved using a combination of policy and technical controls. Parties in
the system may identify what happens to data, when, and how frequently.

G.3 Data Action 3: Data Sharing Across Parties

The infrastructure involves several parties that serve different purposes supporting Orvilia’s security
objectives. As a result, there is a significant flow of data about individuals and their devices occurring
across various parties. This includes sharing device and application data publicly and with third-party
analytics services, and includes sharing device status and usage with third-party analytics.

G.3.1 Potential Problems for Individuals

Data transmission about individuals and their devices among a variety of different parties could be
confusing for employees who might not know who has access to different information about them. If
administrators and co-workers know what colleague is conducting activity on his or her device that
triggers security alerts, it could cause employee embarrassment or emotional distress. This information
being revealed and associated with specific employees could also lead to stigmatization and even impact
Orvilia upper management in their decision-making regarding the employee. Further, clear text
transmissions could leave information vulnerable to attackers and the unanticipated release of
employee information.
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G.3.2 Mitigations

Use de-identification techniques.

De-identification of data helps decrease the chances that a third party is aggregating information
pertaining to one specific individual. While de-identification can help reduce privacy risk, there are
residual risks of reidentification. De-identification techniques may be applied to aggregated data before
sharing it with third-party analytics and publicly.

Use encryption.

Encryption decreases the chances of insecure information being transmitted between parties.
Organizations should keep this in mind when considering how their enterprise data is transmitted and
stored. Mobile security systems share mobile device and application data with one another to optimize
efficiency and leverage data to perform security functions. This data may include application inventory
and employee name, email address, and phone number. Some systems offer multiple encryption
options that allow an organization to choose the encryption level necessary for the type of data that is
stored or transmitted.

Limit or disable access to data.

Conduct a system-specific privacy risk assessment to determine how access to data can be limited. Using
access controls to limit staff access to compliance information, especially when associated with
individuals, is important in preventing association of specific events with particular employees, which
could cause embarrassment. Products used by the organization may offer options for restricting the
amount of employee information that an administrator can access. These options may include hiding an
employee’s username and email address from the administrator console. Mobile application
information may also include employee information. Organizations should consider how their mobile
and other security systems hide application names, application binary analysis details, network names
service set identifier, and network analysis details from administrators.

Limit or disable collection of specific data elements.

Conduct a system-specific privacy risk assessment to determine what elements can be limited.
Identifying the employee information collected and determining what data elements are stored assist in
assessing the privacy risk of mobile security systems. Organizations should consider the mobile security
system’s ability to limit or reduce collection and storage of employee information, such as username,
email address, Global Positioning System location, and application data.

Use contracts to limit third-party data processing.

Establish contractual policies to limit data processing by third parties to only the processing that
facilitates delivery of security services, and no data processing beyond those explicit purposes.
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G.4 Mitigations Applicable Across Various Data Actions

Several mitigations provide benefits to employees pertaining to all three data actions identified in the
privacy risk assessment. These training and support mitigations can help Orvilia appropriately inform
employees about the system and its data processing.

Mitigations:

Provide training to employees about the system, parties involved, data processing, and administrative
actions that can be taken.

Training sessions can also highlight any privacy-preserving techniques used, such as for disclosures to
third parties. Training should include confirmation from employees that they understand the actions
that can be taken on their devices and the consequences—whether this involves blocking access or
wiping data. Employees may also be informed of data retention periods and when their data will be
disposed of. This can be more effective than sharing a privacy notice, which research has shown that
individuals are unlikely to read.

Provide ongoing notifications or reminders about system activity.

This can be achieved using push notifications, similar to those pictured in screenshots in Appendix H,
Threat Event 6, to help directly link administrative actions on devices to relevant threats and help
employees understand why an action is being taken. Notifications of changes to policies can help
increase system predictability by setting employee expectations appropriately with the way the system
processes data and the resulting actions.

Provide a support point of contact.

By providing employees with a point of contact in the organization who can respond to inquiries and
concerns regarding the system, employees can gain a better understanding of the system’s processing of
their data, which enhances predictability.
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Appendix H Threat Event Test Information

Detailed information and screenshots for some of this practice guide’s threat events and their testing
results are provided below.

H.1 Threat Event 1—Unauthorized Access to Sensitive Information via a
Malicious or Privacy-Intrusive Application

A part of Threat Event 1’s testing conclusions is shown in the following screen capture, where the
calendar access permission is being set to a risk score of 10. This allows Mobilelron to automatically
apply the mobile threat protection high-risk label to the device and quarantine the device until the
privacy-intrusive application is removed.

Figure H-1 Setting a Custom Risk Level in Appthority

1 Cam Acoess Cabendas v Appicston Os 1 . 1 - -3

O w A5 Full OM g (=TT Apgicabon Os L
71 Sends Cabendar ] Apphcation O= | e

L1 Sends Cabendas Unsncryptea A Appacaton 0& ' 8

H.2 Threat Event 2—Theft of Credentials Through a Short Message Service
(SMS) or Email Phishing Campaign

Threat Event 2’s outcome is shown in the following screen capture, where PAN-DB is blocking a website
manually added to the malicious uniform resource locator (URL) database.
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Figure H-2 PAN-DB Blocked Website

421 80 as - s
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Web Page Blocked

Access to the web page you were
trying to visit has been blocked in
accordance with company policy.
Please contact your system
administrator if you believe this is in
error.

User: govt\gema
URL: example.com/

Category: Mobile Lab URL Category

I O <

H.3 Threat Event 3—Malicious Applications Installed via URLs in SMS or
Email Messages

The following screenshots demonstrate enabling the Unknown Sources toggle and installing an
application through a link in an email message.
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Figure H-3 Lock Screen and Security
AR N 74 51%E3:25PM
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Work profile notifications
Show all work notification content

Fingerprints

Samsung Pass
Use biometric authentication to verify your identity
easily and securely.
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Allow installation of apps from sources i
other than the Play Store.

Secure startup
Protect your phone by using a screen lock when
your phone turns on.

Encrypt SD card
No SD card inserted

Other security settings
Change other security settings, such as those for
security updates and credential storage.

Figure H-4 Phishing Email on Android
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Please click the below link to install an important
application necessary to continue accessing
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Figure H-5 depicts the iOS test activity of receiving an email containing a link to an application from a

non-Apple App Store source.
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Figure H-5 Phishing Email on iOS Figure H-6 Untrusted Developer Warning
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itms-services://?action=download-
manifest&url=https.//

webserver.govt.mdse.nccoe.orgfimportant-app- Untrusted Developer
update.plist Your device management settings do

not allow using apps from developer
. . . . “iPhone Developer:
Please install this important update to maintain
access. on this iPhone. You can allow using
these apps in Settings.

Cancel

T
L

After the application is installed, an untrusted developer notice appears as shown in Figure H-6 when
the user attempts to launch the application.

Figure H-7 shows Lookout’s ability to detect application signing certificates that have been trusted on a
device by the user to execute applications from sources other than Apple’s App Store.
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Figure H-7 Application Signing Certificates

Low Risk Configuration Issue
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0 DEVICE DETAILS CLASSIFICATION FAMILY NAME
iPhone X Non-App Store Signer iPhone Developer: MITRE (X0O00000GKX)

View device >
CLASSIFICATION DESCRIPTION

This device has explicitly trusted a developer in a way that allows this developer to install
any number of apps on this device without going through the standard Apple App Store or
beta approval process. Apps installed this way may possibly be harmful. This device may
also be testing an app under development. If you believe this developer does not pose a
risk to your organization, you may allow it to be trusted.

Allow non-App Store signer

Configuration Anomalies
ANOMALY DESCRIPTION

Non-App Store Signer =

The following screenshots depict an attempt to install and run the unauthorized demo application on an
i0S device with the al lowEnterpriseAppTrust policy restriction set to false by an Enterprise Mobility
Management (EMM) system. The user is not able to trust the developer when the policy restriction is
active, and hence the application will not run.
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Figure H-8 Restriction Setting Modification Screen
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Figure H-9 Unable to Trust Developer

3:25

9
1
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are not trusted
on this iPhone and will not run until the developer is
trusted.

Some restrictions are enforced by "NCCOE"

APPS FROM DEVELOPER “IPHONE DEVELOPER:

Demo App Verified

Android Device Testing

On Android devices, applications cannot be installed from sources other than the Google Play Store
unless the Unknown Sources setting is enabled in the device’s security settings. Lookout can identify
when the Unknown Sources setting has been enabled and can communicate this information to
Mobilelron to enable automated response actions, such as blocking device access to enterprise
resources until the situation is resolved. However, even if Unknown Sources is disabled, it is possible
that the setting was previously enabled and that unauthorized applications were installed at that time.

Figure H-10 shows Lookout’s ability to detect Android devices with Unknown Sources enabled.
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Figure H-10 Unknown Sources Detection
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H.4 Threat Event 4—Confidentiality and Integrity Loss due to Exploitation
of Known Vulnerability in the Operating System or Firmware

Figure H-11 demonstrates Lookout’s ability to identify known vulnerabilities to which unpatched iOS and
Android devices are susceptible. Figure H-12 shows the patch level of the device.
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Figure H-11 Vulnerability Identification
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H.5 Threat Event 5—Violation of Privacy via Misuse of Device Sensors

The following screenshot depicts a Kryptowire application analysis report and the reported permissions
that this application was requesting.

Figure H-13 Kryptowire Analysis Report

&iOS Mobile Application Analysis

Qekeoyptowice

Automated Analysis Summary

Security Privacy & Information Access

£\ No data at rest encryption {\ Gets information about the user
Does not use iOS provided encryption Integrates with an ad network
No data in transit encryption Accesses calendar

Has in app purchases

+ No hard coded credentials

+ No hard coded initialization vector (V) + No cloud storage integration
+ No external library loaded dynamically + No social network integration
« No malware detected + Does not expose sensitive information

Device Access

A Can interactive with sending SMS/MMS
messages
Accesses the Internet
Can access microphone
Accesses photos and/or videos
Accesses contacts/address book
Accesses location

« Does not interact with email client
+ Does not access Bluetooth
+ Does not access camera

H.6 Threat Event 6—Compromise of the Integrity of the Device or Its
Network Communications via Installation of Malicious EMM/Mobile
Device Management, Network, Virtual Private Network (VPN) Profiles,
or Certificates

The configuration profile used for configuring and testing Threat Event 6 is shown in Figure H-14.
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Figure H-14 Configuration Profile Example

oo @ © Enterprise Access — Edited ~
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General . g
0 Mandatory Certificate
[ Restrictions Certificate Name
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@ Global HTTP Proxy
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2:46:13 PM Eastern Standard Time
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Certificates R ubjec “ame
1 Payload Configured

Passcode
& Not configured

~—~ Wi-Fi .
< Not configured

VPN
M\ Not configured
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Figure H-15 shows the email containing a malicious device configuration profile, and Figure H-16 shows
the warning displayed to the user when attempting to mark the malicious certificate as a trusted root.
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Figure H-15 Configuration Profile Phishing Email
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Figure H-16 Root Certificate Authority
Enablement Warning

Root Certificate
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Cancel Continue

NIST SP 1800-21B: Mobile Device Security: Corporate-Owned Personally-Enabled

119



"T2-008T dS LSIN/8209°0T/840°10p//:d13y w04y 931eyd Jo 3.4 3|qe|lene si uonedljgnd siy |

Figure H-17 Reversed Web Page

L o 9:03 PM < .

-
& nccoe.nist.gov G

— =0 =2 =3 ,2\)

< i 09 SRE

Browse to a hypertext transfer protocol secure (https) website from the mobile device and observe
whether the content has been reversed. Figure H-17 illustrates that the person-in-the-middle attack on
a Transport Layer Security-protected connection was successful.

The following screenshots demonstrate a person-in-the-middle attack on Android.
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Figure H-18 Certificate Phishing Email Figure H-19 Reversed Web Page

N 74 62%E1:53PM N T4 49%&9:01 PM

[« I | : () @& »s/www.nccoe.nistgov [1] @
— =0 JJu1 .
System Update inbox pA¢ mm—rnuormaen danonan 3
| '
1 "';r-'l
mdstest mdstest «
\ to me

1:50 PM View details

Please install the attached item in order to continue
your access to enterprise resources.

B enterprise.pem ¥y N
« - =
Reply Reply all Forward

Person-in-the-middle attack is detected by Lookout as shown in Figure H-20.
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Figure H-20 Network Attack Detected

=N T452%a7:57PM

Network Attack
Detected

You should immediately disconnect
from this network and avoid
accessing any sensitive data

until your connection is secure
again. You may want to reset

any password you typed in while
connecting to this network. Contact
your IT admin for assistance.

Close More Info

H.7 Threat Event 7—Loss of Confidentiality of Sensitive Information via
Eavesdropping on Unencrypted Device Communications

The following screenshot shows Appthority detecting an application sending data unencrypted.
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Figure H-21 Unencrypted Data Transfer

Analysis Status MD5 Hash
S
- Submission Received SHA-1 Hash
= - 04/01/2019 20:07:34
—0 P—
APPTHORITY RISK SCORE 10 Last Report Update
04/01/2019 20:12:28
GENERAL INFO TOP
Platform Version Package Name
Android
Market Category File Type Developer
APK
THREATS ToP
Active Risk Inactive Risk
Sends Data Unencrypted @

H.8 Threat Event 8—Compromise of Device Integrity via Observed,
Inferred, or Brute-Forced Device Unlock Code

Mobilelron applies a policy to the devices to enforce a mandatory personal identification number and
device-wipe capability. Lookout reports devices that have the lock screen disabled.
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Figure H-22 Lock Screen Disabled Detection Notice

O ® < Gl i app.lookout.com

Lookout Configuration
|Lock Screen Disabled |
im Dashboard
Device Encryption Disabled
A Issues
Devices Software
Apps 0s i0S
0OS Version 11.2.1

Policies

H.9 Threat Event 9—Unauthorized Access to Backend Services via
Authentication or Credential Storage Vulnerabilities in Internally
Developed Applications

As shown in Figure H-23, Appthority recognized that an application used hard-coded credentials. The

application’s use of hard-coded credentials could introduce vulnerabilities if the hard-coded credentials
were used for access to enterprise resources by unauthorized entities or for unauthorized actions.

NIST SP 1800-21B: Mobile Device Security: Corporate-Owned Personally-Enabled 124



"TZ-008T'dS LSIN/8209°0T/840"10p//:d11y :wouy 934eYd Jo 9314 d|qe|leAe s| uoiredljqnd siy |

Figure H-23 Hard-Coded Credentials

\\\
=0

APPTHORITY RISK SCORE 10
GENERAL INFO

Platform Version

i0s 5.37

Market Category File Type

Productivity IPA
THREATS

Active

Sends Data Unencrypted

Analysis Status

Submission Received
05/08/2018 11:30:08

Last Report Update
05/08/2018 13:14:52

Package Name

Developer

Risk Inactive

1)

Uses Hardcoded Credentials

o

Accesses Location

o

MDS Hash

SHA-1 Hash

TOP

TOP

Risk

H.10 Threat Event 10—Unauthorized Access of Enterprise Resources from
an Unmanaged and Potentially Compromised Device

The following two screenshots depict the inability to connect to the GlobalProtect VPN without the
proper client certificates, obtainable only through enrolling the device in Mobilelron.
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Figure H-24 No Certificates Found on Android Figure H-25 No Certificates Found on iOS

10:20 =

Info

Status D|s§onnect.ed

WARMINGS/ERRORS

No certificates found Required client certificate not found. Please contact
your IT administrator.
GlobalProtect has requested a certificate.
Agreeing to this request will allow the applica-
tion to use this certificate with servers from
now on. The requesting server has been recog-
nized as vpn.govt.mdse.nccoe.org:443. Only
agree to this request if you trust the application.

+ Install certificate

Cancel

Status Messages Help

H.11 Threat Event 11—Loss of Organizational Data Due to a Lost or Stolen
Device
This screenshot depicts the final warning before Android factory-resets the device. In the event the

device was stolen, all corporate data would be removed from the device after one more failed unlock
attempt, thwarting the malicious actor’s goal.
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Figure H-26 Android Device Wipe Warning

An attempt to unlock the device has
been made 9 times. You have 1 attempt
left before the device is reset to factory
default settings and all data is erased,
including files and downloaded apps.

OK

H.12 Threat Event 12—Loss of Confidentiality of Organizational Data Due
to Its Unauthorized Storage in Non-Organizationally Managed Services

The following screenshot shows one of the data loss prevention configuration options in Mobilelron for
ioS.

Figure H-27 Disallowing Screenshots and Screen Recording

Allow screenshots and screen recording (105 9.0 and later)
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Table I-1 lists the technologies used in this project and provides a mapping among the generic
application term, the specific product used, the security control(s) the product provides, and a mapping
to the relevant National Institute of Standards and Technology (NIST) Special Publication (SP) 800-181,
National Initiative for Cybersecurity Education (NICE) Cybersecurity Workforce Framework Work Roles.
From left to right, the columns in the table describe:

Specific product used: vendor product used by the example solution

How the component functions in the build: capability the component provides in the example
solution. This is mapped to the general mobile technology component term.

Applicable Cybersecurity Framework Subcategories: applicable Cybersecurity Framework
Subcategory(s) that the component is providing in the example solution

Applicable NIST controls: the NIST SP 800-53 Revision 4 controls that the component provided
in the example solution

ISO/IEC 27001:2013: International Organization for Standardization (ISO), International
Electrotechnical Commission (IEC) 27001:2013 mapping that the component provides in the
example solution

CIS 6: Center for Internet Security (CIS) version 6 controls mapping that the component provides
in the example solution

NIST SP 800-181, NICE Framework Work Roles: NICE Framework work role(s) that could be used
to manage this component’s use in the example solution. This mapping provides information on
the workforce members who would be engaged in this part of the example solution’s support.
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Table I-1 Example Solution’s Cybersecurity Standards and Best Practices Mapping

Specific

product
used

How the
component

functions in the

build

Applicable
Cybersecurity
Framework
Version 1.1
Subcategories

Applicable NIST SP
800-53 Revision 4
Controls

ISO/IEC
27001:2013

Mobile Threat Intelligence

NIST SP 800-181 NICE
Framework Work Roles

Appthority
Cloud
Service

Mobile Threat
Intelligence

Security
Assessment and
Authorization CA-
2, CA-7, CA-8

Risk Assessment

A.12.6.1 Control
of Technical

SP-RSK-002
Security Control Assessor

SP-ARC-002
Security Architect

OM-ANA-001

ID.RA-1— Asset RA-3, RA-5 vulnerabilities Csc 4 Systems Security Analyst
—_ Continuous
vulnerabilities Vulnerabilit
are identified System and A18.23 \ Y, | PRVAM-001
and documented | S€rvices Technical ssessmentand | yy|nerability Assessment
Acquisition SA-5, . Remediation Analyst
Compliance
SA-11 .
Review
PR-CDA-001 Cyber
System and Defense Analyst
Information
Isrlmtsegrlty SI-2, SI-4, OV-MGT-001
Information Systems
Security Manager
CsC4 SP-RSK-002
ID.RA-3— Risk Assessment Clause 6.1.2 Continuous i |
Threats, both Information Risk u Security Control Assessor
) RA-3 Vulnerability
internal and Assessment Assessment and
external, are Process e PR-CDA-001
Remediation
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How the

ifi
Specific component

product
used

build

functions in the

Applicable
Cybersecurity
Framework

Applicable NIST SP
800-53 Revision 4

ISO/IEC
27001:2013

NIST SP 800-181 NICE
Framework Work Roles

Version 1.1 Controls
Subcategories
identified and System and Cyber Defense Analyst
documented Information
Integrity SI-5 OV-SPP-001
Cyber Workforce
Insider Threat Developer and Manager
Program PM-12,
PM-16 OV-TEA-001
Cyber Instructional
Curriculum Developer
AN-TWA-001
Threat/Warning Analyst
PR-VAM-001
Vulnerability Assessment
Analyst
OV-MGT-001
Information Systems
Security Manager
csc4 PR-VAM-001
Continuous ili
DE.CM-4— System and A12.2.1 u Vulnerability Assessment
- ) ) . Vulnerability Analyst
Malicious code is | Information Controls Against
. Assessment and
detected Integrity SI-3, SI-8 | Malware

Remediation

PR-CIR-001
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Specific

product
used

How the
component
functions in the
build

Applicable
Cybersecurity
Framework
Version 1.1
Subcategories

Applicable NIST SP
800-53 Revision 4
Controls

ISO/IEC
27001:2013

CSC 7 Email and
Web Browser
Protections

CSC 8 Malware
Defenses

CSC 12 Boundary
Defense

NIST SP 800-181 NICE
Framework Work Roles

Cyber Defense Incident
Responder

PR-CDA-001
Cyber Defense Analyst

OM-NET-001

Network Operations
Specialist

Mobile Code SC-

A.12.5.1
Installation of
Software on

CSC 7 Email and

PR-CDA-001
Cyber Defense Analyst

DE.CM-5— 18, SC-44 Operational Web Brf)wser OM-NET-001
Unauthorized Systems Protections .
] . Network Operations
mobile code is System and Specialist
detected Information A.12.6.2 CSC 8 Malware
Integrity SI-4 Restrictions on Defenses
Software
Installation
Mobile Application Vetting Service
Security SP-RSK-002
A.12.6.1 Control .
Assessment and . CSC4 Security Control Assessor
. ID.RA-1—Asset o of Technical ;
Kryptowire L e Authorization CA- e Continuous
Cloud Application vulnerabilities 2 CA-7 CA-8 vulnerabilities Vulnerabilit
. Vetting are identified ’ ’ v SP-ARC-002
Service and documented Assessment and Security Architect
Risk Assessment A'18'2,'3 Remediation
Technical

RA-3, RA-5
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Applicable

How the

T compnen e SRS so NS
P functions in the . 27001:2013 Framework Work Roles
used . Version 1.1 Controls
build .
Subcategories
Compliance OM-ANA-001
System and Review Systems Security Analyst
Services
Acquisition SA-5, PR-VAM-001
SA-11 -
Vulnerability Assessment
Analyst
System and
Inforrr?atlon PR-CDA-001
Integrity SI-2, SI-4,
SI-5 Cyber Defense Analyst
OV-MGT-001
Information Systems
Security Manager
SP-RSK-002
Security Control Assessor
Risk Assessment
RA-3 OM-ANA-001
ID.RA-3— .
Systems Security Analyst
Threats, both System and Clause 6.1.2 CSCZ_‘
. . . . Continuous
internal and Information Information Risk Vulnerabilit
external, are Integrity SI-5 Assessment Assessmentyand OV-5PP-001
identified and Process o Cyber Workforce
Remediation

documented Insider Threat

Program PM-12,
PM-16

Developer and Manager

OV-TEA-001

Cyber Instructional
Curriculum Developer
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Specific

product
used

How the
component
functions in the
build

Applicable
Cybersecurity
Framework
Version 1.1
Subcategories

Applicable NIST SP

800-53 Revision 4
Controls

ISO/IEC
27001:2013

NIST SP 800-181 NICE
Framework Work Roles

AN-TWA-001
Threat/Warning Analyst

PR-VAM-001

Vulnerability Assessment
Analyst

PR-CDA-001
Cyber Defense Analyst

OV-MGT-001

Information Systems
Security Manager

DE.CM-4—
Malicious code is
detected

System and
Information
Integrity SI-3, SI-8

A12.2.1
Controls Against
Malware

CSC 4 Continuous
Vulnerability
Assessment and
Remediation

CSC 7 Email and
Web Browser
Protections

CSC 8 Malware
Defenses

CSC 12 Boundary
Defense

PR-CIR-001

Cyber Defense Incident
Responder

PR-CDA-001
Cyber Defense Analyst

PR-VAM-001

Vulnerability Assessment
Analyst

OM-NET-001
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Specific

product
used

How the
component
functions in the
build

Applicable
Cybersecurity
Framework
Version 1.1
Subcategories

Applicable NIST SP
800-53 Revision 4
Controls

ISO/IEC
27001:2013

NIST SP 800-181 NICE
Framework Work Roles

Network Operations
Specialist

Mobile Code SC-

A12.5.1
Installation of
Software on

CSC 7 Email and

PR-CDA-001
Cyber Defense Analyst

DE.CM-5— 18, SC-44 Operational Web Browser OM-NET-001
Unauthorized Systems Protections .
. . Network Operations
mobile code is System and Specialist
detected Information A.12.6.2 CSC 8 Malware
Integrity SI-4 Restrictions on Defenses
Software
Installation
Mobile Threat Defense
A13.1.1 CSC 9 Imitation OM-ADM-001
Network and Control of System Administrator
Lookout Controls Network Ports,
Cloud PRAC.S_ Protgcols, and OV-SPP-002
Service/ ' . : Access Control AC- Services Cyber Policy and Strate
Network integrity | 4 Ac_10 A.13.13 y icy gy
Lookout . . ’ ion i Planner
Mobile Threat | is protected (e.g., Segregation in
Agent CSC 14
. Defense/Endpo | network Networks
Version . . . System and Controlled
int Security segregation, PR-CDA-001
5.10.0.142 network Communications Access Based on
(i0S), segmentation) Protection SC-7 A.13.2.1 ‘ the Need to Cyber Defense Analyst
5.9.0.420 Information | know
(Android) Transfer Policies OM-NET-001

and Procedures

CSC 15 Wireless
Access Control

Network Operations
Specialist
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Specific

product
used

How the
component
functions in the
build

Applicable
Cybersecurity
Framework
Version 1.1
Subcategories

Applicable NIST SP
800-53 Revision 4

Controls

ISO/IEC
27001:2013

A14.1.2
Securing
Application
Services on
Public Networks

A14.1.3
Protecting
Application
Services
Transactions

CsC 18
Application
Software
Security

NIST SP 800-181 NICE
Framework Work Roles

PR.PT-4—
Communications
and control
networks are
protected

Access Control AC-

4, AC-17, AC-18

Contingency
Planning Policy
and Procedures
CP-8

System and
Communications
Protection SC-7,
SC-19, SC-20, SC-
21, SC-22, SC-23,
SC-24, SC-25, SC-
29, SC-32, SC-36,
SC-37, SC-38, SC-

A.13.1.1
Network
Controls

A.13.1.3
Segregation in
Networks

A.14.1.3
Protecting
Application
Services
Transactions

CSC 8 Malware
Defenses

CSC 12 Boundary
Defense

CSC 15 Wireless
Access Control

OM-ADM-001
System Administrator

OV-SPP-002

Cyber Policy and Strategy
Planner

OV-MGT-002

Communications Security
(COMSEC) Manager

SP-ARC-0001
Enterprise Architect

PR-CDA-001
Cyber Defense Analyst
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Specific

product
used

How the
component
functions in the
build

Applicable
Cybersecurity
Framework
Version 1.1
Subcategories

Applicable NIST SP
800-53 Revision 4
Controls

39, SC-40, 5C-41,
SC-43

ISO/IEC
27001:2013

NIST SP 800-181 NICE
Framework Work Roles

SP-ARC-002
Security Architect

OM-NET-001

Network Operations
Specialist

Mobile Code SC-

A12.5.1
Installation of
Software on

CSC 7 Email and

PR-CDA-001
Cyber Defense Analyst

DE.CM-5— 18, SC-44 Operational Web Browser OM-NET-001
Unauthorized Systems Protections Network Operations
mobile code is System and Specialist
detected Information A.12.6.2 CSC 8 Malware
Integrity SI-4 Restrictions on Defenses
Software
Installation
Enterprise Mobility Management
Information OM-STS-001
ID.AM-1—= System A8.11 CSC 1 Inventor Technical S t
Mobilelron . Physical devices Inventory of : Y ec .nlc.a uppor
Enterprise Component of Authorized Specialist
Core . and systems Assets
. Mobility e Inventory CM-8 and
Version Management within the Inf i A8.1.2 Unauthorized
9.7.0.1 & organization are Sn Tmaltlon ¢ Ownership of Devices OM-ADM-001
inventoried ystem Inventory Assets System Administrator

PM-5
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Specific

product
used

How the
component
functions in the
build

Applicable
Cybersecurity
Framework
Version 1.1
Subcategories

PR.AC-1—
Identities and
credentials are
issued, managed,
verified, revoked,
and audited for
authorized
devices, users,
and processes

Applicable NIST SP
800-53 Revision 4
Controls

Access Control AC-
1, AC-2

Identification and
Authentication |A-
1, 1A-2, 1A-3, IA-4,
IA-5, I1A-6, |A-7, IA-
8, IA-9, IA-10, IA-
11

ISO/IEC
27001:2013

A.9.2.1 User
Registration and
De-Registration

A.9.2.2 User
Access
Provisioning

A.9.2.3
Management of
Privileged
Access Rights

A9.2.4
Management of
Secret
Authentication
Information of
Users

A.9.2.6 Removal
or Adjustment
of Access Rights

A.9.3.1 Use of
Secret
Authentication
Information

CSC 1 Inventory
of Authorized
and
Unauthorized
Devices

CSC 5 Controlled
Use of
Administrative
Privileges

CSC 15 Wireless
Access Control

CSC 16 Account
Monitoring and
Control

NIST SP 800-181 NICE
Framework Work Roles

OV-SPP-002

Cyber Policy and Strategy
Planner

OM-ADM-001
System Administrator

OV-MGT-002

Communications Security
(COMSEC) Manager

OM-STS-001

Technical Support
Specialist

OM-ANA-001
Systems Security Analyst

PR-CDA-001
Cyber Defense Analyst
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Applicable
Cybersecurity
Framework

How the
component
functions in the

Specific

product
used Version 1.1

il
L Subcategories

Applicable NIST SP
800-53 Revision 4
Controls

ISO/IEC
27001:2013

A.9.4.2 Secure

NIST SP 800-181 NICE
Framework Work Roles

interactions

Physical and
Environmental
Protection PE-2

Personnel Security
PS-3

De-Registration

Log-On
Procedures
A9S.43
Password
Management
System
Access Control AC- OV-SPP-002
1, AC-2, AC-3, AC- Cyber Policy and Strategy
16, AC-19, AC-24 Planner
PR.AC-6— Identification and A711 OV-MGT-002
Identities are Authentication IA- | " " Communications Securit
Screening y
proofed and 1,1A-2, IA-4, 1A-5, CSC 16 Account | (COMSEC) Manager
bound to IA-8 79210 Monitoring and
credentials and -J.2. L User Control
asserted in Registration and OM-ADM-001

System Administrator

PR.IP-1—A
baseline

configuration of

Information
System
Component

A.12.1.2 Change
Management

CSC 3 Secure
Configurations
for Hardware and

SP-ARC-002
Security Architect
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Specific

product
used

How the
component
functions in the
build

Applicable
Cybersecurity
Framework
Version 1.1
Subcategories
information
technology/indus
trial control
systems is
created and
maintained,
incorporating
security
principles (e.g.,
concept of least
functionality)

Applicable NIST SP
800-53 Revision 4
Controls

Inventory CM-2,
CM-3, CM-4, CM-
5, CM-6, CM-7,
CM-9

System and
Services
Acquisition SA-10

ISO/IEC
27001:2013

A.12.5.1
Installation of
Software on
Operational
Systems

A.12.6.2
Restrictions on
Software
Installation

A.14.2.2 System
Change Control
Procedures

A14.2.3
Technical
Review of
Applications
After Operating
Platform
Changes

A14.2.4
Restrictions on
Changes to
Software
Packages

Software on
Mobile Devices,
Laptops,
Workstations,
and Servers

CSC 9 Limitation
and Control of
Network Ports,
Protocols, and
Services

CSC 11 Secure
Configurations
for Network
Devices Such as
Firewalls,
Routers, and
Switches

NIST SP 800-181 NICE
Framework Work Roles

OV-SPP-002

Cyber Policy and Strategy
Planner

SP-SYS-001

Information Systems
Security Developer

OM-ADM-001
System Administrator

PR-VAM-001

Vulnerability Assessment
Analyst

OM-NET-001

Network Operations
Specialist

OV-MGT-001

Information Systems
Security Manager

OM-STS-001

Technical Support
Specialist
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Specific

product
used

Mobilelron
Agent
Version
11.0.1A
(i0s),
10.2.1.1.3R
(Android)

How the
component
functions in the
build

EMM/Endpoint
Agent

Applicable
Cybersecurity
Framework
Version 1.1
Subcategories

PR.DS-6—
Integrity-
checking
mechanisms are
used to verify
software,
firmware, and
information
integrity

Applicable NIST SP
800-53 Revision 4
Controls

System and
Communications
Protection SC-1

System and
Information
Integrity SI-7

ISO/IEC
27001:2013

A12.2.1
Controls Against
Malware

A125.1
Installation of
Software on
Operational
Systems

A14.1.2
Securing
Application
Services on
Public Networks

A.14.1.3
Protecting
Application
Services
Transactions

A.14.2.4
Restrictions on
Changes to
Software
Packages

CSC 2 Inventory
of Authorized
and
Unauthorized
Software

CSC 3 Secure
Configurations
for Hardware and
Software on
Mobile Devices,
Laptops,
Workstations,
and Servers

NIST SP 800-181 NICE
Framework Work Roles

OV-SPP-002

Cyber Policy and Strategy
Planner

SP-ARC-0001
Enterprise Architect

OV-MGT-001

Information Systems
Security Manager

OM-ADM-001
System Administrator

OM-STS-001

Technical Support
Specialist

Trusted Execution Environment
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Specific

product
used

Qualcomm
(Version is
mobile
device
dependent)

How the
component
functions in the
build

Trusted
Execution
Environment

Applicable
Cybersecurity
Framework
Version 1.1
Subcategories

Applicable NIST SP
800-53 Revision 4
Controls

ISO/IEC
27001:2013

NIST SP 800-181 NICE
Framework Work Roles

OV-SPP-002

Cyber Policy and Strategy
Planner

PR-INF-001

Cyber Defense
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Certain commercial entities, equipment, products, or materials may be identified by name or company
logo or other insignia in order to acknowledge their participation in this collaboration or to describe an
experimental procedure or concept adequately. Such identification is not intended to imply special
status or relationship with NIST or recommendation or endorsement by NIST or NCCoE; neither is it
intended to imply that the entities, equipment, products, or materials are necessarily the best available
for the purpose.

National Institute of Standards and Technology Special Publication 1800-21C Natl. Inst. Stand. Technol.
Spec. Publ. 1800-21C, 167 pages, (September 2020), CODEN: NSPUE2

As a private-public partnership, we are always seeking feedback on our practice guides. We are
particularly interested in seeing how businesses apply NCCoE reference designs in the real world. If you
have implemented the reference design, or have questions about applying it in your environment,
please email us at mobile-nccoe@nist.gov.

All comments are subject to release under the Freedom of Information Act.

National Cybersecurity Center of Excellence
National Institute of Standards and Technology
100 Bureau Drive
Mailstop 2002
Gaithersburg, MD 20899

Email: nccoe@nist.gov
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The National Cybersecurity Center of Excellence (NCCoE), a part of the National Institute of Standards
and Technology (NIST), is a collaborative hub where industry organizations, government agencies, and
academic institutions work together to address businesses’ most pressing cybersecurity issues. This
public-private partnership enables the creation of practical cybersecurity solutions for specific
industries, as well as for broad, cross-sector technology challenges. Through consortia under
Cooperative Research and Development Agreements (CRADAs), including technology partners—from
Fortune 50 market leaders to smaller companies specializing in information technology security—the
NCCoE applies standards and best practices to develop modular, adaptable example cybersecurity
solutions using commercially available technology. The NCCoE documents these example solutions in
the NIST Special Publication 1800 series, which maps capabilities to the NIST Cybersecurity Framework
and details the steps needed for another entity to re-create the example solution. The NCCoE was
established in 2012 by NIST in partnership with the State of Maryland and Montgomery County,
Maryland.

To learn more about the NCCoE, visit https://www.nccoe.nist.gov. To learn more about NIST, visit
https://www.nist.gov.

NIST Cybersecurity Practice Guides (Special Publication 1800 series) target specific cybersecurity
challenges in the public and private sectors. They are practical, user-friendly guides that facilitate the
adoption of standards-based approaches to cybersecurity. They show members of the information
security community how to implement example solutions that help them align with relevant standards
and best practices, and provide users with the materials lists, configuration files, and other information
they need to implement a similar approach.

The documents in this series describe example implementations of cybersecurity practices that
businesses and other organizations may voluntarily adopt. These documents do not describe regulations
or mandatory practices, nor do they carry statutory authority.

Mobile devices provide access to vital workplace resources while giving employees the flexibility to
perform their daily activities. Securing these devices is essential to the continuity of business operations.

While mobile devices can increase efficiency and productivity, they can also leave sensitive data
vulnerable. Mobile device management tools can address such vulnerabilities by helping secure access
to networks and resources. These tools are different from those required to secure the typical computer
workstation.
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This practice guide focuses on security enhancements that can be made to corporate-owned personally-
enabled (COPE) mobile devices. COPE devices are owned by an enterprise and issued to an employee.
Both the enterprise and the employee can install applications onto the device.

To address the challenge of securing COPE mobile devices while managing risks, the NCCoE at NIST built
a reference architecture to show how various mobile security technologies can be integrated within an
enterprise’s network.

This NIST Cybersecurity Practice Guide demonstrates how organizations can use standards-based,
commercially available products to help meet their mobile device security and privacy needs.

KEYWORDS

Corporate-owned personally-enabled; COPE; mobile device management; mobile device security, on-
premise; bring your own device; BYOD
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The Technology Partners/Collaborators who participated in this build submitted their capabilities in
response to a notice in the Federal Register. Respondents with relevant capabilities or product
components were invited to sigh a Cooperative Research and Development Agreement (CRADA) with
NIST, allowing them to participate in a consortium to build this example solution. We worked with:

Technology Partner/Collaborator Build Involvement

Appthority* Appthority Cloud Service, Mobile Threat Intelligence

Kryptowire Kryptowire Cloud Service, Application Vetting

Lookout Lookout Cloud Service/Lookout Agent Version 5.10.0.142
(i0S), 5.9.0.420 (Android), Mobile Threat Defense

Mobilelron

Mobilelron Core Version 9.7.0.1, Mobilelron Agent Ver-
sion 11.0.1A (i0OS), 10.2.1.1.3R (Android), Enterprise Mo-
bility Management

Palo Alto Networks

Palo Alto Networks PA-220

Qualcomm

Qualcomm Trusted Execution Environment (version is de-
vice dependent)

*Appthority (acquired by Symantec—A division of Broadcom)
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The following volumes of this guide show information technology (IT) professionals and security
engineers how we implemented this example solution. We cover all of the mobile device security
products employed in this reference design. We do not re-create the product manufacturers’
documentation, which is presumed to be widely available. Rather, these volumes show how we
incorporated the products together in our environment.

Note: These are not comprehensive tutorials. There are many possible service and security configurations
for these products that are out of scope for this reference design.

1.1 Practice Guide Structure

This National Institute of Standards and Technology (NIST) Cybersecurity Practice Guide demonstrates a
standards-based reference design and provides users with the information they need to replicate
addressing mobile device security (MDS) for Corporate-Owned Personally-Enabled (COPE)
implementation challenges. This reference design is modular and can be deployed in whole or in part.

This guide contains three volumes:

= NIST SP 1800-21A: Executive Summary
= NIST SP 1800-21B: Approach, Architecture, and Security Characteristics — what we built and why

= NIST SP 1800-21C: How-To Guides — instructions for building the example solution (you are
here)

Depending on your role in your organization, you might use this guide in different ways:

Business decision makers, including chief security and technology officers, will be interested in the
Executive Summary, NIST SP 1800-21A, which describes the following topics:

= challenges that enterprises face in securely deploying COPE mobile devices
= example solution built at the National Cybersecurity Center of Excellence (NCCoE)
= benefits of adopting the example solution

Technology or security program managers who are concerned with how to identify, understand, assess,
and mitigate risk will be interested in NIST SP 1800-21B, which describes what we did and why. The
following sections will be of particular interest:

= Section 3.4, Risk Assessment, describes the risk analysis we performed.

=  Section 4.3, Security Control Map, discusses the security mappings of this example solution to
cybersecurity standards and best practices.

NIST SP 1800-21C: Mobile Device Security: Corporate-Owned Personally-Enabled 1
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You might share the Executive Summary, NIST SP 1800-21A, with your leadership team members to help
them understand the importance of adopting standards-based solutions when addressing COPE mobile
device security implementation challenges.

IT professionals who want to implement an approach like this will find this whole practice guide useful.
You can use this How-To portion of the guide, NIST SP 1800-21C, to replicate all or parts of the build
created in our lab. This How-To portion of the guide provides specific product installation, configuration,
and integration instructions for implementing the example solution. We do not recreate the product
manufacturers’ documentation, which is generally widely available. Rather, we show how we
incorporated the products together in our environment to create an example solution.

This guide assumes that IT professionals have experience implementing security products within the
enterprise. While we have used a suite of commercial products to address this challenge, this guide does
not endorse these particular products. Your organization can adopt this solution or one that adheres to
these guidelines in whole, or you can use this guide as a starting point for tailoring and implementing
parts of this guide’s example solution for on-premises mobile device security management. Your
organization’s security experts should identify the products that will best integrate with your existing
tools and IT system infrastructure. We hope that you will seek products that are congruent with
applicable standards and best practices. Section 3.6, Technologies, lists the products that we used and
maps them to the cybersecurity controls provided by this reference solution.

A NIST Cybersecurity Practice Guide does not describe “the” solution, but a possible solution.
Comments, suggestions, and success stories will improve subsequent versions of this guide. Please
contribute your thoughts to mobile-nccoe@nist.gov.

1.2 Build Overview

When a business is on the go, mobile devices can serve as a temporary workstation replacement. They
provide convenience of use, portability, and functionality. However, in many ways, mobile devices are
different from the common computer workstation, and alternative management tools are required to
secure their interactions with the enterprise. To address this security challenge, the NCCoE worked with
its Community of Interest and build team partners and developed a real-world scenario for mobile
deployment within an enterprise. The scenario presents a range of security challenges that an enterprise
may experience when deploying mobile devices.

The lab environment used in developing this solution includes the architectural components,
functionality, and standard best practices, which are described in Volume B. The build team partners
provided the security technologies used to deploy the architecture components and functionality. The
standard best practices are applied to the security technologies to ensure the appropriate security
controls are put in place to meet the challenges presented in the devised scenario.
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This section of the guide documents the build process and discusses the specific configurations used to
develop a secure mobile deployment.

Note: Android for Work (AFW) has been re-branded as Android Enterprise. At the time of writing this
document, it was named Android for Work.

1.3 Typographic Conventions

The following table presents typographic conventions used in this volume.

Table 1-1 Typographic Conventions

Typeface/Symbol Meaning Example

Italics file names and path names; For detailed definitions of terms, see
references to documents that | the NCCoE Glossary.

are not hyperlinks; new
terms; and placeholders

Bold names of menus, options, Choose File > Edit.
command buttons, and fields
Monospace command-line input, mkdir

onscreen computer output,
sample code examples, and
status codes

Monospace Bold command-line user input service sshd start
contrasted with computer
output
blue text link to other parts of the All publications from NIST’s NCCoE
document, a web URL, or an are available at
email address https://www.nccoe.nist.gov.

1.4 Logical Architecture Summary

The following graphic illustrates the main components of this example implementation and provides a
view of how they interact.

NIST SP 1800-21C: Mobile Device Security: Corporate-Owned Personally-Enabled
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Figure 1-1 Logical Architecture Summary

Mobile Threat Mobile Threat Ikop Vetting
) Defense | Intelligence 3 (Kryptowire)
detected threats v .-ﬁ-i (Lookout) 7. ‘ﬁ-ﬂ (Appthority) . _
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(Mobilelron) VPN Gateway
s |
device attestation >~ rg Enterprise
App Store
Trusted
Execution
Environment
(Qualcomm)
Enterprise Resources
P,
]
& L local Cloud Local
L Installation ) Service Connector Enterprise Network

This section of the practice guide contains detailed instructions for installing and configuring key
products used for the architecture illustrated below.

In our lab environment, the example solution was logically separated by a virtual local area network
(VLAN) wherein each VLAN represented a separate mock enterprise environment. The network
perimeter for this example implementation was enforced by a Palo Alto Networks virtual private
network (VPN)/firewall appliance. It maintains three zones: one each for the internet/wide area network
(WAN), a demilitarized zone (DMZ), and the organizational local area network (LAN).
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2.1 Appthority Mobile Threat Detection

Appthority contributed a test instance of its Mobile Threat Detection service. Contact Appthority
(Symantec) (https://www.symantec.com/) to establish an instance for your organization.

2.2 Kryptowire EMM+S

Kryptowire contributed a test instance of its EMM+S application-vetting service. Contact Kryptowire
(https://www.kryptowire.com/mobile-app-security/) to establish an instance for your organization.

2.3 Lookout Mobile Endpoint Security

Lookout contributed a test instance of its Mobile Endpoint Security (MES) service. Contact Lookout
(https://www.lookout.com/products/mobile-endpoint-security) to establish an instance for your
organization.

2.4 Mobilelron Core

Mobilelron Core is the central product in the Mobilelron suite. The following sections describe the steps
for installation, configuration, and integration with Active Directory (AD).

2.4.1 |Installation of Mobilelron Core and Stand-Alone Sentry

Follow the steps below to install Mobilelron Core:

1. Obtain a copy of the On-Premise Installation Guide for Mobilelron Core, Sentry, and Enter-
prise Connector from the Mobilelron support portal.

2. Follow the Mobilelron Core pre-deployment and installation steps in Chapter 1 of the On-
Premise Installation Guide for Mobilelron Core, Sentry, and Enterprise Connector for the
version of Mobilelron being deployed in your environment. In our lab implementation, we
deployed Mobilelron Core 9.5.0.0 as a Virtual Core running on VMware 6.0. Post-installa-
tion, we performed an upgrade to Mobilelron Core 9.7.0.1 following guidance provided in
CoreConnectorReleaseNotes9701 _Rev12Apr2018. Direct installations to Mobilelron Core
9.7.0.1 will experience slightly different results, as some added features in this version are
not used with earlier versions of configuration files.

2.4.2 General Mobilelron Core Setup

The following steps are necessary for mobile device administrators or users to register devices with
Mobilelron.

1. Obtain a copy of Mobilelron Core Device Management Guide for iOS Devices from the Mo-
bilelron support portal.
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2. Complete all instructions provided in Chapter 1, Setup Tasks.

2.4.3 Upgrade Mobilelron Core

The following steps were used to upgrade our instance of Mobilelron Core from 9.5.0.0 to 9.7.0.1. Note
there was no direct upgrade path between these two versions; our selected upgrade path was 9.5.0.0 >
9.5.0.1>9.7.0.1.

1. Obtain upgrade credentials from Mobilelron Support.
2. In Mobilelron Core System Manager, navigate to Maintenance > Software Updates.
3. Inthe Software repository configuration section:
a. Inthe User Name field, enter the username provided by Mobilelron Support.
b. Inthe Password field, enter the password provided by Mobilelron Support.
c. Inthe Confirm Password field, reenter the password provided by Mobilelron Support.
d. Select Apply.

Figure 2-1 Mobilelron Repository Configuration

@) Mobilelron

Software Updates Maintenance — Software Updates
Self Diagnosis Software Version
Export Configuration Core 9.5.0.0 Build 77

Import Configuration
Software repository configuration
Clear Configuratior

User Name: maobileironeval

Reboot Password: sesssnenss
Confirm Password; | ssssesss ul

URL: @ Default (i ]

System Backup

Optimize Database

4. In the Software Updates section:

a. Select Check Updates; after a few seconds, the available upgrade path options appears.
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b. Select the Core 9.5.0.1 status: Not Downloaded option.
c. Select Download Now. After a delay, the Software Download dialogue appears.

Figure 2-2 Mobilelron Core Version

@ Mobilelron

SETTINGS SECURITY MAINTENANCE TROUBLESHOOTING

Software Updates Mantenance — Software Updates
Export Configuration Software Version
Import Configuration Core 9.5.0.0 Build 77

Clear Configuration
Software repository configuration

System Storage

Reboot User Name: mobileironeval
System Backup Password:
Optimize Database URL: @ Default © 0

/

T o

Software updates

() Core 2.6.0.1 status: Not downloaded
@ Core 9.5.0.1 status: Not downloaded

Note: To install, please reboot the system only after status says Reboot to install.

5. Inthe Download Software dialogue, click OK.
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Figure 2-3 Mobilelron Download Status

Download software

Download is successful.Please click on the Stage for Install and then Reboot the
system.

6. Inthe Software updates section:
a. Select the Core 9.5.0.1 status: Downloaded option.
b. Select the Validate Database Structure and Data option.
c. Select Validate.
Figure 2-4 Validating Database Data

Software updates

Check Updates

© Core 9.6.0.1 status: Not downloaded

@ Core 9.5.0.1 status: Downloaded.

© validate Database structure (schema)

@ Validate Database structure and Data

Validation Status: NOT RUNNING

Download Now Validate Stage for Install

Note: To install, please reboot the system only after status says Reboot to install.

7. Inthe Confirm dialogue, click Yes to validate database structure and data.
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Figure 2-5 Validating Database Data Confirmation

]

? ) ‘Validate Database structure and Data’ runs in maintenance mode and stops core services during validation. Do you want to proceed?
ves | o
8. Inthe Validate Update dialogue, click OK.

Figure 2-6 Database Data Validation Initiation Confirmation

Validate Update

Validation initiated successfully

o

9. Inthe Software updates section, select Stage for Install.
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Figure 2-7 Database Data Validation Status

Software updates

() Core 9.6.0.1 status: Not downloaded

@ Core 9.5.0.1 status: Downloaded.

() Validate Database structure (schema)

@ Validate Database structure and Data

Validation Status: SUCCESS - Validation is successful
For detailed validation logs click here

Download Now Validate Stage for Install

Note: To install, please reboot the system only after status says Reboot to install.

a. The Download Updates dialogue appears.
10. In the Download Updates dialogue, select Reboot Now; a series of dialogues appears.

Figure 2-8 Software Updates Reboot Prompt

Download Updates

Please click on the following link to view the upgrade status after the
reboot.

https://mi-core.govt.mdse.nccoe.org:8443/upgrade/status

Reboot Now Reboot Later

11. In the Confirm dialogues:
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a. Click Yes to confirm the appliance reboot.

Figure 2-9 Software Update Reboot Confirmation

Confirm

\t:/ Do you really want to reboot the appliance?
-
Yes ‘ No |

b. Click Yes to confirm saving the current configuration.

Figure 2-10 Reboot Configuration Save Prompt

-
4

Confirm

9 Would you like to save your current
\:'4) configuration?

Yes || Mo

12. The Upgrade Status website hosted by Core automatically opens.

Figure 2-11 Upgrade Status

"/\ Mobile Upgrade Status

Start Invoking upgrade-database

13. Once the upgrade is complete, System Manager > Maintenance > Software Updates >
Software Updates now shows the capability to upgrade to 9.7.0.1.
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Figure 2-12 Ability to Upgrade t0 9.7.0.1

Software updates

() Core 9.6.0.3 status: Not downloaded

() Core 9,7.0.1 status: Not downloaded

Sap or il

Note: To install, please reboot the system only after status says Reboot to install.

The image shows the Core patch levels this instance can upgrade to. Specifically, it shows Core 9.6.0.3
and Core 9.7.0.1.

14. Repeat Steps 4b through 11 above, replacing 9.5.0.1 with 9.7.0.1 during Steps 4b and 6;
this will complete the upgrade path from Mobilelron Core 9.5.0.0 t0 9.7.0.1.

2.4.4 Integration with Microsoft Active Directory

In our implementation, we chose to integrate Mobilelron Core with Active Directory using lightweight
directory access protocol (LDAP). This is optional. General instructions for this process are covered in the
Configuring LDAP Servers section in Chapter 2 of On-Premise Installation Guide for Mobilelron Core,
Sentry, and Enterprise Connector. The configuration details used during our completion of selected steps
(retaining the original numbering) from that guide are given below:

1. From Step 4 in the Mobilelron guide, in the New LDAP Server dialogue:

a. Directory Connection:
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Figure 2-13 LDAP Settings

New LDAP Setting

Directory Connection

Directory URL: ldap://192.168.7.10
Directory Failover URL:

Directory UserID: mi-ldap-sync

Search Results Timeout: 30 Seconds

Chase Referrals: Enable @ Disable

Admin State: @ Enable () Disable

Directory Type: @ Active Directory Domino () Other
Domain: govt.mds.local

Note: The light gray text is default text, and your own directory URL should be entered.
b. Directory Configuration—QOUs (organizational units):

Figure 2-14 LDAP OUs

New LDAP Setting
Directory Configuration - OUs
QU Base DN: dc=govt,dc=mds,dc=local
OU Search Filter: (| {objectClass=organizationalUnit){objectClass=container))
c. Directory Configuration—Users:
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Figure 2-15 LDAP User Configuration

New LDAP Setting

Directory Configuration - Users

User Base DN: de=govt,dc=mds,dc=local
Search Filter: (& objectClass=user)(objectClass=person))
Search Scope: All Levels

First Mame: givenMame

Last Name: 5N

User ID: sAMAccountName

Email: mail

Display Name: displayName
Distinguished Name: distinguishedMame

User Principal Mame: userPrincipalName

Locale: c

d. Directory Configuration—Groups:

Figure 2-16 LDAP Group Configuration

New LDAP Setting

Directory Configuration - Groups

User Group Base DN: de=govt,dc=mds,dc=Ilocal
Search Filter: (objectClass=group)
Search Scope : All Levels

User Group Name: cn

Membership Attribute: member

Member Of Attribute: memberOf

Custom Attribute-1:
Custom Attribute-2:
Custom Attribute-3:
Custom Attribute-4:
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e. LDAP Groups:

i. Asa preparatory step, we used Active Directory Users and Computers to create
a new security group for mobile-authorized users on the Domain Controller for
the govt.mds.local domain. In our example, this group is named Mobile Users.

ii. Inthe search bar, enter the name of the LDAP group for mobile-authorized us-
ers.

iii. Select the magnifying glass button; the group name should be added to the
Available list.

iv. Inthe Available list box:
1) Select the Mobile Users list item.

2) Select the right-arrow button; the Mobile Users list item should move to
the Selected list box.

Figure 2-17 Selected LDAP Group

New LDAP Setting
LDAP Groups Select LDAP groups that will be used in the system.

Available | Search by LDAP Groups L Selectad

Mobile Users

v. Inthe Selected list:
1) Select the default Users group list item.

2) Select the left-arrow button; the Users list item should move to the Availa-
ble list box.

f. Custom Settings: Custom settings were not specified.

g. Advanced Options: Advanced options were configured as shown in Figure 2-18.
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Figure 2-18 LDAP Advanced Options

New LDAP Setting
¥ Advanced Options
Authentication Method: @ Bind (Default) ) Kerberos v5 (SASL)
Authentication User ID User DN v
Format:
Group Member Format: DN w
Quality of Protection: Authentication only w

[~ Use Client TLS Certificate

[] Enable Detailed Debug

Additiontal
INDI Context Properties:

Note: In our lab environment, we did not enable stronger Quality of Protection or enable the Use of
Client Transport Layer Security Certificate or Request Mutual Authentication features. However, we
recommend that implementers consider using those additional mechanisms to secure communication
with the LDAP server.

2. From Steps 19 through 21 from the Mobilelron guide, we tested that Mobilelron can suc-
cessfully query LDAP for Derived Personal Identity Verification Credential (DPC) Users.

a. Inthe New LDAP Setting dialogue, click the Test button to open the LDAP Test dialogue.

b. Inthe LDAP Test dialogue, enter a User ID for a member of the DPC Users group, then
click the Submit button. A member of the Mobile Users group in our environment is
gema.
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Figure 2-19 Testing LDAP Configuration

LDAP Test

User ID:
Group ID:

I e

c. The LDAP Test dialogue indicates the query was successful:

Figure 2-20 LDAP Test Result

LDAP Test %)

Found 1 user with the user query ‘gema’

First Name : gema

Last Mame :

User 1D : gema

Email

Display Name : gema

Principal Name : gema@govt.mds.local
Locale

Custom 1

Custom 2

Custom 3

Custom 4 :

Distinguished Mame : CN=gema,CN=Users,DC=govt,DC=mds,DC=local
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2.4.5 Create a Mobile Users Label

Mobilelron uses labels to link policies and device configurations with users and mobile devices. Creating
a unique label for each category of authorized mobile user allows mobile device administrators to apply
a consistent set of controls applicable to users with a common mobile use case. Our limited usage
scenario only required a single Mobilelron label to be created.

1. Inthe Mobilelron Core Admin Portal, navigate to Devices & Users > Labels.
2. Select Add Label.

Figure 2-21 Mobilelron Device Labels

Dashboard Devices & Users Admin  Apps Policies & Configs Services Settings Logs

Devices Users Labels ActiveSync Apple DEP Apple Education
Add Label
NAME 4 | DESCRIPTION TYPE CRITERIA SPACE VIEW DE...
AFW Android for Work - enter...  Filter ("common.platform™ = "android" and "android.afw_cap...  Global 10
All-Smartphones Label for all devices irre...  Filter "common.retired"=false Global 16

3. Inthe Name field, enter a unique name for this label (Mobile Users in this example).
4. In the Description field, enter a meaningful description to help others identify its purpose.
5. Under the Criteria section:
a. Inthe blank rule:
i. Inthe Field drop-down menu, select User > LDAP > Groups > Name.

ii. Inthe Value drop-down menu, select the Active Directory group created to sup-
port mobile user policies (named Mobile User in this example).

b. Select the plus sign icon to add a blank rule.
c. Inthe newly created blank rule:
i. Inthe Field drop-down menu, select Common > Platform.

ii. Inthe Value drop-down menu, select Android.
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Figure 2-22 Adding a Device Label

Add Label x
Name IMobiIe Users
Description | Applies to users authorized to use mobile devices to access sensitive enterprise resources.
Type O Manual @ Filter
Criteria
All of the following rules are true
Name 22 Equals v Mobile Users v e e
Platform v |Equals ~ | | Android o+ X -]
o "user.ldap.groups.name” = "Mobile Users" AND "common.platform® = "Android”
d. The list of matching devices appears below the specified criteria.
e. Select Save.
Figure 2-23 Device Label Matches
Q "userldap.groups.name” = "Mobile Users" AND "common._platform® = "Android" Re
Exclude retired devices from search results
3 matching devices
DISPLAY NAME CURRENT PHONE NUMBER MODEL STATUS
sallie 1234567890 Pending
jason FDA Pending
gema FDA Pending
6. Navigate to Devices & Users > Labels to confirm the label was successfully created.
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Figure 2-24 Mobilelron Label List

Dashboard  Devices & Users Admin Apps Policies & Configs  Services Settings Logs

Devices Users Labels ActiveSync Apple DEP Apple Education

Add Label
NAME - | DESCRIPTION TYPE CRITERIA SPACE VIEW DE...
macOs Label for all macOS De... Filter "common.platform”="mac0S" AND "common.retired"=...  Global 0
Mobile Users Label for users authoriz. .. Filter ("user.|dap.groups.name" = "Mobile Users" AND "com...  Global 3
MTP - Deactivated Device lifecycle: deactiv...  Manual Global 0

2.5 Integration of Palo Alto Networks GlobalProtect with Mobilelron

The following steps detail how to integrate Mobilelron Core, Microsoft Certificate Authority (CA), and
Palo Alto Networks GlobalProtect to allow mobile users to authenticate to the GlobalProtect gateway
using user-aware device certificates issued to mobile devices by Microsoft CA during enrollment with
Mobilelron Core.

2.5.1 Mobilelron Configuration

The following steps create the Mobilelron Core configurations necessary to support integration with
Palo Alto Networks GlobalProtect and Microsoft CA.

2.5.1.1 Create Simple Certificate Enrollment Protocol (SCEP) Configuration

1. Inthe Mobilelron Admin Portal, navigate to Policies & Configs > Configurations.

2. Select Add New > Certificate Enrollment > SCEP; the New SCEP Configuration Enrollment
Setting dialogue will open.

3. Inthe New SCEP Certificate Enrollment Setting dialogue:
a. For the Name field, enter a unique name to identify this configuration.
b. Enable the Device Certificate option.
c. Inthe URL field, enter the URL where SCEP is hosted within your environment.

d. Inthe CA-ldentifier (ID) field, enter the subject name of the Microsoft CA that will issue
the device certificates.

e. Inthe Subject drop-down menu, select SDEVICE_IMEIS.
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Figure 2-25 Mobilelron SCEP Configuration

New SCEFP Certificate Enrollment Setting

Name | Internal_Microsoft_GA

Description | Issues local CA device certificates to enrolled clevioes] |

@ Centralized @ 0 Decentralized @
[ store keys on core 0 Proxy requests through Core
) User Certificate @ Device Certificate

URL Ihttp:.-"fndes.govt.mds.Iocalfcenswfmscepf

ChA-ldentifier | SubCA

Subject | CN=SDEVICE_IMEI$ v
Subject Common Name | yone =
Type
Key Usage Signing Encryption
Key Type |RSA v 0O
Key Length | 2048 v O

i

f. In the Fingerprint field, enter the fingerprint of the Microsoft CA that will issue the de-

vice certificates.

g. For the Challenge Type drop-down menu, select Microsoft SCEP.

h. Below the Subject Alternative Names list box, select Add; a new list item appears.

i. Forthe new listitem:
i. Forthe Type drop-down menu, select NT Principal Name.

ii. Forthe Value drop-down menu, select SUSER_UPNS.

j.  Click Issue Test Certificate; the Certificate dialogue should indicate success.
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Figure 2-26 Test SCEP Certificate Configuration

CSR Signature Algorithm | SHA384 ~ 0O
Finger Print | 098A256ACOCO38A7ACE9C103EEB202D7
Challenge Type | Microsoft SCEP v
Challenge URL I http://ndes.govt.mds.local/certsrv/mscep_adrm
User Name | NDES

Challenge Change

Subject Alternative Names
TYPE VALUE i
NT Principal Name FUSER_UPNS

Issue Test Cortificate LI J

k. Inthe Certificate dialogue, click OK.

Cancel

Save
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Figure 2-27 Test SCEP Certificate

Certificate b 4
Successfully issued a test certificate for the provided configuration.

[

[
Version: V3
Subject: CN=test123-device-imei, OU=appSetting:[CONSUMER_UUID]
Signature Algorithm: SHA256withRSA, OID = 1.2.840.113548.1.1.11

Key: Sun RSA public key, 2048 bits

modulus:
2192049853455598454992140409362 1229496439507 3575552000958056388518500839460553960849542968300555157597499520033
167276834480002365910855283668384991357741105701816908182572320641459438792215284671475803235992515887481195282
2474782833881412239258042742487608016382200209391628693134114927134014914993104404059261 7532545304 7697352695285
1579149221 34065835650942638552140403653143011296400114537483963495813517437574570475146271668191885805804116457
142457564356427411004500507794435128602887 T60885625261284062725191550472209756464 737799209855349460145969923071
67016809618532083319934630152274538180779566823493351991026773

public exponent: 65537

Validity: [From: Tue Oct 02 18:54:36 UTC 2018,

To: Thu Oct 01 18:54:36 UTC 2020]
Issuer: CN=SUB-CA, DC=govt, DC=mds, DC=local
SerialNumber: [ 6000000 7e104240 e1eBeleb 14000000 00007e]

Certificate Extensions: 9

[1]: Objectld: 1.3.6.1.4.1.311.21.10 Criticality=false

Extension unknown: DER encoded OCTET string =

0000: 04 40 30 3E 30 0A 06 08 2B 06 01 05 05 07 03 04 .@0>0...+.......
0010: 30 DA06 0B 2B 06 01 05 0507 03 01 30 0C 06 0A O..4......0..
0020:2B0601040182370A 0304 300A06082B06 +...7..0..+.
0030:010505070302300A 06082BO601050508 ....0..+....
0040: 02 02 -

4. Click Save.

2.5.1.2 Create Palo Alto Networks GlobalProtect Configuration

The GlobalProtect configuration instructs the mobile client to use the provisioned device certificate and
to automatically connect to the correct VPN URL; mobile users will not need to manually configure the
application. The following steps will create the GlobalProtect configuration.

1. Inthe Mobilelron Admin Portal, navigate to Policies & Configs > Configurations.
2. Select Add New > VPN; the Add VPN Setting dialogue will appear.
3. Inthe Add VPN Setting dialogue:

a. Inthe Name field, enter a unique name to identify this VPN setting.

b. Inthe Connection Type drop-down menu, select Palo Alto Networks GlobalProtect.
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c. Inthe Server field, enter the fully qualified domain name (FQDN) of your Palo Alto Net-

works appliance; our sample implementation uses vpn.govt.mdse.nccoe.org.

d. For the User Authentication drop-down menu, select certificate.

e. For the Identity Certificate drop-down menu, select the SCEP enrollment profile created

in the previous section.
f. Click Save.

Figure 2-28 Mobilelron VPN Configuration

Add VPN Setting )(1
Name | GlobalProtect VPN
Description | Allows devices to authenticate to the GlobalProtect VPN
Connection Type | Palo Alto Networks GlobalProtect ~ 0
Server I\rpn.gmrt.mclse.ncnae.arg
Proxy  None v O
Username I$USEHID$ i ]
User Authentication | Certificate v
Password | $PASSWORDS (i ]
Identity Certificate IInternaI_Micmsuﬁ_C.A v
[ vPNonDemand @
Per-app VPN () ves @ No O License Required
¥ Safari Domains (i0S7 and later; macOS 10.11 and later)
If the server ends with one of these domain names, the VPN is started automatically.
SAFARI NNMAIN NFSCRIPTINN
Cancel Save
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2.5.2 Basic Palo Alto Networks Configuration

During basic configuration, internet protocol (IP) addresses are assigned to the management interface,
domain name system (DNS), and network time protocol (NTP). The management interface allows the
administrator to configure and implement security rules through this interface.

2.5.2.1 Configure Management Interface
The following steps will configure the Palo Alto Networks appliance management interface.
1. Inthe Palo Alto Networks portal, navigate to Device > Setup > Interfaces.

2. Onthe Interfaces tab, enable the Management option; the Management Interface Setting
page opens.

Figure 2-29 Palo Alto Networks Management Interface Enabled

paloalto

HETWIRKE

Dashboard ACC Monitor Policies Objects Network

/4 Setup B
EiHigh Availability

By config Audit

©F Password Profiles

Q Administrators

Q)Admin Roles

%Amhenticalion Profile
ﬁﬂmﬁenticalion Seguence

User Identification

l_i;_-.'j\-’M Information Sources

Intarfaces

Management auto-negotiate

3. Onthe Management Interface Setting screen:
a. Inthe IP Address field, enter the IP address for the Palo Alto Networks appliance.
b. In the Netmask field, enter the netmask for the network.

c. Inthe Default Gateway field, enter the IP address of the router that provides the appli-
ance with access to the internet.

d. Under Administrative Management Services: Enable the Hypertext Transfer Protocol
(HTTP), Hypertext Transfer Protocol Secure (HTTPS), Secure Shell (SSH), and Ping op-
tions.

e. Click OK.
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Figure 2-30 Management Interface Configuration

Management Interface Settings
IP Type (®) static () DHCP Client
1P Address | 192.168.9.110
Netmask | 255,255.255.0
Default Gateway  192.168.9.1
1Pv6 Address/Prefix Length
Default IPv6 Gateway
Speed  auto-negotiate
MTU 1500
Administrative Management Services
[V HrTe [V HTTPS
[ Telnet [V ssH

Network Services
[] HrTP OCSP [V ping

[] snme [] user-1p

[ user-ID Syslog Listener-sSL || User-ID Syslog Listener-UDP

CAd @

4. To verify the configuration, navigate to Palo Alto Networks Portal > Dashboard; the Gen-
eral Information section should reflect the appliance’s network configuration.
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Figure 2-31 Palo Alto Networks Firewall General Information

General Information

Device Name

MGT IP Address

MGT Netmask

MGT Default Gateway
MGT IPv6 Address

MGT IPve Link Local Address
MGT IPv6 Default Gateway
MGT MAC Address

Model

Serial #

Software Version
GlobalProtect Agent
Application Version

URL Filtering Version

GlobalProtect Clientless VPN
Version

Time

Uptime

vpn
152,168.9.110
255.255.255.0

152,168.9.1

unknown
feg::a30:6bff:feec:9800/64

08:30:6b:ac:98:00
PA-220
012801032696
8.1.1

4.1.3

7999-0000
20180815.40177

0

Thu Aug 16 10:48:01 2018
14 days, 19:02:59

2.5.2.2 Configure DNS and NTP

1. Inthe Palo Alto Networks Portal, navigate to Device > Setup > Services.

2. Inthe Services tab, select the gear icon.
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Figure 2-32 Palo Alto Networks Services Configuration

paloalto

NETWORKS Dashboard ACC Monitor Palicies Objects Netwaork

gh setup Management | Operations | Services

i High Availability
5 config Audit
@ Password Profiles
Q Administrators Update Server updates.paloaltonetworks.com
&2 Admin Roles Verify Update Server Identity [/
& nuthentication Profile DN5  DNS Proxy Object
ﬁﬂuthentication Sequence DNS Proxy Mobile_Lab_DNS_Proxy
User Identification FQDM Refresh Time {sec) 1800
\fM Information Sources Proxy Server
7 [ Certificate Management Primary NTP Server Address  192.168.7.10
E‘ Certificates Primary NTP Server Authentication Type MNone
&2 Certificate Profile L Secondary NTP Server Address
§ OCSP Responder

3. On the Services > Services tab:
a. For the Primary DNS Server field, enter the primary DNS server IP address.

b. Forthe Secondary DNS Server field, enter the secondary DNS server IP address, if appli-
cable.

4. Selectthe NTP tab.
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Figure 2-33 DNS Configuration

Update Server updates.paloaltonetworks.com

B Verify Update Server Identity

DNS Settings
DNS (®) Servers () DMS Prowy Object
Primary DN5 Server | 10.5.1.1
Secondary DNS Server  192,168.7.10

FQDM Refresh Time (sec) 1800

Proxy Server
Server
Port
User
Password

Confirm Password

5. On the NTP tab:

a. Forthe Primary NTP Server > NTP Server Address field, enter the IP address of the pri-
mary NTP server to use.

b. Forthe Secondary NTP Server > NTP Server Address field, enter the IP address of the
backup NTP server to use, if applicable.

6. Click OK.
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Figure 2-34 NTP Configuration

Primary NTP Server Secondary NTP Server

NTP Server Address | 192.168.7.10 NTP Server Address | 10.97.74.8

Authentication Type | None Authentication Type Mone

2.5.3 Palo Alto Networks Interfaces and Zones Configuration

Palo Alto Networks firewall model PA-220 has eight interfaces that can be configured as trusted (inside)
or untrusted (outside) interfaces. This section describes creating a zone and assigning an interface to it.

2.5.3.1 Create Ethernet Interfaces and Addresses
Our example implementation uses three interfaces:
= LAN: Orvilia’s LAN, which hosts intranet web and mail services
= DMZ: Orvilia’s DMZ network subnet, which hosts Mobilelron Core and Mobilelron Sentry

=  WAN: provides access to the internet and is the inbound interface for secure sockets layer (SSL)
VPN connections

To create and configure Ethernet interfaces:
1. Navigate to Palo Alto Networks Portal > Network > Ethernet > Interfaces > Ethernet.

Figure 2-35 Ethernet Interfaces

#2 paloalto

NETWORKS Dashboard ACC Monitor Policies Objects Device

(2as]
I “ | CEthernet | VLAN | Loopback | Tunnel
[ Zones
S5 VLANS
Hg virtual Wires
% virtual Routers Interface Interface Type I";lraur;li:emeni SI::tI:E 1P Address Virtual Router 1

.ﬁ IP3ec Tunnels
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2. Inthe Ethernet tab, select the name of the interface to configure; the Ethernet Interface

dialogue will appear.
3. Inthe Ethernet Interface dialogue:
a. Inthe Comment field, enter a description for this interface.
b. For the Interface Type drop-down menu, select Layer3.

Figure 2-36 Ethernet Interface Configuration

Ethernet Interface

Interface Name

Comment  Connected to the Lab
Interface Type Layerd K
Netfiow Profile None -

Config IPvé 6  Advanced

Assign Interface To

Security Zone -

c. Select the IPv4 tab.

d. On the IPv4 tab:
i. Inthe P list box, select Add; a blank list item appears.

ii. Inthe blank list item, select New Address; the Address dialogue appears.
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Figure 2-37 WAN Interface IPv4 Configuration

Ethernet Interface )]

Interface Name | ethemet1/1
Comment Connected to the Lab
Interface Type Layer3 bt

Netflow Profile None x

Config IPvé  IPv6 = Advanced

Type (@) Static )} PPPoE DHCP Client

iii. Inthe Address dialogue:
1) For the Name field, enter a unique name to identify this address.

2) For the Description field, enter a meaningful description of the purpose of
this address.

3) In the unnamed field following the Type drop-down menu, enter the IPv4
address that this interface will use in Classless Inter-Domain Routing nota-
tion. This example uses 10.6.1.2/24 for the WAN interface in our lab envi-
ronment.

4) Click OK.
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Figure 2-38 WAN Interface IP Address Configuration

Lab_WAN

Connected to the lab

1P Netmask v |10.6.1.2/24 Saah

Enter an [P address or a network using the slash
notaton (Ex. 192.168.80.150 or 192.168.80.0/24), You
can also enter an PG sdaress or an [Pwh sdoress with
#=s prafior (Ex. 2001:dbB:123:1::1 or

20001 il 129211/ 64

e. The address should now appear as an item in the IP list box; select OK; the Address dia-

logue closes.

Figure 2-39 Completed WAN Interface Configuration

Ethernet Interface ®

Interface Name ethemetl/1

Comment Connected to the Lab

Interface Type Layer3 b, 4
Netflow Profile None b
Config  IPv4 | IPvE  Advanced
Type (®) Static () PPPoE () DHCP Client
F 10.6.1.2/24

]
4. Click OK.

5. Repeat Steps 2 and 3 for each of the additional Ethernet/Layer3 interfaces.
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2.5.3.2 Create Security Zones

The PA Security Zone is a collection of single or multiple interfaces that have the same security rules. For
this setup, four different zones have been configured:

= Mobile_Lab_GOVT: inside (trusted) interface connecting to the government (GOVT) segment
= Mobile_Lab_DMZ: inside (trusted) interface connecting to the DMZ segment

= Mobile_Lab_WAN: outside (untrusted) interface to permit trusted inbound connections (e.g.,
Lookout cloud service) from the untrusted internet and allow internet access to on-premises
devices

= Mobile_Lab_SSLVPN: outside (untrusted) interface for VPN connections by trusted mobile
devices originating from untrusted networks (e.g., public Wi-Fi)

To configure each zone:
1. Navigate to Palo Alto Networks Portal > Network > Zones.

Figure 2-40 Security Zone List

#2 paloalto

HETWORKS Dashboard ACC Monitor Policies Objects Device

&3 Interfaces
) Zones
94 VLANS
‘ﬂ;g\-"lrtual Wires 7] Name Type Interfaces | Virtual Zone Protection Profile Packst .Buffer
&9 virtual Routers Systems Protection
@@ 1Psec Tunnels [ mobile_Lab_pMz layer3 ethemet1/2
_'I’;I DHCP [ Mobile_Lab_GOVT layers ethemetl/3
DT;_'E DN3 Proxy [ Mobile_Lab_S5LVPN layer3 tunnel.1
¥ @ GlobalProtect [ mobile_lab_wan layer3 ethernet1/1
% Portals
e; Gateways

2. Inthe Zones pane, select Add; the Zones page opens.
3. Onthe Zones page:
a. For the Name field, provide a unique name for the zone.
b. For the Type drop-down menu, select Layer 3.
c. Under Interfaces, select Add; a blank drop-down menu appears.

d. Inthe drop-down menu, select the interface to assign to this zone; this example shows
selection of ethernet 1/3, which is associated with the LAN interface.
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e. Click OK.

Figure 2-41 LAN Security Zone Configuration

Name | Mobile_Lab_GOVT | User 1dentification ACL

Log Setting  Mone || Enable User Identification

Type | Layer3 Sl W indude List

¥ -

| ethernet1/3
i loopback
itunn.-.!
|vian -

Usars from these addresses)subnets will be identifiad,

o @ l.;&dudeLisl'
== ”‘E‘E‘B |

Zone Protection

Zone Protection Profile Mone

|| Enable Packet Buffer Protection BAdd 8

Usars from these addresses!subners will not be dencfied.

f. Repeat Step b for each zone.

2.5.4 Configure Router

Palo Alto Networks uses a virtual router to emulate physical connectivity between interfaces in different
zones. To permit systems to reach systems in other zones, the following steps will create a virtual router
and add interfaces to it. The router also sets which of these interfaces will act as the local gateway to
the internet.

1. Inthe Palo Alto Networks Portal, navigate to Network > Virtual Routers.

2. Below the details pane, select Add; the Virtual Router form opens.
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3. Inthe Virtual Router form, on the Router Settings tab:
a. For the Name field, enter a unique name to identify this router.
b. On the Router Settings > General tab:
i. Under the Interfaces list box, select Add; a new list item appears.
ii. Inthe new list item drop-down menu, select an existing interface.
iii. Repeat Steps 3a and 3b to add all existing interfaces to this router.
4. Select the Static Routes tab.
5. On the Static Routes > IPv4 tab:
a. Below the list box, select Add; the Virtual Router - Static Route - IPv4 form opens.
b. In the Virtual Router—Static Route—IPv4 form:
i. Forthe Name field, enter a unique name to identify this route.
ii. For the Destination field, enter 0.0.0.0/0.

iii. For the Interface drop-down menu, select the interface that provides access to
the internet.

iv. For the Next Hop drop-down menu, select IP Address.

v. Inthe field below Next Hop, enter the IP address of the gateway that provides
access to the internet.

vi. Click OK.
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Figure 2-42 Virtual Router Configuration

Virtual Router - Static Route - [Pvd

Mame WWan Default Route
Destination | 0.0.0.0/0
Interface  ethernetlf1

Mext Hop 1P Address

10.6.1]

Admin Distance
Metric 10
Route Table Unicast

Path Monitoring

Failure Conditon () Any i Preemptive Hold Time (min} 2

6. Click OK.
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Figure 2-43 Virtual Router General Settings

Virtual Router - Mobile Lab VR

Router Settings Name me__Lab_‘{E

Static Routes General |~ ECMP

[[] ethemet1/1 Static | 10
[F] ethemet1/2 Static IPv6 | 10
[F] ethemet1/3

s OSPF Int | 30
[ tunmel.1
OSPF Ext | 110

OSPFv3 Int | 30

OSPFv3 Ext | 110
IBGP 200
EBGP |20

RIP

2.5.5 Configure Tunnel Interface

The SSL VPN uses a tunnel interface to secure traffic from the external zone to the internal zone where
organizational resources available to mobile users are maintained. To configure the tunnel interface:

1. Navigate to Palo Alto Networks Portal > Network > Ethernet > Interfaces > Tunnel.
2. Below the details pane, select Add; the Tunnel Interface form opens.
3. Inthe Tunnel Interface form on the Config tab:

a. Inthe Assign Interface To section:

i. Forthe Virtual Router drop-down menu, select the virtual router created in the
previous section.

ii. For the Security Zone drop-down menu, select the security zone created for the
SSL VPN.

b. Click OK.
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Figure 2-44 SSL VPN Tunnel Interface

Tunnel Interface

Interface Name

Comment  UsedByMobileUsers
Netflow Profile  None

Confiy  IPv4  IPVv6  Advanced

Assign Interface To
Virtual Router | Mobile_Lab_VR

Security Zone | Mobile_Lab_SSLVPN

2.5.6 Configure Applications and Security Policies

Security policies work similarly to firewall rules; they block or allow traffic between defined zones
identified by a source, destination, and application(s) (contextually, Palo Alto Networks’ objects define
network protocols and ports). Palo Alto Networks has built-in applications for a large number of
standard and well-known protocols and ports (e.g., LDAP and Secure Shell), but we defined custom
applications for Mobilelron-specific traffic.

2.5.6.1 Configure Applications

The following steps will create an application:

1. Inthe Palo Alto Networks Portal, navigate to Objects > Applications.
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Figure 2-45 Application Categories

paloalto

HETWORKS Dashboard ACC Monitor Palicies Netwaork Device

% addresses N s [ T oo

L'_ja Address Groups Technology
Q Regions ) : .

— 823 business-systems 51 audio-streaming « | 1041 browser-based
Applications 614 collaboration 22 auth-service 1107 dient-sarver
Applicaﬁon Groups 445 general-internet 37 database 365 network-protocel
[ Application Filters 293 media 82 email 134 peer-to-peer
# Services 472 networking 64 encrypted-tunnel
@@Sewice Groups 2 unknown 48 erp-crm
QTags 315 file-sharing

7 @, GlobalProtect &4 gaming
!j HIP Objects 173 general-business -

2. On the Applications screen:

3. Select Add; the Application form opens.

4. On the Application > Configuration screen:
a. Inthe General > Name field, provide a unique name to identify this application.
b. Inthe General > Description field, enter a meaningful description of its purpose.

c. Forthe Properties > Category drop-down menu, select a category appropriate to your
environment; our sample implementation uses networking.

d. For the Properties > Subcategory drop-down menu, select a subcategory appropriate to
your environment; our sample implementation uses infrastructure.

e. Forthe Properties > Technology drop-down menu, select a technology appropriate to
your environment; our sample implementation uses client-server.
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Figure 2-46 Mobilelron Core Palo Alto Networks Application Configuration

Application

General
Name Maobilelron3997

Description | Allows mobile devices to check-in with MobileIron Core

Properties
Category networking Subcategory  infrastructure Technology | dient-server

Parent App  None Risk 1

Characteristics

I:i Capable of File Transfer |:i Has Known Vulnerabilities i:| Pervasive

[ "] Excessive Bandwidth Use [ ] used by Malware [ Prone to Misuse

[ | Tunnels Other Applications |_| Evasive || continue scanning for other Applications

5. Select the Advanced tab.
6. On the Application > Advanced screen:
a. Select Defaults > Port.
b. Under the Ports list box, select Add; a blank list item appears.

c. Inthe blank list item, enter the port number used by the application; this example uses
9997.

7. Click OK.
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Figure 2-47 Mobilelron Application Port Configuration

Application
Configuration

Defaults

(®) Port () 1P Protocol () ICMPType () ICMPS Type () Mone

9997

3 Add @ Delete

Entar sach port in the form of [repjudp]{dynamac|0-65535] Examiple: top/dynamic or wudp/32
Timeouts
Timeout +6 TCP Timeout UDP Timeout

TCP Haif Cosed 604 TCP Time Wait

Scanning

[ ] File Types - [ ] pata Patterns

8. Repeat Steps 2 through 7 with the following modifications to create an application for the
Mobilelron Core system administration console:

a. Configuration > General > Name is Mobilelron8443.
b. Configuration > Properties > Category is business-systems.
c. Configuration > Properties > Subcategory is management.

d. Advanced > Defaults > Port first entry is 8443.

2.5.6.2 Configure Security Policies

Security policies allow or explicitly deny communication within, between, or (externally) to or from Palo
Alto Networks zones. For this sample implementation, several security policies were created to support
communication by other components of the architecture. The first subsection covers the steps to create
a given security policy. The second subsection provides a table illustrating the security policies we used;
these policies would need to be adapted to host names and IP addresses specific to your network
infrastructure.
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2.5.6.2.1 Create Security Policies
To create a security policy:

1. Inthe Palo Alto Networks Portal, navigate to Policies > Security.
2. Select Add; the Security Policy Rule form will open.
3. Inthe Security Policy Rule form:

a. Inthe Name field, enter a unique name for this security rule.

b. Forthe Rule Type drop-down menu, select the scope of the rule, following the guidance
provided in the Palo Alto Networks documentation for creating firewall rules.

Figure 2-48 DMZ Access to Mobilelron Firewall Rule Configuration

Security Policy Rule

General | Source | User | Destination | Application | Service/URL Category | Actions

Name DMZAccessVirtuallPCore
Rule Type universal (default)

Description

4. Select the Source tab.
5. Onthe Source tab:
a. If the security rule applies to a specific source zone:
i. Under the Source Zone list box, select Add; a new entry appears in the list box.
ii. Forthe new list item, select the source zone for this rule.

b. If the rule applies to only specific source IP addresses:
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i. Under the Source Address list box, select Add; a new list item appears.
ii. Forthe new list item, select the source address for this rule.

Figure 2-49 DMZ Access to Mobilelron Security Rule Source Zone Configuration

Security Policy Rule

B Any

M| source Zone

[E1 gen Mobile_lab_wWAN

6. Select the Destination tab.
7. On the Destination tab:
a. If the security rule applies to a specific destination zone:

i. Under the Destination Zone list box, select Add; a new destination list item ap-
pears.

ii. Forthe new Source Zone list item, select the destination zone for this rule.
b. If the rule applies to only specific destination IP addresses:
i. Under the Destination Address list box, select Add; a new list item appears.

ii. Forthe new list item, select the destination address for this rule.

NIST SP 1800-21C: Mobile Device Security: Corporate-Owned Personally-Enabled a4



"TZ-008T"dS’ LSIN/8209°0T/810"10p//:d11y :wiouy 84eYd 4o 3344 3|qejieAe s| uonedlqnd siyL

Figure 2-50 DMZ Access to Mobilelron Security Rule Destination Address Configuration

Security Policy Rule

[ | Destination Zone ‘. Destination Address
[ & 10.6.1.120

8. Select the Application tab.
9. On the Application tab:
a. Under the Applications list box, select Add; a new list item appears.

b. Forthe new Applications list item, select the application representing the protocol and
port combination of the traffic to control.

c. Repeat Steps 9a and 9b for each application involving the same source and destination
that would also have its traffic allowed or explicitly blocked (if otherwise allowed by a
more permissive security rule).
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Figure 2-51 DMZ Access to Mobilelron Security Rule Application Protocol Configuration

Security Policy Rule
User | Destination | Application | Service/URL Category | Actions

[ & ping

[ g sl
] web-browsing

10. Select the Actions tab.

11. On the Actions tab: Unless explicitly blocking traffic permitted by a more permissive secu-
rity rule, ensure that the Action Setting > Action drop-down menu is set to Allow.
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Figure 2-52 DMZ Access to Mobilelron Security Rule Action Configuration

Security Policy Rule

Service/URL Category | Actions

Action Setting Log Setting
Action  Allow v [+ Log at Session Start
| send 1CMP Unreachable [ Log at Session End
Log Forwarding None b
Other Settings
Profile Setting Schedule None st
Profile Type None b QoS Marking | None v
|:| Disable Server Response Inspection

12. Click OK.

2.5.6.2.2 Implemented Security Policies
The implemented security policies are provided in Table 2-1, Table 2-2, and Table 2-3. Configuration
options that aren’t shown were left as their default values.

Table 2-1 Implemented Security Policies

Name Tags Type Source Zone Source Address
DMZAccessVirtuallPCore none universal Mobile_lab_WAN | any
CoretoAppleSrvs none universal Mobile_Lab DMZ | MI_Core
AdminAccessToMI none interzone | Mobile_Lab_GOVT | MDS.govt.admin
AppthorityConnectorAccessToMI- | none interzone | Mobile_Lab_GOVT | govt.appthority
Core

MICoreObtainDeviceCERT none interzone | Mobile_Lab DMZ | MI_Core
MiICoreAccessDNS none interzone | Mobile_Lab DMZ | MI_Core
MICoreRelaySMSNotifications none interzone | Mobile_Lab_DMZ | MI_Core
MICoreSyncLDAP none interzone | Mobile_Lab_DMZ | MI_Core
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Table 2-2 Implemented Security Policies

Source Source Destination Zone  Destination
User Host Address
Infor-
mation
Protocol
Profile
DMZAccessVirtuallPCore any any any 10.6.1.120
CoretoAppleSrvs any any any 17.0.0.0/8
AdminAccessToMI any any Mobile_Lab_DMZ | MI_Core;MI_Sentry
AppthorityConnectorAccessToMI- | any any Mobile_Lab_DMZ | MI_Core
Core
MICoreObtainDeviceCERT any any Mobile_Lab_GOVT | SCEP_server
MICoreAccessDNS any any Mobile_Lab_GOVT | DNS_Server
MICoreRelaySMSNotifications any any Mobile_Lab_GOVT | SMTP_Relay
MICoreSyncLDAP any any Mobile_Lab_GOVT | LDAP_Server

Table 2-3 Implemented Security Policies

Name Application Service Action Profile | Options

dns;ping;ssl;web | any allow | none none
DMZAccessVirtuallPCore -browsing
CoretoAppleSrvs any any allow | none none

AdminAccessMI; | any allow | none none
AdminAccessToMI ssh;ssl

AdminAccessMI; | any allow | none none
AppthorityConnectorAccessToMI- | ssl;web-
Core browsing

scep;web- application- allow | none none
MICoreObtainDeviceCERT browsing default

dns application- allow | none none
MICoreAccessDNS default

smtp application- allow | none none
MICoreRelaySMSNotifications default

Idap application- allow | none none
MICoreSyncLDAP default
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2.5.7 Network Address Translation

To allow communication with external networks over the internet, the appliance also needs to be
configured with Network Address Translation (NAT) rules. To configure NAT:

1. Inthe Palo Alto Networks Portal, navigate to Policies > NAT.
2. Below the details pane, select Add; the NAT Policy Rule form opens.
3. Inthe NAT Policy Rule form, on the General tab:

a. Inthe Name field, provide a unique name for this NAT policy rule.

b. Ensure the NAT Type drop-down menu is set to ipv4.

Figure 2-53 Outbound NAT Rule

NAT Policy Rule

Original Packet

Name | GOVT to Outside|

Description

Tags v

NAT Type ipvd

4. Select the Original Packet tab.

5. On the Original Packet tab:
a. Under the Source Zone list box, select Add; a new Source Zone list item appears.

b. For the new Source Zone list item, select the zone that represents your LAN subnet; in
this sample implementation, that is Mobile_Lab_GOVT.

c. Repeat Steps 5a and 5b to add the zone that represents your DMZ; in this sample imple-
mentation, that is Mobile_Lab_DMZ.

d. Repeat Steps 5a and 5b to add the zone that represents your SSL VPN; in this sample im-
plementation, that is Mobile_Lab_SSLVPN.

e. For the Destination Zone drop-down menu, select the zone that represents the inter-
net; in this sample implementation, that is Mobile_lab_WAN.
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f.  For the Destination Interface, select the adapter that is physically connected to the
same subnet as your internet gateway; in this sample implementation, that is ether-
netl/1.

g. Under the Source Address list box, select Add; a new Source Address list item appears.

h. For the new Source Address list item, select the address that represents the subnet (IP
address range) for the LAN.

i. Repeat Steps 5f and 5g to add the address representing the DMZ subnet.

j.  Repeat Steps 5f and 5g to add the address representing the SSL VPN subnet.

Figure 2-54 Outbound NAT Original Packet Configuration

NAT Policy Rule

Original Packet

Destination Zone

[ Any i Any
Maobilz_lab_WAN -
B | source Zone == [ | source Address 8 | pestination Address

[E] px mobile Lab DMz [[] §§ oMz Segment
[ [ Mobile_Lab_GOVT [ E_‘ GOVT Segment
] Destination Interface F %
Maobile_Lab_SSLVPN ¥ VPN Segment
M - ethernet1/1 w 3! E
Senvice

any

w

6. Select the Translated Packet tab.

7. On the Translated Packet tab, under Source Address Translation:
a. Forthe Translation Type drop-down menu, select Dynamic IP and Port.
b. Forthe Address Type drop-down menu, select Interface Address.
c. Forthe Interface drop-down menu, select the same interface selected in Step 5e.

d. For the IP Address drop-down menu, select the IPv4 address on the same subnet as
your internet gateway.
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Figure 2-55 Outbound NAT Translated Packet Configuration

NAT Policy Rule

Translated Packet

Source Address Translation Destination Address Translation
Translation Type Dynamic IP And Port Translation Type None
Address Type Interface Address
Interface  ethemnet1/1
IP Address | 10.6.1.2/24

8. Select OK.

2.5.8 Configure SSL VPN

The SSL VPN enables remote mobile device users to create an encrypted connection to the enterprise
from unencrypted networks (e.g., public Wi-Fi hot spots).

2.5.8.1 Configure End-User Authentication

The following steps establish the integrations and configurations related to mobile user identification
and authentication.

2.5.8.1.1 Configured Server Profile
The following steps integrate this appliance with Microsoft Active Directory Domain Services to manage
mobile user permissions via AD groups and roles.

1. Inthe Palo Alto Networks Portal, navigate to Devices > Server Profiles > LDAP.
2. Below the details pane, select Add; the LDAP Server Profile form opens.
3. Inthe LDAP Server Profile form:
a. Inthe Profile Name field, enter a unique name to identify this profile.
b. Under the Service List box, select Add; a new Server List item appears.
c. Inthe new Service List item:
i. Inthe Name column, enter a name to identify the server.

ii. Inthe LDAP Server column, enter the IP address of the LDAP server.
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iii. The value in the Port column defaults to 389; change this if your LDAP server
communicates over a different port number.

iv. Repeat Steps 3ci through 3ciii for each LDAP server that you intend to use.
d. Under Server Settings:
i. Inthe Type drop-down menu, select active-directory.

ii. Inthe Base DN drop-down menu, select the DN for your Active Directory domain
users who will use the SSL VPN.

iii. Inthe Bind DN field, enter the Active Directory domain user account that will au-
thenticate to LDAP to perform queries.

iv. Inthe Password field, enter the password for the Active Directory user account
specified in the previous step.

v. Inthe Confirm Password field, reenter the password entered in the previous step.

4. Click OK.

Figure 2-56 LDAP Profile

LDAP Server Profile

Profile Mame | Mobile_Lab_LDAP-Profile

D Administrator Use Only

Server List Server Settings
Name LDAP Server Port Type | active-directory -
AD 192.168.7.10 389 Base DN | DC=govt,DC=mds,DC=local -

Bind DN | palo.altto@govt. mds.local
Password ssssssss

Confirm Password | eeesssss

CAd @

Enter the IP address or FQDN of the LDAP sarver

Bind Timeout | 30

Search Timeout | 30

Retry Interval | &0
@ Require 55L/TLS secured connection

D Verify Server Certificate for SSL sessions
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2.5.8.2 Configure Authentication Profile

1. Inthe Palo Alto Networks Portal, navigate to Device > Authentication Profile.
2. Under the details pane, select Add; the Authentication Profile form opens.
3. In the Authentication Profile form:
a. Inthe Name field, provide a unique name to identify this authentication profile.
b. On the Authentication tab:
i. Forthe Type drop-down menu, select LDAP.

ii. Forthe Server Profile drop-down menu, select the name of the LDAP Server Pro-
file created in the previous section.

iii. For the Login Attribute field, enter userPrincipalName.

iv. For the User Domain, enter the name of your enterprise domain; our sample im-
plementation uses govt.
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Figure 2-57 Authentication Profile

Authentication Profile

Authentication | Factors = Advanced

Type | LDAP
Server Profile | Mobile_Lab_LDAP-Profile
Login Attribute | userPrincipalName

Password Expiry Warning |7

Mumber of days prior to waming a user about password expiry

User Domain | govt

Username Modifier | SSUSERIMPUTS:
Single Sign On
Kerberos Realm

Kerberos Keytab | Click “Impor

c. Select the Advanced tab.
d. On the Advanced tab:
i. Under the Allow List box, select Add; this creates a new list item.
ii. Inthe new list item, select the Active Directory group for your mobile users.

iii. Repeat Steps 3di and 3dii for any additional groups that should authenticate to
the SSL VPN.

e. Click OK.

NIST SP 1800-21C: Mobile Device Security: Corporate-Owned Personally-Enabled

54



“TZ-008T"dS" LSIN/8Z09°0T/810°10p//:dny :wioly 381eY JO 3314 3|ge|IeAR SI uoiedlgnd SIyL

Figure 2-58 Advanced Authentication Profile Settings

Authentication Profile
Name Mobile_Lab_Auwth-Profile
Authentication Factors  Advanced
Allow List

-
[ g cn=domain admins,cn=users,dc=govt,dc=mds,dc=local

[ g cn=maobile users,cn=users,dc=govt,dc=mds,dc=local

Cadd Q

Account Lockout
Failed Attempts | [

Lockout Time {min) |0

2.5.8.3 Configure User Identification

1. Inthe Palo Alto Networks Portal, navigate to Device & User Identification.
2. Inthe details pane, select the Group Mapping Settings tab.
3. Below the details pane, select Add. The Group Mapping form opens.
4. Inthe Group Mapping form:
a. Inthe Name field, enter a unique name to identify this group mapping.

b. Inthe Server Profile tab:
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i. Forthe Server Profile drop-down menu, select the LDAP Server Profile created
previously.

ii. For Domain Setting > User Domain, enter the name of your Active Directory do-
main; this sample implementation uses govt.

Figure 2-59 LDAP Group Mapping

Group Mapping

Name | Mobile_Lab_User 10|

Server Profle Userand Group Attributes ~ Group Include List ~ Custom Group

Server Profile | Mobile_Lab_LDAP-Profile Update Interval
Diomain Setting

User Domain | govt

Group Objects
Search Filter

Object Class

User Objects
Search Filter

Object Class  person

[+ Enabled

c. Select the Group Includes List tab.
d. On the Group Includes List tab:

i. Inthe Available Groups list box, expand the Active Directory domain to reveal
configured user groups.

ii. For each Active Directory group to be included in this User Identification configu-
ration:

1) Select the Active Directory group.
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2) Select the plus icon to transfer the group to the Included Groups list box.

Figure 2-60 LDAP Group Include List

Group Mapping

Name | Mobile_Lab_User_ID

Server Profile  User and Group Atfributes ~~ Group Include List ~ Custom Group

Available Groups Included Groups

g govtimobile users
¥ ‘' cn=users - govtidomain admins
9 cn=allowed rodc password replication g

d_; cn=cdm

'3 cn=cert publishers
=

$ cn=cloneable domain controllers

$ cn=denied rodc password replication gr
9 en=dnsadmins

':B cn=dnsupdateproxy

$ cn=domain admins

g cn=domain computers

5. Select OK.

2.5.8.4 Configure Authentication Policy Rule

1. Navigate to Policies > Authentication.

2. Click Add.

3. Give the policy a name. In this implementation, Mobile_Lab_Auth_Rule was used.
4. Click Source.

5. Under Source Zone, click Add. Select the SSL VPN zone.

6. Under Source Zone, click Add. Select the WAN zone.
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Figure 2-61 Authentication Policy Source Zones

Authentication Policy Rule

[E] peg Mobile_Lab_SSLVPN
[C] peg Mobile_lab_WAN

o o

|:]. Negate

7. Click Destination.

8. Under Destination Zone, click Add.

9. Select the LAN zone (in this implementation, Mobile_Lab_GOVT).
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Figure 2-62 Authentication Policy Destination Zones

Authentication Policy Rule

Destination Zone B | Destination Address

[F] g Mobile_Lab_GOWT

D Megate

10.

11.

12.

13.

14,

15.

16.

17.

Click Service/URL Category.

Under service, click Add.

Select service-http.

Under service, click Add.

Select service-https.

Click Actions.

Next to Authentication Enforcement, select default-web-form.

Leave Timeout and Log Settings as their default values.
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Figure 2-63 Authentication Profile Actions

Authentication Policy Rule

Destination | Service/URL Category

Authentication Enforcement | default-web-form
Timeout {min} | &0

Log Settings

D Log Authentication Timeouts

Log Forwarding | Mone

18. Click OK and commit the changes.

2.5.9 Import Certificates

Certificates need to be imported into the appliance to configure certificate profiles that will affect how
they are used in supporting communication with other systems. In particular, device certificates issued
to mobile devices will be used to identify and authenticate mobile users.

Note: The certificate private keys must be password-protected to import them into the firewall.

1. In the Palo Alto Networks Portal, navigate to Device > Certificate Management > Certifi-
cates.
2. Under the details pane, select Import; the Import Certificate form opens.

3. Inthe Import Certificate form:
a. For the Certificate Type, select Local.
b. For the Certificate Name field, enter a unique name to identify this certificate.

c. Next to the Certificate File field, Select Browse... to specify the full path to the file con-
taining the certificate.

d. For the File Format drop-down menu, select the certificate encoding appropriate to the
certificate file; this example assumes the certificate and private key are in separate files,
and select PEM. Note: The certificate’s private key must be password-protected to im-
port it into Palo Alto Networks appliances.
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e. If the certificate identifies the Palo Alto Networks appliance:
i. Enable the Import private key checkbox.

ii. Next to Key File, select Browse... to specify the full path to the file containing the
private key for the uploaded certificate.

iii. For the Passphrase field, enter the pass phrase protecting the private key.

iv. For the Confirm Passphrase field, re-enter the pass phrase protecting the private
key.

Figure 2-64 Import Mobilelron Certificate

Import Certificate

Certificate Type ® |ocal
Certificate Name vpn.govt.mdse.nccoe.org
Certificate File | C:\fakepath\cert_vpn.govt.mdse.nccoe.org.crt
File Format Base64 Encoded Certificate (PEM)
|| Private key resides on Hardware Security Module
¥y Import private key

Key File C:\fakepath\mi-sentry.govt.mdse.nccoe.org.key

F"assphrase . EEEEEEEE

Confirm Pﬂ‘iﬁphl’ﬂEE TLLITLL

f. Select OK.

4. Repeat Step 3 for each certificate to import into the Palo Alto Networks appliance. This will
include all certificates that the appliance will use to identify itself or authenticate to remote
systems, all certificates in the chain of trust for each such certificate, and any chain-of-trust
certificates supporting identity verification for remote systems to which this appliance will
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require certificate-based identification and authentication. This sample implementation
uses certificates for the following systems:

= server certificate for this appliance issued by DigiCert
= DigiCert root CA certificate

= DigiCert subordinate CA certificate

=  Microsoft CA enterprise root certificate

=  Microsoft CA enterprise subordinate CA certificate

2.5.10 Configure Certificate Profile

1. Inthe Palo Alto Networks Portal, navigate to Device > Certificate Management > Certifi-
cate Profile.

2. Under the details pane, select Add; the Certificate Profile form opens.

3. Inthe Certificate Profile form:
a. Inthe Name field, enter a unique name to identify this certificate profile.
b. Inthe Username Field drop-down menu, select Subject Alt.
c. Select the Principal Name option.

d. Inthe User Domain field, enter the Active Directory domain name for your enterprise;
this sample implementation uses govt.

e. Under the CA Certificate list box, select Add; a secondary Certificate Profile form ap-
pears.

f. In the secondary Certificate Profile form, in the CA Certificate drop-down menu, select
the Microsoft Active Directory Certificate Services root certificate uploaded in Section
2.5.9.

g. Click OK.

h. Repeat Step 3f for each intermediary certificate in the trust chain between the root cer-
tificate and the subordinate CA certificate that issues certificates to mobile devices.
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Figure 2-65 Certificate Profile

Certificate Profile

Name | Mobile_Lab_Cert_Profile

Username Field ' Subject Alt () Emaill (® Principal Name

User Domain  govt

[ nternal Root
[ Internal SubCa

Dafault OCSP URL (must start with hitpy/| or hitps/)
[] use cRL CRL Receive Timeout (sec) 5 [] Block session if certificat status is

[ use ocse OCSP Receive Timeout (sec) 5 unknown

DCSP takes precedence over CRL Certificate Status Timeout (sec) | 5 || Block session if certificate status cannot be
retrieved within timeout
|| Block session if the certificate was not
issued to the authenticating device

|| Block sessions with expired certificates

i. Click OK.
Figure 2-66 Internal Root Certificate Profile

Certificate Profile

CA Certificate  Internal Root
Default OCSP URL

OCSP Verify Certificate  None

4. Click OK.

2.5.11 Configure SSL/TLS Service Profile

The following steps will configure the SSL/TLS profile, which determines what certificates to trust when
mobile devices are connecting to the VPN and what certificate to use when establishing outbound
SSL/TLS connections.

NIST SP 1800-21C: Mobile Device Security: Corporate-Owned Personally-Enabled 63



“12-008T"dS"LSIN/8209°0T/840"10p//:d11y ;w0 981eyd 4o 994 3|qejieAe S| uonedljgnd siyL

1. Inthe Palo Alto Networks Portal, navigate to Device > Certificate Management > SSL/TLS
Service Profile.

2. Below the details pane, select Add; the SSL/TLS Service Profile form opens.
3. Inthe SSL/TLS Service Profile form:
a. Inthe Name field, enter a unique name to identify this service profile.

b. For the Certificate drop-down menu, select the certificate to use for this SSL/TLS service
profile; our sample implementation uses a client certificate obtained from a Microsoft
enterprise CA via SCEP.

c. For the Min Version drop-down menu, select TLSv1.2. For Max Version, select Max.
d. Select OK.

Figure 2-67 SSL/TLS Service Profile

SSL/TLS Service Profile

Name | SSL-TLS Profile]
Certificate  Mobile_Lab_SCEP_CERT
Protocol Settings
Min Version | TLSv1.2

Max Version Max

4. Repeat Step 3 to add an identical SSL/TLS service profile for this appliance’s server certifi-
cate issued through DigiCert.

2.5.12 URL Filtering Configuration
1. Navigate to Objects > Custom Objects > URL Category.

2. Click Add.
3. Give the category a name and description.

4. Add sites to be blocked. For this example, *.example.com was used.
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Figure 2-68 Custom URL Category

Custom URL Category ®

MName Mobile Lab URL Category

Description  Custom URL block list

o 1 item = %]

[ | sites

[ =.example.com

BAd B o~ Import L, Export

Entar one entry per row.
Each entry may be of the form www.example.com or it could have wildeards ke wwn. *.com.

5. Click OK.

6. Navigate to Objects > Security Profiles > URL Filtering.
7. Check the box next to default and click Clone.

8. Select default from the window that appears.

9. Click OK.

10. Click the newly created profile, default-1.

11. Give the newly created profile called default-1 a meaningful name and provide a descrip-

tion for the new profile.

12. Scroll to the bottom of the list. The name of the created category will be last on the list.

13. Click the option below Site Access and next to your created URL category.

14. Set the Site Access option to block.
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Figure 2-69 URL Filtering Profile

URL Filtering Profile

Mame  Mobile_Lab_URL_Filtering

Description | URL filtering profile

Categories  Ovemides  URL Filtering Settings  User Credential Detection  HTTP Header Insertion

o 67 ilems [ %}

User Credential

Site Access

Submission

o w_— -
[T training-and-toals allowr allow &
[[] translation allow allow

[ travel allow allow

[ unknowin allow allow

] weapons allow allow

[ web-advertisements allowr allow

[] web-based-email allow allow

[ wieb-hesting allow allow

[#] Mobile Lab URL Category * block block: b
¥ indicates & oustom URL category, + indicates extamnal dynamic [ist

Check URL Category

15. Click OK.

16. Navigate to Policies > Security.

17. Click the default outbound policy for the internal network (not VPN).
18. Click Actions.

19. Next to Profile Type, select Profiles.

20. Next to URL Filtering, select the newly created profile.

21. Click OK.

22. Repeat Steps 18 through 21 for the SSL VPN outbound traffic.
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Figure 2-70 URL Filtering Security Policy

Security Policy Rule

Destination | Application | Service/URL Category | Actions
Action Setting Log Setting
Action | Allow v IZ Log at Session Start
| send 1CMP Unreachable E’l Log at Session End
) = Log Forwarding None -
Profile Setting
Profile Type | Profiles v Other Settings
Antivirus | Mone v Schedule None b
vulnerability | Mone - QoS Marking None »
Protection o
| | pisable server Response Inspection
Anti-Spyware | None b
URL Filtering | Mobile_Lab_URL_Filtering W
File Blocking | Mone 58
Data Filtering | Mone by
WildFire Analysis | None il

23. Click Commit in the upper right-hand corner.

24. In the popup window, click Commit.

2.5.13 GlobalProtect Gateway and Portal Configuration

The SSL VPN configuration requires creation of both a GlobalProtect gateway and a GlobalProtect portal,
the latter of which could be used to manage VPN connections across multiple gateways. In this sample
implementation, only a single gateway and portal are configured.

2.5.13.1 Configure GlobalProtect Gateway

The GlobalProtect gateway provides remote users with secure access to internal resources based on
their Microsoft AD group. To configure the GlobalProtect gateway:

1. Inthe Palo Alto Networks Portal, navigate to Network > GlobalProtect > Gateways.

2. Below the details pane, select Add; the GlobalProtect Gateway Configuration form opens.
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3. Inthe GlobalProtect Gateway Configuration form, on the General tab:
a. Inthe Name field, enter a unique name to identify this GlobalProtect Gateway.
b. Under Network Settings:

i. Inthe Interface drop-down menu, select the physical interface connected to the
subnet on which the internet gateway device is located.

ii. Inthe IPv4 Address drop-down menu, select the IP address associated with the
physical interface specified in the previous step.

Figure 2-71 General GlobalProtect Gateway Configuration

GlobalProtect Gateway Configuration

Name

Authentication Metwork Settings
Interface | ethemnet1/1

IP Address Type IPv4 Only

IPv4 Address | 10.6.1.2/24

c. Select the Authentication tab.
d. In the Authentication tab:

i. For the Server Authentication > SSL/TLS Service Profile drop-down menu, select
the TLS/SSL profile associated with the publicly trusted server certificate for this
appliance.

ii. For the Client Authentication > Certificate Profile drop-down menu, select the
client TLS/SSL profile associated with the internally trusted client certificates is-
sued to mobile devices.
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Figure 2-72 GlobalProtect Authentication Configuration

GlobalProtect Gateway Configuration

Server Authentication

SSL/TLS Service Profile  TLS Digicert Profile

Client Authentication

(&)

Certificate Profile  Mobile_Lab_Cert_Profile

e. Select the Agent tab.
f.  On the Agent > Tunnel Settings tab:
i. Select the Tunnel Mode checkbox.
ii. Select the Enable IPSec checkbox to disable IPSec.
Figure 2-73 GlobalProtect Tunnel Configuration

GlobalProtect Gateway Gonfiguration

Tunnel Settings ~ Timeout Settings  Client IPPool  Client Settings ~ Network Services  Video Traffic

#! Tunnel Mode
Tunnel Interface | tunnel.1

Max User

[] Enable 1PSec

g. Select the Agent > Client IP Pool tab.
h. On the Agent > Client IP Pool tab:
i. Below the IP Pool list box, select Add; a new list item will appear.

ii. Forthe new IP Pool list item, enter the network address for the IP address pool
from which connected devices will be allocated an IP address.
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Figure 2-74 VPN Client IP Pool

GlobalProtect Gateway Configuration

Tunnel Seftings ~ TimeoutSettings  Client PPool  ClentSetings  Network Services  Video Traffic  HIP Notification

1 10.3.3.0/24

i. Select the Agent > Client Settings tab.
j. Onthe Agent > Client Settings tab:
i. Under the Client Settings list box, select Add; the Configs form opens.

Figure 2-75 VPN Client Settings

GlobalProtect Gateway Configuration

Tunnel Settings ~ Timeout Settings ~ ClientIP Pool  Client Settings  Network Services  Video Traffic HIP Notification

ii. Inthe Configs form on the Authorization Override tab, enter a unique name to

identify this client configuration.
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Figure 2-76 VPN Authentication Override Configuration

Configs

Authentication Override | User/User Group | IPPools | Split Tunnel

Mame Mobile_Lab_Remote
Authentication Override

|| Generate cookie for authentication override

|| Accept cookie for authentication override

Certificate to Encrypt/Decrypt Cookie Mone

iii. Select the User/User Group tab.
iv. On the User/User Group tab:
1) Below the Source User list box, select Add; a new list item appears.

2) In the Source User list item, select the Microsoft AD user group to grant
access to internal resources through this GlobalProtect gateway.

Figure 2-77 VPN User Group Configuration

Configs

User/User Group | IPPools | Split Tunnel

/| en=mobile users,cn=users,dc=govt,dc=mds,dc=local
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v. Select the Split Tunnel tab.
vi. On the Split Tunnel tab, on the Access Route tab:
1) Under the Include list box, select Add; a new list item appears.

2) In the new Include list item, enter 0.0.0.0/0. This enforces full tunneling.

Figure 2-78 VPN Split Tunnel Configuration

Configs

Split Tunnel

Access Route | Domain and Application

D Mo direct access to local network

Mo divect access to kes! network is applicable to Windows and Mac only

1 o.0.0.0/0

hat dlients should exclude (e.g. 172.16.1.0/24)

Thesz routes will be added mo the client’s rowting table. More-specific routes take precedence over kess-specific routss.

vii. Click OK.

k. Click OK.
2.5.13.2 Configure GlobalProtect Portal
1. Inthe Palo Alto Networks Portal, navigate to Network > GlobalProtect > Portal.
2. Below the details pane, select Add; the GlobalProtect Portal Configuration form opens.
3. Inthe GlobalProtect Portal Configuration form, on the General tab:

a. Inthe Name field, enter a unique name to identify this GlobalProtect portal.
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b. Inthe Interface drop-down menu, select the physical interface connected to the subnet
where the internet gateway device is located.

c. Inthe IP Address Type drop-down menu, select IPv4 Only.

Figure 2-79 GlobalProtect Portal Configuration

GlobalProtect Portal Configuration

Mame [t
Authentication Network Settings
Interface ethemnet1/1
1P Address Type IPv4 Only

1Pv4 Address | 10.6.1.2/24

Appearance
Portal Login Page  factory-default
Portal Landing Page  factory-default

App Help Page  factory-default

4. Select the Authentication tab.
5. In the Authentication tab:

a. Forthe Server Authentication > SSL/TLS Service Profile drop-down menu, select the
SSL/TLS service profile based on your third-party server certificate.

b. For the Certificate Profile drop-down menu, select the client TLS/SSL profile associated
with the internally trusted client certificates issued to mobile devices.

c. Click Add.
d. Enter a profile name. In this example implementation, Client Authentication was used.

e. For the Authentication Profile drop-down menu, select the previously created authenti-
cation profile.

f. Click OK.
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Figure 2-80 GlobalProtect Portal SSL/TLS Configuration

GlobalProtect Portal Configuration

Server Authentication

SSL{TLS Service Profile | TLS Digicert Profile

Client Authentication
Authentication
Meszage

[ Authentication Any Mobile_Lab_Auth- Username Password Enter login
Profile Profile credentials

Clientless VPN [l | Mame o5 Authentication Profile | Username Label Password Label

Dhd B @ ] [}

Certificate Profile  Mobile_Lab_Cert_Profilz

6. Select the Agent tab.

7. Onthe Agent tab:
a. Below the Agent list box, select Add; the Configs form will open.
b. Inthe Configs form:

i. Inthe Authentication tab, below Components that Require Dynamic Passwords,
check the box next to Portal.

ii. Inthe External tab, under the External Gateways list box select Add; the External
Gateway form opens.

iii. Inthe External Gateway form:
1) In the Name field, enter a unique name to identify this external gateway.

2) For the Address option, enter the FQDN for this appliance; in this sample
implementation, the FQDN is vpn.govt.mdse.nccoe.org.

3) Below the Source Region list box, select Add; a new list item appears.
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4) In the new Source Region list item, select Any.
5) Select the Manual checkbox.
6) Click OK.

Figure 2-81 GlobalProtect External Gateway Configuration

External Gateway

Name | Mobile_Lab_Ext G

Address (@) FQDN () 1P

vpn.govt.mdse.nccoe.org

IQ‘. Manual (The user can manually select this gateway)

iv. Below the Trusted Root CA list box, select Add; a new list item appears.
v. Inthe new Trusted Root CA list item, select your internal CA root certificate.

vi. Repeat Steps 7biii and 7biv to add each certificate in your internal or third-party
certificate trust chains used when mobile devices contact the GlobalProtect por-
tal.

c. Click App. Ensure that Connect Method is set to User-logon (Always On).
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Figure 2-82 GlobalProtect Portal Agent Configuration

GlobalProtect Portal Configuration

| External Gateways
[] Mobile_Lab_Agent any f Mobile_Lab_Bxt_GW

Badd @ e [+
kgtntUseern‘idequ anne

Il |
Il |
;.IT““"“M“

Confirm Agent User Override Key  sass
[] internal Root -
[7] DigiCert Root W -

d. Click OK.

2.5.14 Configure Automatic Threat and Application Updates

1.

2.

In the PAN-OS portal, navigate to Device > Dynamic Updates.
Click Check Now at the bottom of the page.

Under Applications and Threats, click Download next to the last item in the list, with the
latest Release Date. It will take a minute to download the updates.

When the download completes, click Done.
Click Install next to the downloaded update.
Click Continue Installation.

When installation completes, click Close.

Next to Schedule, click the link with the date and time.
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Figure 2-83 Schedule Link

Version & File Mame Features Type

w Applications and Threats Last checked: 2018/11/29 12:25:15E5T  Schedule: |E\rer\f Wednesday at 01:02 (Download nnlvi

9. Select the desired recurrence. For this implementation, Weekly was used.
10. Select the desired day and time. For this implementation, Saturday at 23:45 was used.
11. Next to Action, select download-and-install.

Figure 2-84 Threat Update Schedule

Applications and Threats Update Schedule

Recurrence | Weekly
Day  saturday
Time  23:45

Action  download-and-install

D Disable new apps in content update

Threshold (hours) | [1 - 336]
A ontent update must be at least ths many hours old
for the action to be tzkan,

Allow Extra Time to Review New App-1IDs

Set the amount of time the firewall waits before installing content updates that contain
new App-IDs. You can use this wait period to assess and adjust vour security policy
based on the new App-1Ds.

Mew App-1D Threshold (hours)

12. Click OK.
13. Click Commit in the upper right-hand corner.

14. In the popup window, click Commit.
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2.6 Integration of Kryptowire EMM+S with Mobilelron

Kryptowire’s application vetting service uses the Mobilelron application programming interface (API) to
regularly pull current device application inventory information from Mobilelron Core. Updated analysis
results are displayed in the Kryptowire portal.

2.6.1 Add Mobilelron APl Account for Kryptowire

The following steps will create an administrative account that will grant Kryptowire the specific
permissions it requires within Mobilelron.

1. In the Mobilelron Admin Portal, navigate to Devices & Users > Users.
2. Onthe Users page:
a. Select Add > Add Local User; the Add New User dialogue opens.

Figure 2-85 Mobilelron Users

Dashboard Devices & Users Admin  Apps Policies & Gonfigs Services Settings Logs

Users
<
m Resync Wiih LDAP To |Authorized Users v
admin admin 2017-08-31 5:45: Local Change Device Ownership, Li
Appthority Connector appthority appthority@govt mds local 2017-10-30 5:41:.. Local User Portal

b. Inthe Add New User dialogue:

i. Inthe User ID field, enter the user identity that the Kryptowire cloud will authen-
ticate under; our implementation uses a value of kryptowire.

ii. Inthe First Name field, enter a generic first name for Kryptowire.
iii. Inthe Last Name field, enter a generic last name for Kryptowire.

iv. Inthe Display Name field, optionally enter a displayed name for this user ac-
count.

v. Inthe Password field, provide the password that the Kryptowire identity will use
to authenticate to Mobilelron.

vi. In the Confirm Password field, enter the same password as in the preceding step.
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vii. In the Email field, provide an email account for the Kryptowire identity; this could
be used in configuring automatic notifications and should be an account under
the control of your organization.

viii. Click Save.

Figure 2-86 Kryptowire APl User Configuration

Add New User X
User ID kryptowire
First Name Kryptowire
Last Name Cloud
Display Name Kryptowire 2 Mobilelron API
Passwar‘d I (TTTENTT]
Confirm Password I
Ermail | kryptowire@mds.local
Cancel Save

3. Inthe Mobilelron Admin Portal, navigate to Admin > Admins.
4. Onthe Admins page:
a. Enable the account you created for Kryptowire during Step 2.

b. Select Actions > Assign to Space; this opens the Assign to Space dialogue for the Kryp-
towire account.
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Figure 2-87 Mobilelron User List

Dashboard Devices & Users Admin  Apps Policies & Configs  Services Settings Logs

Admins Device Spaces
Actions - To | Authorizec
NAME USER ID EMAIL SOURCE ROLES
admin admin Local API, Add device, Apply and remove compliance policy labels, Apply
Appthority Connector appthority appthority@govt.mds.local Local API, Add device, Apply and remove compliance policy labels, Apply
[¥] Kryptowire 2 Mobilelro...  kryptowire kryptowire@govt. mds.local Local API, View dashboard, View device page, device details
Lookout Cloud lookout lookout@govt.mds.local Local API, Connector, Distribute app, View Audit logs, View apps and iboi

c. Inthe Assign to Space dialogue:
i. Inthe Select Space drop-down menu, select Global.

Figure 2-88 Kryptowire APl User Space Assignment

Assign to Space - Kryptowire 2 Mobilelron API X

Admin Space IGIobaI v

Admin Roles
[] Select all admin roles

¥ Device Management

/] View device page, device details Selected Permissions Available Permissions

ii. Enable each of the following settings:

Admin Roles > Device Management > View device page, device details
Admin Roles > Device Management > View dashboard

Admin Roles > Privacy Control > View apps and ibooks in device details
Admin Roles > Privacy Control > View device IP and MAC address
Admin Roles > App Management > View app

Admin Roles > App Management > View app inventory

Other Roles > Common Services Provider (CSP)

Other Roles > API

iii. Click Save.
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2.6.2 Contact Kryptowire to Create Inbound Connection

Once the Mobilelron APl account has been created, contact Kryptowire customer support to integrate

your instance of Mobilelron Core. Note that this will require creation of firewall rules that permit

inbound connections from IP addresses designated by Kryptowire to Mobilelron Core on port 443. Once
the connection has been established, the Kryptowire portal will populate with information on devices
registered with Mobilelron. The EMM (Enterprise Mobility Management) ID presented by Kryptowire
will be the same as the Universally Unique ID assigned to a device by Mobilelron Core.

Figure 2-89 Kryptowire Device List

(dkryptowice

Devices on Network

Search:
MDM INTEGRATION

Show 10 : entries
APPLICATION ANALYSIS
Analyzed Apps - 0s
Platform  Device Version User Compliant  Email
Submit i0S App [ Pixel 8.1 mpeck v
Submit Android Aj
i .‘ [ ipad Air 2 11.3.1 mikepeck ¥
WATCH LIST
D Nexus & 7.0 jeanluc v
SUPPORT TICKET [] sm-Go30v 7.0 mpeck v

MAC Address

ac:37:43:dc:0f:da

ag:5b:78:15:45:39

f8:cf:c5:cd:48:29

2c:0e:3d:40:06:fa

Showing 1 to 10 of 19 entries

Previous - 2 Next

MDM Identifier

b04f418c-89ef-444a-8307-43f387b09797

€c598fa2-7110-4022-bb05-20771943f8¢c3

d4511074-0297-4a64-949f-1f42bcbfec29

eb195105-456e-4827-8aa0-f769d7b78d0f

2.7 Integration of Lookout Mobile Endpoint Security with Mobilelron

Lookout’s Mobile Endpoint Security cloud service uses the Mobilelron API to pull mobile device details

and app inventory from Mobilelron Core. Following analysis, Lookout uses the API to apply specific
labels to devices to categorize them by the severity of any issues detected. Mobilelron can be
configured to automatically respond to the application of specific labels per built-in compliance actions.

2.7.1 Add Mobilelron API Account for Lookout

The following steps will create an administrative account that will grant Lookout the specific permissions

it requires within Mobilelron.

1. Inthe Mobilelron Admin Portal, navigate to Devices & Users > Users.

2. Onthe Users page:

a. Select Add > Add Local User; the Add New User dialogue opens.
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Figure 2-90 Mobilelron User List

Dashboard Devices & Users Admin Apps Policies & Configs Services Settings Logs

Devices Users Labels ActiveSync Apple DEP Apple Education

Add ~ Resync With LDAP

[ E NAME USER ID EMAIL CREATION DATE 50... ROLES

0 & admin admin 2017-08-31 5:45:19 AM Local Change Device
] Administrator Administrator 2018-07-27 9:14:22 AM LDAP

= & Appthority Connector appthority appthority@agovt mds_local 2017-10-30 5:41:48 AM Local User Portal

b. Inthe Add New User dialogue:

vi.

Vii.

viii.

In the User ID field, enter the user identity that the Lookout cloud will authenti-
cate under. Our implementation uses a value of lookout.

In the First Name field, enter a generic first name for Lookout.
In the Last Name field, enter a generic last name for Lookout.

In the Display Name field, optionally enter a displayed name for this user ac-
count.

In the Password field, provide the password that the Lookout identity will use to
authenticate to Mobilelron.

In the Confirm Password field, enter the same password as in the preceding step.

In the Email field, provide an email account for the Lookout identity; since this
may be used for alerts, it should be an account under the control of your organi-
zation.

Click Save.
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Figure 2-91 Mobilelron Lookout User Configuration

i "\

Add New User X

User ID I lookout
First Name I Lookout
Last Name I Cloud
Display Mame Lookout Cloud
Password |ur-uu.-
Confirm Password I sssssssse
Email [.Ioa.knutﬁgnﬂ.mds_locﬂ ) |

e 7

3. Inthe Mobilelron Admin Portal, navigate to Admin.
4. On the Admin page:
a. Enable the account you created for Lookout during Step 2.

b. Select Actions > Assign to Space; this opens the Assign to Space dialogue for the Look-
out account.
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Figure 2-92 Lookout Mobilelron Admin Account

Dashboard  Devices & Users Admin Apps Policies & Configs Services  Settings

Admins
m To | Authorized Users v Lookout

7| Lookout Cloud lookout lookout@govt mds.local Local

c. Inthe Assign to Space dialogue:
i. Inthe Select Space drop-down menu, select Global.

Figure 2-93 Lookout Account Space Assignment

Assign to Space - Lookout Cloud

Select Space | Global v

Admin Roles

Select all admin roles

¥ Device Management

ii. Enable each of the following settings:

Admin Roles > Device Management > View device page, device details

Admin Roles > Device Management > View dashboard

Admin Roles > Label Management > View Label

Admin Roles > Label Management > Manage Label

Admin Roles > Privacy Control > View apps and ibooks in device details

Admin Roles > Privacy Control > View device IP and MAC address

Admin Roles > App Management > Distribute app

Admin Roles > Logs and Event Management > View Audit logs

Admin Roles > Logs and Event Management > View events

Other Roles > CSP

Other Roles > Connector

Other Roles > API

iii. Click Save.
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2.7.2 Add Mobilelron Labels for Lookout

Lookout will dynamically apply Mobilelron labels to protected devices to communicate information
about their current state. The following steps will create a group of Lookout-specific labels.

1. Inthe Mobilelron Admin Portal, navigate to Devices & Users > Labels.
2. Onthe Labels page:
a. Select Add Label; the Add Label dialogue appears.

Figure 2-94 Mobilelron Label List

Dashboard Devices & Users Admin Apps Policies & Configs Services  Settings

Labels
Add Label
All-Smartphones Label for all devices irrespective of 0S Filter "common refired"=false
Android Label for all Android Phones. Filter “common.platform™="Android” AND "common retired"=!
Company-Owned Label for all Company owned smartphones. Filter “common.owner'="COMPANY" AND "common retired”

b. Inthe Add Label dialogue:

i. Inthe Name field, enter the name of the label. Note: future steps will use the La-
bel Names presented here but use of these names is optional.

ii. Inthe Description field, enter a brief description for this label.
iii. For the Type option, select Manual; this hides all other form inputs.

iv. Click Save.

NIST SP 1800-21C: Mobile Device Security: Corporate-Owned Personally-Enabled 85



“TZ-008T"dS" LSIN/8Z09°0T/810°10p//:dny :wioly 381eY JO 3314 3|ge|IeAR SI uoiedlgnd SIyL

Figure 2-95 MTP Low Risk Label Configuration

Add Label x

Name |MTP - Low Risk

Description [Risk posture: devices with low-risk threats in Lookout |

Type @ Manual © Filter

c. Complete Step 2 for each label in the following table:

Label Name Purpose

Lookout for Work Device enrollment

MTP - Pending Lifecycle management: devices with
Lookout not yet activated

MTP - Secured Lifecycle management: devices with
Lookout activated

MTP - Threats Present Lifecycle management: devices with
threats detected by Lookout
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Label Name Purpose

MTP - Deactivated Lifecycle management: devices with
Lookout deactivated

MTP - Low Risk Risk posture: devices with a low risk score
in Lookout

MTP - Moderate Risk Risk posture: devices with a moderate
risk score in Lookout

MTP - High Risk Risk posture: devices with a high risk
score in Lookout

Note: Administrators can choose to alter the label names to something more appropriate for their
environment.

2.7.3 Add Lookout for Work for Android to Mobilelron App Catalog

The following steps will add the Lookout for Work app for Android to Mobilelron.
1. Inthe Mobilelron Admin Portal, navigate to Apps > App Catalog.

2. Onthe App Catalog page, select Add; this starts the workflow to add a new app to the app
catalog.

Figure 2-96 Mobilelron App Catalog

Dashboard Devices & Users  Admin Apps Policies & Configs  Services Settings Logs

App Catalog iBooks Installed Apps App Tunnels App Control Apps@Work Settings App Licen:
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¥ Source ]
_ L
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O Public
7 In-House

3. Onthe App Catalog > Choose page:
a. Select Google Play; additional controls will be displayed.

b. Inthe Application Name field, enter Lookout for Work.
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c. Select Search; search results will be displayed in the lower pane.
d. Inthe list of search results, select the Lookout for Work app.
e. Select Next.

Figure 2-97 Adding Lookout for Work to the Mobilelron App Catalog

Dashboard Devices & Users Admin  Apps  Policies & Configs  Services Settings Logs

App Catalog iBooks Installed Apps App Tunnels App Control Apps@Work Settings App
LY
o Choose &) e s Google Play v == Windows .
Application Name | Lookout for Work
NAME DESCRIPTION

- Lookout for Work This app is only for bt
@ Lookout Security & Antivirus Intreducing Safe Wi-F

Cancel Next —»

4. Onthe App Catalog > Describe page:

a. In Category drop-down menu, optionally assign the app to a category as appropriate to
your Mobilelron deployment strategy.

b. Select Next.
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Figure 2-98 Lookout for Work Application Configuration
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5. Onthe App Catalog > App Configuration page:

a. Inthe Apps@Work Catalog section, Enable Feature this App in the Apps@Work cata-
log.

Figure 2-99 Lookout for Work Application Configuration

Dashboard Devices & Users  Admin Apps Policies & Configs  Services Settings Logs

App Cataloa
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b. Inthe Android Enterprise (Android for Work [AFW]) section:
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i. Enable Install this app for Android enterprise; additional controls display.
ii. Enable Auto Update this App.
iii. Ensure Silently Install is enabled.
c. Click Finish.

Figure 2-100 Lookout for Work AFW Configuration

Dashboard Devices & Users Admin  Apps  Policies & Configs  Services Settings Logs
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Auto Update this App @
[V] Silently Install
[7] Block Widget on Home Screen

[7] Block Uninstall

- Back Skip m

6. The Lookout for Work app should now appear in the App Catalog with the AFW indicator.

2.7.4 Apply Labels to Lookout for Work for Android
1. On the App Catalog page:

a. Enable Lookout for Work.

b. Select Actions > Apply To Labels; the Apply To Labels dialogue appears.
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Figure 2-101 Apply Lookout for Work to Android Devices
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c. Inthe Apply To Labels dialogue:

i. Enable the Lookout for Work and Android labels, plus any other labels appropri-
ate to your organization's mobile security policies.

ii. Select Apply.
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Figure 2-102 Apply To Labels Dialogue
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d. The Lookout for Work app appears with the Lookout for Work and Android labels ap-

plied.
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Figure 2-103 Lookout for Work with Applied Labels

l"\ > CORE Dashboard Devices & Users Admin  Apps Policies & Configs  Services  Settings Logs
App Catalog iBooks Installed Apps App Tunnels App Control Apps@Work Settings
Filters m Quick Import =
9 [} APPLICATION NAME « | APP VERSION | SOURCE LABELS
app(s) |
Search by Name
Email+ 2.8.0.0.10-TB...  In-House
O
¥ Source
® A Lookout for Work Public Android, Lookout for Work
) Public [
) In-House

2.7.5 Add Lookout for Work app for iOS to Mobilelron App Catalog

The following steps will add the Lookout for Work app for iOS to Mobilelron, apply appropriate
Mobilelron labels, and create and upload a configuration file for one-touch activation of the app.

2.7.5.1 Import Lookout for Work App
1. Inthe Mobilelron Admin Portal, navigate to Apps > App Catalog.

2. Onthe App Catalog page, select Add; this starts the workflow to add a new app to the app
catalog.

Figure 2-104 Mobilelron App Catalog

Dashboard Devices & Users Admin  Apps  Policies & Configs  Services Settings Logs

App Catalog iBooks Installed Apps App Tunnels App Control Apps@Work Settings App Licen:
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3. Onthe App Catalog > Choose page:
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a. Select iTunes; additional controls display.

b. In the Application Name field, enter Lookout for Work.

c. Select Search; the search results display in the lower pane.
d. Inthe list of search results, select the Lookout for Work app.
e. Select Next.

Figure 2-105 Lookout for Work Selected From iTunes

Dashboard Devices & Users  Admin Apps Policies & Configs  Services  Settings Logs
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4. Onthe App Catalog > Describe page:

a. In Category drop-down menu, optionally assign the app to a category as appropriate to
your Mobilelron deployment strategy.

b. Select Next.
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Figure 2-106 Lookout for Work App Configuration
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5. Onthe App Catalog > App Store page:

a. Inthe Apps@Work Catalog section:

i. Enable Allow conversion of app from unmanaged to managed (iOS 9 or later).

ii. Enable Feature this App in the Apps@Work catalog.

iii. Select Next.
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Figure 2-107 Lookout for Work App Configuration
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b. In the App Catalog > App Configuration section:

i. Enable Send installation request or send convert unmanaged to managed app
request (i0OS 9 and later) on device registration or sign-in.

ii. Enable Advanced Settings > Automatically update app when new version is
available.

c. Click Finish.
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Figure 2-108 Lookout for Work Managed App Settings
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6. The Lookout for Work app should now appear in the App Catalog with AFW indicator.

Figure 2-109 App Catalog with Lookout for Work
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2.7.5.2 Apply Mobilelron Labels to Lookout for Work App
1. On the App Catalog page:

a. Enable Lookout for Work.
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b. Select Actions > Apply To Labels; the Apply To Labels dialogue will appear.

Figure 2-110 Lookout for Work Selected
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c. Inthe Apply To Labels dialogue:

i. Enable the Lookout for Work and iOS labels, plus any other labels appropriate to
your organization's mobile security policies.

ii. Select Apply.
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Figure 2-111 Apply To Labels Dialogue
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d. The Lookout for Work app appears with the Lookout for Work and iOS labels applied.

Figure 2-112 App Catalog with Lookout for Work
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2.7.5.3 Create Managed App Configuration File for Lookout for Work

Mobilelron can push a configuration file down to managed iOS devices to allow users to activate
Lookout for Work. The following steps will create and upload the necessary file.

1. Using a plain text editor, create the following text file by replacing the asterisks on line 13
with your organization's Global Enroliment Code.

<?xml version="1_.0" encoding="UTF-8"7?>
<IDOCTYPE plist PUBLIC *"-//Apple//DTD PLIST 1.0//EN"
"https://www._apple.com/DTDs/PropertyList-1.0.dtd">
<plist version="1.0">
<dict>
<key>MDM</key>
<string>MOBILEIRON</string>
<key>DEVICE_UDID</key>
<string>$DEVICE_UDID$</string>
<key>EMAlL</key>
<string>$EMAIL$</string>
<key>GLOBAL_ENROLLMENT_CODE</key>
<string>*******</string>
</dict>
</plist>

2. Inthe Mobilelron Admin Portal, navigate to Policies & Configs > Configurations.
3. On the Configurations Page:

a. Select Add New > iOS and OS X > iOS Only > Managed App Config; the New Managed
App Config Setting dialogue opens.
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Figure 2-113 Importing Managed Application Configuration
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b. Inthe Managed App Config Setting dialogue:

i. Inthe Name field, provide a name for this configuration; our implementation
used Activate Lookout.

ii. Inthe Description field, provide the purpose for this configuration.

iii. Inthe Bundleld field, enter the bundle ID for Lookout at Work, which for our ver-
sion was com.lookout.work.

?.

Select Choose File... to upload the plist file created during Step 1.

v. Click Save.
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Figure 2-114 plist File Configuration
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2.7.5.4 Apply Labels to Managed App Configuration for Lookout for Work

The following steps will apply the managed app configuration created in the previous section to labels.
1. Inthe Mobilelron Admin Portal, navigate to Policies & Configs > Configurations.
2. On the Configurations page:

a. Enable the Lookout Activation managed app configuration created in the previous sec-
tion.

b. Select Actions > Apply To Label; the Apply To Label dialogue opens.

Figure 2-115 Lookout Configuration Selected
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c. Inthe Apply To Label dialogue:
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i. Enable the iOS and Lookout for Work labels.

ii. Select Apply.

Figure 2-116 Apply To Label Dialogue
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d. The system should now reflect that the Lookout for iOS and iOS labels have been ap-
plied to the Activate Lookout configuration.
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Figure 2-117 Lookout Configuration With Labels
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2.7.6 Add MDM Connector for Mobilelron to Lookout MES

The following instructions will connect Lookout with your Mobilelron instance and associate Lookout
device states with the Mobilelron labels created previously.

1. Using the most-recent version of MDM Service IP allowed addresses available from the
Lookout support portal, configure your organization's firewalls to permit inbound connec-
tions from the IP addresses provided on port 443 to your instance of Mobilelron Core.

2. Inthe Lookout MES portal, navigate to Lookout > System > Connectors.
3. On the Connectors page:
a. Select Add Connector > Mobilelron; a new form opens.

Figure 2-118 Add Lookout Connector Display
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b. Inthe Connector Settings section of the form:

i. Forthe Mobilelron URL field, enter the FQDN for your instance of Mobilelron. In
our example implementation, the URL was mi-core.govt.mdse.nccoe.org.

ii. Forthe Username field, enter the User ID of the Mobilelron admin account cre-
ated in 2.7.1. In our example implementation, the User ID is lookout.

iii. Forthe Password field, enter the password associated with that Mobilelron ad-
min account.

iv. Select Create Connector; this enables additional sections of the form.

Figure 2-119 Connector Settings
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c. Inthe Enrollment Management section of the form:

i. Toggle Device Enrollment > Automatically drive Lookout for Work enrollment on
Mobilelron managed devices to On.

ii. Forthe Device Enrollment > Use the following label to identify devices that
should have the Lookout for Work app activated drop-down menu, select the
Lookout for Work label.

iii. Toggle Device Enroliment > Automatically send activation emails to Mobilelron
managed devices to On.
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iv. Select Save Changes.

Figure 2-120 Connector Enrollment Settings
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Devices

Automatically send activation emails to Mabileiron ()
Error Managed devices
Management

Device Deactivation

Delete device on unenroliment

Automatically deactivate Lookout on select devices™* m

Deactivate Lookout on devices with any of these Lost
Mobilelron statuses
Wiped
+ Retired
Save changes

NIST - National

d. Inthe State Sync section of the form:
i. Toggle State Sync > Synchronize Device Status to Mobilelron to On.
ii. Foreach entry in the table below:
1) Toggle the control to On.

2) From the drop-down menu, select the Mobilelron Label with the associ-
ated Purpose from the table in Section 2.6.2 Add Mobilelron Labels for
Lookout. We provide the Label Name we used for each Purpose in our ex-
ample implementation.

State Purpose Label Name
Devices that have Lifecycle management: | MTP - Pending
not activated devices with Lookout

Lookout yet not yet activated
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State

Purpose

Label Name

Devices with
Lookout activated

Lifecycle management:
devices with Lookout
activated

MTP - Secured

Devices on which
Lookout is
deactivated

Lifecycle management:
devices with Lookout
deactivated

MTP - Deactivated

Devices with any

Lifecycle management:

MTP - Threats

Risk issues present

with a low risk score in
Lookout

issues present devices with threats Detected
detected by Lookout
Devices with Low Risk posture: devices MTP - Low Risk

Devices with
Medium Risk issues
present

Risk posture: devices
with a moderate risk
score in Lookout

MTP - Moderate
Risk

Devices with High
Risk issues present

Risk posture: devices
with a high risk score in
Lookout

MTP - High Risk

Note: Administrators can choose to alter the label names to something more appropriate for their

environment.

iii. Select Save Changes.
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Figure 2-121 Connector Sync Settings

Lookout @ Mobilelron
Connector State Sync

Account Settings

Synchronize device status to MobileIron m

: Enroliment
Manage Admins
Management .
Device Lifecycle
e ent Settinas
Enroliment Setting State Sync Devices that have not activated Lookout yet MTP - Pending
Send Invites Managed
Devices Devices with Lookout activated MTP - Secured
Manage Invites
Error . . . " .

Devices on which Lookout is deactivated MTP - Deactivated
I ) Management
108 Configuration -

Devices that have lost connectivity with
Connectors Lookout
Applicatic Devices with any issues present MTP - Threats Present

Risk Posture

Devices with Low Risk issues present MTP - Low Risk
Devices with Medium Risk issues present MTP - Moderate Risk
Devices with High Risk issues present MTP - High Risk

<D NIST - National
Institute of Save changes

2.7.7 Configure Mobilelron Risk Response

RBB B EAAA

The following steps will allow Mobilelron to generate responses to various device states as assighed to

devices by Lookout (e.g., MTP - High Risk).

2.7.7.1 Add Mobilelron App Control Rule
1. Inthe Mobilelron Admin Portal, navigate to Apps > App Control.
2. Select Add; the Add App Control Rule dialogue appears.
3. Inthe Add App Control Rule dialogue:

a. Inthe Name field, enter Threats Present Trigger.
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b. Of the Type options, select Required.
c. Inthe App Identifier/Name field enter app does not exist.
d. Inthe Device Platform drop-down menu, select All.

e. Inthe Comment field, optionally enter Forces non-compliant state.

bl

Click Save.

Figure 2-122 Mobilelron App Control Rule

Edit App Control Rule

Mame:  Threats Present Trigger
Type: () Allowed | Disallowed () WIP @ Required (Required option is only applicable to Android, I0S and macOS)

When creating policies for

« Android, i05 or macOS, use "Name Equals/Identifier Equals/Name Contains/Identifier Contains®
» Windows Phone 8.1 or Windows 10 Mobile, only use "MS Store GUID Equals®

+ Windows 10 Desktop, use "Publisher/PFN Eguals" or "EXE/Win32 Equals”

Note: When using "EXE/Win32 Equals”, you can choose either the publisher/application for signed apps or the direct path for

unsigned apps.
Rule Entries:
App Identifier/Name Device Platform Comment
App Identifier Equals |~  app does not exist All ~ | Forced non-compliant state o
o

Ed | cance

4. The new app control rule should now appear on the Apps > App Control page.
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Figure 2-123 Mobilelron App Control Rule

Dashboard Devices & Users  Admin Apps Policies & Configs  Services Seitings Logs

App Control
<
Add L Type: Al v
Edit Name » Type Rule Entries Used In Policy
Threats Present Trigger Required le Ent Not Used

2.7.7.2 Add Mobilelron Compliance Actions

A Compliance Action defines what actions Mobilelron will take when an App Control policy, like the one
created in the previous section, is violated by a managed mobile device. The following steps will create

and configure an example Compliance Action in response to the MTP - High Risk App Control rule. Note
that a single Compliance Action can be associated with multiple App Control rules if the same response

would be configured for each. Otherwise, a new Compliance Action should be created.

1. Inthe Mobilelron Admin Portal, navigate to Policies & Configs > Compliance Actions.
2. Select Add; the Add Compliance Action dialogue opens.
3. Inthe Add Compliance Action dialogue:

a. Inthe Name field, add a description of the compliance action; we recommend indicating
the kind of action taken. This example illustrates creating a compliance action that will
be associated with the MTP - High Risk label.

b. Select the Enforce Compliance Actions Locally on Devices check box.

c. Select the Send a compliance notification or alert to the user check box.
d. Select the Block email access and AppConnect apps check box.

e. Select the Quarantine the device check box.

f. Deselect the Remove All Configurations check box.

g. Click Save.
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Figure 2-124 MTP High Risk Compliance Action

Add Compliance Action x

Select the actions that will be performed when devices are out-of-compliance.

Name: | MTP - High Risk
Enforce Compliance Actions Locally on Devices 0

Tier 1

¥ ALERT
Send a compliance notification or alert to the user

v BLOCK ACCESS
Block email access and AppConnect apps i ]

¥ QUARANTINE

6 For Android enterprise devices, all Android enterprise apps and functionality will be hidden except
Downloads, Google settings, Google Play Store and Mobile @ Work app.

Quarantine the device

[] Remove All Configurations
[] Remove iBooks content, managed apps, and block new app downloads

Cancel Save

2.7.7.3 Create Mobilelron Security Policy for Lookout MES

In addition to potentially defining other controls, such as password requirements, a Security Policy can
map a Compliance Action to an App Control rule, enabling Mobilelron to execute the configured actions
whenever a device that applies the policy violates the App Control rule. The following steps will create a

NIST SP 1800-21C: Mobile Device Security: Corporate-Owned Personally-Enabled 111



"TZ-008T"dS"LSIN/8209°0T/840"10p//:d11y :wioly 381eyd Jo 3314 3|qe|ieAe S| uoiedlignd siy L

new Security Policy for Lookout MES High Risk devices using an existing policy as a baseline from which
to apply more stringent controls.

1. Inthe Mobilelron Admin Portal, navigate to Policies & Configs > Policies.
2. Onthe Policies page:
a. Select the security policy to use as a baseline.

b. Select More Actions > Save As; this opens the New Security Policy dialogue.

Figure 2-125 Baseline Policy Selection

Dashboard Devices & Users Admin  Apps Policies & Configs Services Settings Logs

Configurations Policies Sync Policies Compliance Policies Compliance Actions
Delete More Actions + Add New ~ Labels: | All-Smartphones b Search by User 2| Policy Type: | Search by Policy Type || |Search by Nan
[ | Policy Name Priority « Status Descr... Type Last Modified # Phones Labels Watch List &«
|| Default Lockdown... LOCKDOWN Active Defaul... LOCKDOWN 2008-01-01 3:00:00... 0 1]
I”| Default Sync Policy SYNC Active Defaul... SYNC 2008-01-01 3:00:00... 15 0
¥]| DOD Policy SECURITY - 3 Active Mobil... SECURITY 2018-06-11 2:52:57 ... 0 0

c. Inthe New Security Policy dialogue:
i. Inthe Name field, rename the policy to MTP - High Risk.

ii. Inthe Priority drop-down menu, select a current policy. The new policy will be
prioritized based on the selection. In this example, the new policy is higher than
the MTP Medium Risk policy. Note: for ease of setting priority, it is recom-
mended to add new security policies in ascending order (lowest to highest prior-

ity).
Figure 2-126 MTP High Risk Policy

New Security Policy

m| Cancel

Name: MTP High Risk

Status: @ Active Inactive
Priority: @ Higher than Lower than MTP Medium Risk (2) A

Description: | Applied to devices with MTP - High Risk label

iii. Under Access Control > For All Platforms section:
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1. For the when a device violates the following app control rules drop-down
menu, select the MTP - High Risk compliance action.
2. Inthe Available list of app control rules, highlight MTP High Risk Trigger.
3. Select the right arrow to move MTP High Risk Trigger item into the Enabled
List.
iv. Click Save.

Figure 2-127 Security Policy Trigger

New Security Policy

EX | cancel

- | Access Control

Platforms
Supported

For All Platforms

~ when a device has not connected to Core in day(s)
Block Email, AppConnect apps, an v whan a policy has been out of date for day(s) 0
[7] |MTP - High Risk ~ when a device violates following App Control rules:

Rule Type: Required
Available Enabled
Threals Present Trigger MTP High Risk Trigger

Install AFW Pulse Secure

[«

| Cancel

2.7.7.4 Apply Lookout MES Label to Mobilelron Security Policy

The following steps will apply the MTP - High Risk label to the security policy created in the previous
section. As a result, once the Lookout cloud service applies the label to any device with a detected high-
risk threat and such a device checks in with Mobilelron, the security policy will automatically be applied
to it (provided it is of higher priority than the policy currently applied). In turn, that will cause the MTP
High Risk Trigger App Control policy to be violated and the MTP - High Risk Compliance Action to be
taken. Once Lookout detects that the threat has been resolved, the Lookout service will remove the
MTP - High Risk label, and on device check-in, Mobilelron will then apply the next-lower-priority security

policy.
1. Inthe Mobilelron Admin Portal, navigate to Policies & Configs > Policies.
2. On the Policies page:
a. Select the check box in the MTP High Risk security policy item.

b. Select More Actions > Apply to Label; the Apply to Label dialogue opens.
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Figure 2-128 Policy List

Dashboard Devices & Users Admin Apps  Policies & Configs  Services Settings Logs

Configurations Puolicies ActiveSync Policies Compliance Policies Compliance Actions
* Add New * Labels: All-Smartphones v Search by User £ | Policy Type: | Search by Policy Type | | | Search by Nan
|_, Policy Name Priority « Status Deser... Type Last Medified # Phones Labels Watch List b
E_ Appthority Android APPCONNECT -1 Active Allows... APPCONNECT 2017-11-16 12:26:0... 11 Android, Appthority i
E_ MTP High Risk SECURITY -1 Active Applie... SECURITY 2018-06-12 11:20:2... 0 MTP - High Risk 1]

c. Inthe Apply to Label dialogue:
i. Select the check box for the MTP - High Risk item.

ii. Select Apply.
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Figure 2-129 Apply To Label Dialogue

Apply To Label

Search by Name or Description

O

MTP

OOO0O0O0O0O0EOO0OO0

1 4

MTP -
MTP -
MTP -
MTP -
MTP -
MTP -

Name =

Lookout for Work
macO3

Mobile Users

- Deactivated
High Risk
Low Risk

Pending
Secured

NoAgent
Signed-0Out

Moderate Risk

Threats Present

Description

Uszed to identify devices enrolled wit...
Label for all macOS Devices.

Label for users authorized to access...
Device lifecycle: deactivated in Look...
Risk posture: high-risk devices in Lo...
Risk posture: low-risk devices in Loo...
Risk posture: moderate risk devices ...

Device lifecycle: pending devices in ...

Device lifecycle: secured by Lookout.
Device lifecycle: threats on device d...
Only for devices without the Mobile. ..

Label for devices that are in a multi-...

Pagel1 |of2| b M |
| Apply |

2.8 Integration of Appthority Mobile Threat Detection with Mobilelron

Installed

Mot Applied
Mot Applied
Mot Applied
Not Applied
Not Applied
Mot Applied
Mot Applied
Mot Applied
Mot Applied
Mot Applied
Mot Applied
Not Applied

1-200f 22

Appthority provides an on-premises connector for Mobilelron that runs as a Docker container on RedHat
Linux. The connector uses the Mobilelron API to obtain information on managed devices and their
installed apps, which is then synchronized with the cloud service instance to obtain app and device risk
scores, which are assigned to devices using custom attributes. The following sections provide the steps

to create a Mobilelron APl account and deploy and configure the Appthority connector.

2.8.1 Create Mobilelron API Account for Appthority Connector

The following steps will create an administrative account that will grant Appthority the specific
permissions it requires within Mobilelron.
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1. Inthe Mobilelron Admin Portal, navigate to Devices & Users > Users.

2. On the Users page:

a. Select Add > Add Local User; the Add New User dialogue opens.

b. Inthe Add New User dialogue:

vi.

Vii.

viii.

In the User ID field, enter the user identity the Appthority connector will authen-
ticate under. Our implementation uses a value of Appthority.

In the First Name field, enter a generic first name for Appthority.
In the Last Name field, enter a generic last name for Appthority.

In the Display Name field, optionally enter a displayed name for this user ac-
count.

In the Password field, provide the password the Appthority identity will use to
authenticate to Mobilelron.

In the Confirm Password field, enter the same password as in the preceding step.

In the Email field, provide an email account for the Appthority identity; this
should be an account under the control of your organization.

Click Save.
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Figure 2-130 Appthority User Settings

Add New User X
User ID appthority
First Name Appthority
Last Name Connector
Display Name Appthority Connector
pﬂﬁﬁwarﬂ I (AT EER AL EER I L]
Gﬂnﬁrm passwnrd I (T TERSTEER LT
Emall | appthority@mds.local
Cancel Save

3. Inthe Mobilelron Admin Portal, navigate to Admin.
4. On the Admin page:
a. Enable the account you created for Appthority during Step 2.

b. Select Actions > Assign to Space; this opens the Assign to Space dialogue for the Ap-
pthority account.
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Figure 2-131 Appthority Connector User

Dashboard Devices & Users Admin  Apps Policies & Configs Services Settings Logs

Admins Device Spaces
Actions - To |Authorized Users A4 Search by User Id L
1| NAME USERID EMAIL SOURCE ROLES ADMIN SPACES
[T admin admin Local API, Add device, Apply and remove co... Global
Appthority Connector appthority appthority@govt.mds.local Local API, Add device, Apply and remove co... Global
[7] Kryptowire 2 Mobilelro...  kryptowire kryptowire@govt.mds.local Local API, View dashboard, View device page...  Global

c. Inthe Assign to Space dialogue:
i. Inthe Select Space drop-down menu, select Global.

Figure 2-132 Appthority Connector Space Assignment

Assign to Space - Appthority Gonnector x

Select Space I Gilobal w

Admin Roles

[ Select all admin roles

ii. Enable each of the following settings:

Device Management > View device page, device details
Privacy Control > View apps and ibooks in device details
App Management > Apply and remove application label
Other Roles > API

iii. Click Save.

2.8.2 Deploy Appthority Connector Open Virtualization Appliance

One deployment option for the Appthority connector is a pre-built RedHat virtual machine distributed as
an Open Virtualization Appliance (OVA). We imported the OVA into our virtual lab environment
following guidance provided in Connector On-Premises: Virtual Machine Setup available from the
Appthority support portal: https://support.appthority.com/.

NIST SP 1800-21C: Mobile Device Security: Corporate-Owned Personally-Enabled 118


https://support.appthority.com/

"TZ-008T'dS LSIN/8209°0T/840°10p//:d13y :woJy d84eYd JO 3344 3|qe|ieAe si uofiealjqnd sty

2.8.3 Run the Enterprise Mobility Management Connector Deployment Script

Once the Appthority docker container is running, the setup script will configure it to use the Mobilelron
APl account created previously. Detailed instructions on using the script are available on the Appthority
support portal at https://help-mtp.appthority.com/SetUp/EMM/EMM Script/Run-
EMMDeployScript.html. The first two steps ask for Appthority-supplied credentials necessary to verify
your subscription and to link the connector with the correct instance of their cloud service. In the third
step you will provide details to integrate with your on-premises instance of Mobilelron core. Our results
from completing the third step are shown below.
1. Obtain a copy of Run the EMM Connector Deployment Script from the Appthority support
portal at https://help-mtp.appthority.com/SetUp/EMM/EMM _Script/Run-
EMMDeployScript.html (authentication to the portal is required).

2. Execute the script. The third step in the script involves providing settings to enable the Ap-
pthority Connector to communicate with Mobilelron Core. The results of our completion of
that step are provided below as a reference.

Figure 2-133 Appthority Connector CLI Configuration

Selection: 3
Conf igure EMM
Select EMM Provider:

[A] Airlatch 9.X
[M] Mobilelron Core 9.X
[MC] Mobilelron Cloud

EMM Provider: M

EMM Provider Selected: mobileiron

Is Mobilelron Core On-Premise? (y/m): uy

EMM URL: mi-core .govt .mdse .nccoe.org
Is the EMM User a Domain Account (y/n)? n

EMM Username: appthority

EMM Password:

Is there a Proxy (ym)7? n

Set EMM API Timeout (y/ml7? n

[Okay]

3. Once the script has been completed, verify successful synchronization with the Appthority
cloud service by accessing the Appthority MTP portal and navigating to Admin > EMM and
viewing items under Connector Status.
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Figure 2-134 Appthority EMM Connector Status

(MTP | appthority

(;73 DASHBOARD Q DEVICES 88 APPS [% COMPLIANCE ‘ C% ADMIN

Organization Users EMM  MTP Mobile App

Vendor / Product Connector Status : Appthority Connector

MOb"elron Core (On'Prem|SeS) @ App Inventory ® Remediation v13.2

# Device Information On-premises

2.9 Registering Devices with Mobilelron Core

In this scenario, the employee manages their own personal apps, data, and many device functions. The
organization manages work-related apps and data, and has control over specific device functions, such
as requiring a complex device unlock PIN or being able to remotely wipe a lost device. The mechanisms
to achieve similar security characteristics between iOS and Android devices differ.

2.9.1 Supervising and Registering iOS Devices

Many MDM-based security controls are only applicable to iOS devices that are running in Supervised
Mode. The following steps outline how to place an iOS device into this mode, and then register with
Mobilelron Core.

2.9.1.1 Resetting the iOS Device

Before a device can be placed into Supervised Mode, it must be in a factory-reset state with the
Activation Lock on the device removed. If Activation Lock is in-place, Configurator 2 will be unable to
place the device into Supervised Mode.
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2.9.1.1.1 Reset an Unsupervised Device Using Settings App
If a device is not already in Supervised Mode, it is recommended to have the current device user

manually reset and activate the device to factory settings using the following steps:
1. Navigate to Settings > General > Reset.
2. Select Erase All Content and Settings.

Figure 2-135 iOS Reset Screen

all & 10:39 AM B () #

£ General Reset

Reset All Settings

Erase All Content and Settings

Reset Network Settings

Reset Keyboard Dictionary
Reset Home Screen Layout

Reset Location & Privacy

3. Atthe warning that this will delete all media and data and reset all settings, select Erase
iPhone.
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Figure 2-136 Erase iPhone Confirmation

This will delete all media and data,
and reset all settings.

Erase iPhone

4. At the warning that all media, data, and settings will be irreversibly erased, select Erase
iPhone. Once the reset process is complete, the device will reboot and need to be acti-
vated.
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Figure 2-137 Erase iPhone Final Confirmation

Are you sure you want to continue? All media, data,
and settings will be erased.
This cannot be undone.

Erase iPhone

5. Once the device displays the Hello screen, press the Home key.

6. At the Select Your Language screen, select English.

7. At the Select Your Country or Region screen, select United States.
8. At the Quick Start screen select Set up Manually.

9. At the Choose a Wi-Fi Network screen, select the Service Set Identifier (SSID) for the net-
work and authenticate to your on-premises SSID Wi-Fi network; the device should indicate
it is being activated. Note: you may need to attempt activation again if there is a delay in
the device establishing connectivity to the internet.

10. Stop at the Data & Privacy screen. At this point, the device should be placed into Super-
vised Mode using Configurator 2.
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2.9.1.1.2 Reset a Supervised Device Using Configurator 2
1. Connect the iOS device with the system running Configurator 2 over Universal Serial Bus
(USB).

2. Onthe device at the Enter Passcode screen (if locked), enter the device unlock passcode.
Figure 2-138 Entering iOS Passcode

all Verizon =

Enter Passcode

escsesese OK

Emergency

3. At the Trust this Computer? dialogue, select Trust. Note that this step, along with step that
follows, is only encountered the first time a device is paired with a given system.

NIST SP 1800-21C: Mobile Device Security: Corporate-Owned Personally-Enabled 124



“12-008T"dS"LSIN/8209°0T/840"10p//:d11y ;w0 981eyd 4o 994 3|qejieAe S| uonedljgnd siyL

Figure 2-139 iOS Trust Computer Confirmation

Trust This Computer?

Your settings and data will be
accessible from this computer when

connected.

Don't Trust

4. At the Enter Device Passcode to Trust This Computer screen:
a. Enter the device unlock passcode.

b. Click OK.
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Figure 2-140 Entering Passcode to Trust Computer

Enter device Passcode to Trust
This Computer

Your settings and data will be accessible from this
computer when connected.

ssescese oK

1 2 3

ABC DEF

4 5 6

GHI JKL MNO

i 8 9

PQRS TUuv WXYZ

Delete

5. In Configurator 2, select the representation of the connected device.
6. From the context menu, select Advanced > Erase All Content and Settings.
7. Atthe Are you sure you want to erase "<device name>"? dialogue, select Erase.

Figure 2-141 Configurator 2 Erase Confirmation

Are you sure you want to erase “Spike's
iPhone"? This will delete all media and data,
and reset all settings.

You cannot undo this action.

Cancel Erase
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8. Atthe License Agreement screen:
a. Review the license agreement.
b. Select Accept to agree to the license and continue using the software.

9. Configurator 2 will take several minutes to restore the device to factory default settings.
Configurator 2 will also activate the device following restoration.

Figure 2-142 Restoring iPhone

Restoring iOS on "Spike's iPhone”

Cancel

2.9.1.2 Placing an iOS Device into Supervised Mode

iOS devices that have been factory reset and subsequently activated (the Activation Lock has been
removed) can be placed into Supervised Mode using software available from Apple, Configurator 2, by
the following steps:

1. Pair the target iOS device with the system running Configurator 2 over USB.

2. Navigate to Configurator 2 > Unsupervised; a representation of the connected device
should appear.

3. On the All Devices tab:

a. Select the representation of the paired device.

b. From the context menu, select Prepare; a wizard opens to guide the process.
4. For the Prepare Devices step:

a. Enable Supervise Devices.

b. Select Next.
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Figure 2-143 Device Preparation Options

Prepare Devices

Preparing devices is the first step in any deployment. You need to prepare
devices before you distribute them to users.

Prepare with:  Manual Configuration
| Add to Device Enrollment Program

Activate and complete enrollment

Supervise devices
Allow devices to pair with other computers
Enable Shared iPad

Cancel

Previous MNext

5. For the Enroll in MDM Server step:

a. Ensure the Server drop-down menu has Do not enroll in MDM selected.

b. Select Next.
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Figure 2-144 MDM Server Selection

Enroll in MDM Server

Choose an MDM server to manage the devices remotely over the air,
if desired.

Server: Do not enroll in MDM

k/’

*a

Cancel Previous

6. For the Sign into the Device Enrollment Program step, select Skip.
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Figure 2-145 Signing into Apple Account

Sign in to the Device Enrollment Program

‘ Apple ID l?:r.-_‘nmplc:it cloud

Mext

Create new Apple ID

Forgot Apple ID or password?

Cancel

Previous

Skip

7. For the Assign to Organization step:

a. If you have previously created your organization, select Next and continue with Step 9.

b. If you have not created your organization, from the Organization drop-down menu, se-

lect New Organization...
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Figure 2-146 Organization Assignment Dialogue

Assign to Organization

Choose the organization which will be used to supervise the devices.
Settings > General > About will display the organization’s contact
information, which cannot be changed without erasing the devices.

Organization: Mew Organization...

Cancel Previous

8. At the Create an Organization screen:
a. Inthe Name field, enter the name of your organization.
b. Inthe Phone field, enter an appropriate support number for your mobility program.
c. Inthe Email field, enter an appropriate support email for your mobility program.
d. Inthe Address field, enter the address for your organization.

e. Select Next.

NIST SP 1800-21C: Mobile Device Security: Corporate-Owned Personally-Enabled 131



“12-008T"dS"LSIN/8209°0T/840"10p//:d11y ;w0 981eyd 4o 994 3|qejieAe S| uonedljgnd siyL

Figure 2-147 Creating an Organization

Create an Organization

Enter information about the organization.

Name: NCCoE MDSE Lab

Phone:

_. Email: mobile-nccoe@nist.gov
; Address:

Cancel Previous Next

9. If your organization has established a digital identity for placing devices into Supervised
Mode:

a. Continue with Step 10. Note: that the same digital identity must be used for any given

device.
b. Otherwise, continue with Step 14.

10. In the Create an Organization screen:

a. Forthe Generate or choose a supervision identity option, select Choose an existing su-

pervision identity.

b. Select Next.
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Figure 2-148 Supervisory ldentity Configuration

Create an Organization

Generate or choose a supervision identity.

| Generate a new supervision identity
) Choose an existing supervision identity

*d

\

Cancel Previous

11. Select Choose...
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Figure 2-149 Organization Selection

Create an Organization

No Identity Selected

Choose...

Cancel Previous Mext

12. At the Choose a supervising identity for the organization dialogue:
a. Select the digital certificate from the list of those available to the system.
b. Select Choose.

Figure 2-150 Supervising Identity Selection

7~ Choose a supervising identity for the organization.

Show Certificate Cancel Choose

13. At the Create an Organization screen, select Next.
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Figure 2-151 Selected Organization

Create an Organization

iPhone Developer: Spike Dog (% = saaw)
Issued by: Apple Worldwide Developer Relations Certification Authority
Expires: Tuesday, Movember 6, 2018 at 1:46:30 PM Eastern
Standard Time
This certificate is valid
> Details
Choose...
Cancel Previous Next

14. In the Create an Organization screen:

a. Forthe Generate or choose a supervision identity option, select Generate a new super-
vision identity.

b. Select Next.
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Figure 2-152 Create an Organization Supervision Identity Configuration

Create an Organization

Generate or choose a supervision identity.

© Generate a new supervision identity
~Choose an existing supervision identity

*d

Cancel Previous MNext

15. For the Configure iOS Setup Assistant step:

a. Ensure the Setup Assistant drop-down menu shows Show only some steps selected;
additional options will appear.

b. Enable each of the Privacy, Passcode, Apple ID, and Location Services check-boxes.

c. Select Prepare.
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Figure 2-153 Setup Assistant Configuration

Configure iOS Setup Assistant

Setup Assistant:

Show only some steps
Language Location Services
Region Siri
Keyboard App Analytics
Privacy Display Zoom
Passcode Home Button

Touch ID True Tone

Apple Pay iMessage

Apps & Data Watch Migration

Move from Android Mew Feature Highlights
Apple ID

Choose which steps will be presented to the user in Setup Assistant.

Cancel

Previous Prepare

16. Configurator 2 will take several minutes to prepare the device and place it into Supervised

Mode.

Figure 2-154 Waiting for iPhone

Preparing “Spike's iPhone"
Waiting for the device

Cancel

2.9.1.3 Registration with Mobilelron Core

The following steps will register an iOS device in Supervised Mode with Mobilelron Core, which uses a

web-based process rather than the Mobile@Work app.
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1. Using Safari, navigate to the Mobilelron Core page, substituting <FQDN> for your organiza-
tion's instance of Mobilelron Core. In our example implementation, the resulting URL is
https://mi-core.govt.mdse.nccoe.org/go.

Figure 2-155 iOS Device Mobilelron Registration Page

Mo Service = 2:08 PM 1
& mi-core.govt.mdse.nccoe.org

@ Mobilelron

To configure and secure your iOS device, please
enter your username and password, and then tap
'Register’.

L]

Username:
jason

Password:

\ Done

® Passwords

2. At the warning that the web site is trying to open Settings to show a configuration profile,
select Allow; the Settings built-in app opens.

NIST SP 1800-21C: Mobile Device Security: Corporate-Owned Personally-Enabled 138



“TZ-008T"dS" LSIN/8Z09°0T/310°10p//:dny :wioly 351y J0 3344 3|eIeA. S| uoiedlgnd SIy L

Figure 2-156 Opening Settings Confirmation

12:39 e T ()

& mi-core.govt.mdse.nccoe.org G

This website is trying to open Settings
to show you a configuration profile. Do
you want to allow this?

Ignore  Allow

3. At the Settings > Install Profile screen:
a. Verify the Signed by field indicates the server identity is Verified.
b. Select Install.
Figure 2-157 Profile Installation

12:40
« Safari

= -

Cancel Install Profile Install

Profile Service
NCCOE

Signed by mi-core.govt.mdse.nccoe.org
Verified +

Description  Enter device into the NCCOE encrypted
profile service
Contains Device Enroliment Challenge

More Details

4. At the Installing Profile screen, select Install.
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Figure 2-158 Profile Installation

Install

Cancel

5. At the Warning screen:

a. Verify that information under Root Certificate and MDM is consistent with information
provided by your mobile device administrator.

b. Select Install.
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Figure 2-159 Profile Installation Warning

12:40 = -
4 Safari
Cancel Warning Install

ROOT CERTIFICATE

Installing the certificate "DigiCert Global Root
G2" will add it to the list of trusted certificates
on your iPhone.

MOBILE DEVICE MANAGEMENT

Installing this profile will allow the
administrator at “https://mi-
core.govt.mdse.nccoe.org/mifs/c/i/mdm/
mdm.htmi?c= S to remotely
manage your iPhone.

The administrator may collect personal data,
addfremove accounts and restrictions, install,
manage, and list apps, and remotely erase
data on your iPhone.

6. Inthe Remote Management dialogue, select Trust.
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Figure 2-160 Profile Installation Trust Confirmation

Remote Management
Do you trust this profile's source to
enroll your iPhone into remote
management?

Cancel Trust

7. At the Profile Installed screen, select Done. The device is now registered with Mobilelron.
Figure 2-161 Profile Installation Confirmation

12:40
« Safari

Profile Installed Done

NCCOE
NCCOE

Signed by mi-core.govt.mdse.nccoe.org
Verified

Description NCCOE - Encrypted Configuration

Contains Mobile Device Management
Device Identity Certificate
3 Certificates

More Details

2.9.2 Activating Lookout for Work on iOS

The configuration of the Lookout for Work (iOS) app in the Mobilelron app catalogue causes a
configuration file to be included during the automatic install.

NIST SP 1800-21C: Mobile Device Security: Corporate-Owned Personally-Enabled 142



"TZ-008T"dS"LSIN/8209°0T/840"10p//:d11y :wioly 381eyd Jo 3314 3|qe|ieAe S| uoiedlignd siy L

Upon launching the app, additional action is required to grant Lookout for Work the permissions
necessary for it to provide optimal protection.

1. Launch the Lookout for Work app; activation occurs silently at the splash screen.

Figure 2-162 Lookout for Work Splash Screen

11:49 AM

LQ_Q kout

2. At the welcome screen, select Continue.
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Figure 2-163 Lookout for Work Permission Information

11:49 AM

In order to get started, we're going
to need the following permissions

Motifications

We don't collect your location or
share it with your employer.

3. At the "Lookout Work" Would Like to Send You Notifications dialogue, select Allow.
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Figure 2-164 Notifications Permissions Prompt

“Lookout Work" Would Like
to Send You Notifications
Notifications may include alerts,

sounds, and icon badges. These can
be configured in Settings.

Don't Allow Allow

4. Atthe Allow "Lookout Work" To Access Your Location? dialogue, select Always Allow.
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Figure 2-165 Locations Permission Prompt

Allow “Lookout Work" to
access your location?

In order for Lookout to continue to
check for threats we may sometimes
need access to location services on

your device to keep the app running in
the background.

We don't collect your location or
share it with your employer.

Only While Using the App

Always Allow

Don't Allow

5. Lookout for Work should automatically perform scans of device and app activity and pro-
vide feedback to the user.
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Figure 2-166 Lookout for Work Home Screen

il Verizon F &8 11:50 AM

v

No Issues Found
Today 11:49 am

v All your apps are safe

Your network is safe

Your system is safe
Weesoses

2.9.3 Provisioning Work-Managed Android Devices with a Work Profile

In this scenario, Android devices are deployed as work-managed with a work profile. Enabling this
feature for AFW-capable devices requires a change to the AFW configuration. It also requires that the
device user already has a personal Google account to provision the work profile; it is not created as part
of the workflow to register a device with Mobilelron Core.

2.9.3.1 Enable Work Profile on Work-Managed Devices
1. Inthe Mobilelron Admin Portal, navigate to Policies > Configs > Configurations.
2. Enable the check box in the row for the AFW configuration.

3. Inthe Configuration Details pane, select Edit.
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Figure 2-167 Mobilelron AFW Configuration

Dashboard Devices & Users Admin  Apps Policies & Configs Services Settings Logs

Configurations Policies olicies Compliance Policles Compliance Actions
Actions v Add New v Spaces: | Filter by Space v | Labels: |Filter by Labe v Search by User R | Configuration Type: Filter by Configurat
IZ] Name < Configuration ... Bundle/Package!D  Desc... # Phones  Configuration Details ¥
7]} Activate Lookout MANAGED AP... com.lookout.work Activ... 4 m
i¥] Android for Work Configur... ANDROIDFOR... Creat... 12 ¥ ™ =
s Android for Work Configuration
=1 Apptharity Mobile Intelige... MANAGED AP... com.appthority.Appt... Identi... 4

Device Space: Global
4. Inthe Edit Android enterprise (all modes) Setting dialogue:
a. Enable Enable Managed Devices with Work Profile on the devices.
b. Enable Add Google account.

c. Inthe Google Account text box, provide a valid Google domain account. The example in
our reference implementation will map a Mobilelron user ID of gema to an email ad-
dress of mdse.gema@gmail.com. This needs to be done for each user. See Mobilelron
Core 9.4.0.0 Device Management Guide for AFW for a list of variables to appropriately
adapt this field to your existing identity management strategy.

d. Click Save.
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Figure 2-168 AFW Configuration

Edit Android enterprise (all modes) Setting

Name | Android for Work Gonfiguration

Description |Created to support Android for Work configuration options on
Android devices.

Enable Managed Device with Work Profile on the devices
Auto update Mobile@Work app on the devices
For Android 6.0 and higher only

Enable Runtime Permissions

@ User Prompt
) Always Accept
) Always Deny

Add Google Account

Google Account I mdse. $USERID$@gmail.com [ ]

For Android 7.0 and higher only
[[] Always-on VPN

Work Challenge @

Cancel Save

2.9.3.2 Registering Android Devices

The following steps can only be completed when working with an Android device that is still set to (or
has been reset to) factory default settings.

1. When prompted to sign in with your Google Account:
a. Inthe Email or phone field, enter afw#mobileiron.core.

b. Select Next.
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Figure 2-169 Mobilelron Enrollment Process

Google

Signin

with your Google Account. Learn more

Ermail or phone

afw#mobileiron.core

Forgot email?

Create account NEXT

&) afw#mobileiron.core N

TH23 4567181940

q‘ wlelr|t y ulilo pI
alsldlflglnlilkl
£ z x cvbnm©

#l , @ EN(US) . .com Go
\l/

2. When AFW prompts you to install Mobile@Work, select Install; this downloads the
Mobile@Work client to the device.
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Figure 2-170 AFW Enroliment

0]
Android for Work

This account requires mobile device manage-
ment. Install the Mobile@Work app to enforce
security policies required by the account.

a2y Mobile@Work

SKIP INSTALL

3. At the prompt to install Mobilelron, select Install.
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Figure 2-171 Mobilelron Installation

Do you want to install this application? It
does not require any special access.

CANCEL  INSTALL

4. Atthe Set up your device screen, select Accept.
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Figure 2-172 Accepting AFW Terms and Conditions

Set up your device

Your admin can monitor and manage
settings, corporate access, apps, permissions,
theft-protection features, and data associated
with this phone, including network activity and
your phone’s location information.

Knox Terms and Conditions

Privacy Policy

Google

Your organization will manage and monitor this
device using the following app:

APP

-y Mobilelron

CANCEL ACCEPT >

5. This screen notifies the user of the data that Mobile@Work collects and how it is used.
When this information has been reviewed, select Accept. Mobile@Work minimizes and re-
turns to the operating system home screen.
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Figure 2-173 Mobilelron Privacy Information

[® secure Mobility
Mobile@Work will not access personal
content such as your personal email,
photos or voicemail

3 oevice Details
Your company requires some general device
details to provide secure mobility services

Q Remote Security
If your device is lost or stolen, you and your
company can take security measures to
protect your data

£ Learn More
You can find more details after registration,
under Settings > Your Privacy

Your Privacy is Important

Don't worry! Your company cannot
access your personal data

CONTINUE

Tap here to fill entire screen

= [J =

6. When Mobilelron sends a Configuration Required notification, select the notification.
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Figure 2-174 Mobilelron Configuration Required Notification

Configuration Required
Mobile@Work configuration required. Tap to begin.

Swipe up or down for all apps

Play Store

-
N

7. On the Device Status > Create Work Profile screen, select Continue.
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Figure 2-175 Mobilelron Device Status

Device Status

goo )

® Create Work Profile

Android enterprise (AFW) creates a separate
work profile to access work data and keeps it
separate from your personal data. In the next
steps, you will be guided to set up your Android
enterprise (AFW) profile.

CONTINUE
. 2 o <

8. At the AFW prompt, select Continue.
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Figure 2-176 AFW Configuration

Android Enterprise (AFW)

Your company is implementing
a work profile to separate

your work data from your
personal data!

You will be guided through this
required update.

To continue your access to
company data, please click on
“Continue” to begin Setup.

DISMISS CONTINUE

. = 5 ¢

9. AFW notifies the user that it is creating the personal workspace. The next two screens re-

peat Steps 3 and 4 as above.
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Figure 2-177 AFW Workspace Creation

Creating Workspace...

Work apps have a badge on their icon.

10. At the Device Status > Work Profile Lock Preferences screen, select Continue.
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Figure 2-178 Mobilelron Work Profile Lock Preferences

3 ol [ =1 96% W 3;19 PM

Device Status c

Work Profile Lock
Preferences

On the next screen, you will set up the work
profile lock for your device.

Your administrator has applied a new work
profile lock policy or your previous work profile
lock may have expired. Please set up the work
profile lock for your device.

CONTINUE
. 2 o <
11. The user will be prompted to create a passcode to protect the AFW container.

12. At the Device Status > Add Google Account screen, select Continue.
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Figure 2-179 Mobilelron Google Account Configuration

B Add Google Account

YOUR GOOGLE ACCOUNT EMAIL IS
mdse.gema@gmail.com

In the next steps, you will be asked to enter the
associated password for this to add the account.

CONTINUE

1 (®] <

13. The user will be prompted to authenticate to the same Google domain account mapped to
their Mobilelron account based on the email address set in the AFW configuration in Mo-
bilelron Core. In our example implementation, the mapped Google account is
mdse.gema@gmail.com.

14. Once the Mobile@Work app has been provisioned with the user's account, the Device Sta-
tus screen should appear; the device has now successfully been provisioned into Mobilel-
ron.
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Figure 2-180 Mobilelron Device Status

Device Status

SM-G965U1

ACTIVE

Checked in - less than a
minute ago

@ You're all set!

Currently there are no updates needing
your attention.
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Active Directory

Android for Work

Application Programming Interface
Certificate Authority

Corporate-Owned Personally-Enabled
Demilitarized Zone

Distinguished Name

Domain Name System

Derived Personal Identity Verification Credential
Enterprise Mobility Management

Fully Qualified Domain Name

Government

Hypertext Transfer Protocol

Hypertext Transfer Protocol Secure
Identifier

International Mobile Equipment Identity
Internet Protocol

Local Area Network

Lightweight Directory Access Protocol
Mobile Device Management

Mobile Device Security

Mobile Endpoint Security

Mobile Threat Posture

Network Address Translation

National Cybersecurity Center of Excellence
National Institute of Standards and Technology
Network Time Protocol

Open Virtualization Appliance

Property List

Simple Certificate Enrollment Protocol

Secure Shell
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SSID
SSL
TLS
URL
uUsB
VLAN
VPN
WAN

Service Set Identifier
Secure Sockets Layer
Transport Layer Security
Uniform Resource Locator
Universal Serial Bus
Virtual Local Area Network
Virtual Private Network
Wide Area Network
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Application

Programming Interface

(API)
App-Vetting Process

Authenticate

Certificate

Certificate Authority
(CA)

Corporate-Owned
Personally-Enabled
(COPE)

Demilitarized Zone
(DM2Z)

Derived Personal
Identity Verification
(PIV)

Hypertext Transfer
Protocol (HTTP)

Hypertext Transfer

Protocol Secure (HTTPS)

A system access point or library function that has a well-defined
syntax and is accessible from application programs or user code
to provide well-defined functionality [1].

The process of verifying that an app meets an organization's
security requirements. An app vetting process comprises app
testing and app approval/rejection activities [2].

Verifying the identity of a user, process, or device, often as a
prerequisite to allowing access to resources in an information
system [3].

A data structure that contains an entity’s identifier(s), the
entity's public key (including an indication of the associated set
of domain parameters) and possibly other information, along
with a signature on that data set that is generated by a trusted
party, i.e., a certificate authority, thereby binding the public key
to the included identifier(s) [4].

A trusted entity that issues and revokes public key certificates

[5].

A device owned by an enterprise and issued to an employee.
Both the enterprise and the employee can install applications
onto the device.

An interface on a routing firewall that is similar to the interfaces
found on the firewall’s protected side. Traffic moving between
the DMZ and other interfaces on the protected side of the
firewall still goes through the firewall and can have firewall
protection policies applied [6].

A credential issued based on proof of possession and control of
the PIV Card, so as not to duplicate the identity proofing process
as defined in [SP 800-63-2]. A Derived PIV Credential token is a
hardware or software-based token that contains the Derived PIV
Credential [7].

A standard method for communication between clients and
Web servers [8].

HTTP transmitted over TLS [9].
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Internet Protocol (IP)
addresses

Lightweight Directory

Access Protocol (LDAP)

Local Area Network
(LAN)

Mutual Authentication

Passphrase

Personal Identity
Verification (PIV)

Risk Analysis

Risk Assessment

Root Certificate
Authority (CA)

Standard protocol for transmission of data from source to
destinations in packet-switched communications networks and
interconnected systems of such networks [10].

The Lightweight Directory Access Protocol, or LDAP, is a

directory access protocol. In this document, LDAP refers to the
protocol defined by RFC 1777, which is also known as LDAP V2.
LDAP V2 describes unauthenticated retrieval mechanisms [11].

A group of computers and other devices dispersed over a
relatively limited area and connected by a communications link
that enables any device to interact with any other on the
network [12].

The process of both entities involved in a transaction verifying
each other [13].

A passphrase is a memorized secret consisting of a sequence of
words or other text that a claimant uses to authenticate their
identity. A passphrase is similar to a password in usage, but is
generally longer for added security [14].

A physical artifact (e.g., identity card, “smart” card) issued to a
government individual that contains stored identity credentials
(e.g., photograph, cryptographic keys, digitized fingerprint
representation) so that the claimed identity of the cardholder
can be verified against the stored credentials by another person
(human readable and verifiable) or an automated process
(computer readable and verifiable). PIV requirements are
defined in FIPS PUB 201 [15].

The process of identifying the risks to system security and
determining the probability of occurrence, the resulting impact,
and the additional safeguards that mitigate this impact. Part of
risk management and synonymous with risk assessment [16].

The process of identifying risks to organizational operations
(including mission, functions, image, reputation), organizational
assets, individuals, other organizations, and the Nation, resulting
from the operation of an information system [17].

In a hierarchical public key infrastructure (PKI), the certification
authority (CA) whose public key serves as the most trusted
datum (i.e., the beginning of trust paths) for a security domain
[18].
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